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Preface

Gain the AS/400 NetServer advantage. AS/400 NetServer is an OS/400 function
introduced in Version 4 Release 2, which enables Windows clients to connect to
AS/400 shared directory paths and shared output queues using TCP/IP. It
enables an AS/400 system to provide file and print serving in a Windows network
without needing to install additional hardware or software on the AS/400 system.
This redbook is designed with the needs of all AS/400 system implementors in
mind and offers you various ways to enhance your environment with AS/400
NetServer.

If you are using Client Access Express, you will discover how to give your clients
access to AS/400 disk space and printers. If you are using Client Access for
Windows 95/NT, after reading this book, you may decide to use AS/400
NetServer support rather than the support provided in Client Access for file and
print serving. The reason is that AS/400 NetServer does not require additional
software and is part of the OS/400 operating system. If you are currently using
IBM Warp Server/400 or Novell NetWare on an Integrated Nefinity Server, you
can use the information provided to help you migrate to AS/400 NetServer for file
and print serving. If you are interested in using Network Stations with Windows
NT server 4.0, Terminal Server Edition, you can enhance your users’ environment
by taking advantage of AS/400 NetServer.

This book is divided into three parts:

• Part 1 describes how to configure and use AS/400 NetServer shares and
printers.

• Part 2 describes considerations for moving file and print serving from an
Integrated Netfinity Server using Warp Server/400 or Novell NetWare to
AS/400 NetServer. We include some scenarios to help you apply what we
describe to your own situation.

• If your installation has Network Stations, you may want to consider file sharing
using AS/400 NetServer. In Part 3, you learn how to use AS/400 NetServer, as
well as Windows NT server, Terminal Server Edition, to provide file and print
sharing for your users.
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the Business Server team. Justine holds an MBA from the University of Western
Australia and is a Certified Lotus Professional Notes Principal System
Administrator.

Tony Barker is a Systems Management IT Specialist in Portsmouth, England. He
has been working at IBM for three years. He holds an HNC in Electrical and
Electronic Engineering together with an industry approved Engineering
Apprenticeship and is an IBM Certified AS/400 Professional System Operator.
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Part 1. Configuring and using AS/400 NetServer

The first part of this book covers the following topics:

• An overview of the communication that supports AS/400 NetServer and the
positioning of AS/400 NetServer in the file sharing world

• Configuring AS/400 NetServer and defining file and print shares

• Administering and using AS/400 NetServer

• Troubleshooting when something goes wrong

• Security considerations with AS/400 NetServer

An Integrated Netfinity Server is an Intel processor, memory, and one or more
LAN cards packaged on adapters that fit inside the AS/400 system. Throughout
this redbook, when we refer to an Integrated Netfinity Server, we may also be
referring to the first model (known as File Server Input Output Processor
(FSIOP)), the second model (called Integrated PC Server (IPCS)), as well as
the current Integrated Netfinity Server.

Note
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Chapter 1. Introduction

This redbook is about a function called AS/400 Support for Windows Network
Neighborhood, which is more commonly referred to as AS/400 NetServer. AS/400
NetServer has been available since Version 4 Release 2 of OS/400. It is
integrated into the base of OS/400 and is not a part of Client Access. It is not a
separately installable option or product.

Windows PCs on the network use the file and print sharing capabilities that are
built into their operating systems to access AS/400 NetServer resources on the
AS/400 system. For example, you can use Network Neighborhood on a Windows
95 PC to access file and print resources on an AS/400 system without loading
any additional software on the PC.

AS/400 NetServer uses NetBIOS over TCP/IP to communicate with its clients.
Therefore, TCP/IP must be configured on those AS/400 systems and PCs that
use AS/400 NetServer. The TCP/IP configuration on the AS/400 system does not
require any specific changes to support AS/400 NetServer, although TCP/IP must
be active.

In this chapter, we describe the Networking concepts that support AS/400
NetServer. This will help you better understand the environment. We list for you
the benefits of AS/400 NetServer. Plus, we explain the advantages that AS/400
NetServer has over file and print serving using Client Access for Windows 95/NT.
Then, we position AS/400 NetServer in the world of file serving to help you decide
how you can best deploy AS/400 NetServer in your organization.

1.1 Application and file serving

Before proceeding, we need to understand the terms application serving and file
serving.

Application serving involves running a process on the server. For example, if you
submit a batch command to run on another computer, that computer would be
application serving. A Domino server is an application server. A Microsoft SQL
Server and IBM DB2 UDB for Windows NT are also application servers.

Windows NT on the Integrated Netfinity Server can act as both a file server and
an application server. When Windows NT Server 4.0, Terminal Server Edition
runs on the Integrated Netfinity Server, providing the support necessary for
Network Stations to operate, it is acting as an application server.

When users store and retrieve data from a mapped drive on the Integrated
Netfinity Server, or even if they load their word processing code from the
Integrated Netfinity Server, it is acting as a file server. The reason is that the only
processing required on the CPU of the Integrated Nefinity Server is the
downloading of the application, not the execution of the application. The
application is actually running on the client.

AS/400 NetServer provides file serving capabilities using the disk storage of the
AS/400 system. A PC program cannot be run on the AS/400 system directly using
the processor of the AS/400 system.
© Copyright IBM Corp. 1999 3



1.2 Benefits of AS/400 NetServer

Here are some benefits of AS/400 NetServer that you can consider when
planning your file and print serving strategy:

• AS/400 NetServer eliminates the cost of administering multiple servers in your
network because the AS/400 system becomes a single point for software
maintenance.

• AS/400 NetServer reduces the cost of PC software and maintenance because
there is no additional software needed on client PCs and no retraining is
required because it uses standard Windows interfaces.

• No special hardware is needed since AS/400 NetServer uses the AS/400
processor, disk, and LAN adapters. Using AS/400 NetServer as a network
print server takes advantage of AS/400 disk space to spool print jobs to a
shared output queue configured for a network attached printer.

• Because AS/400 NetServer is managed with AS/400 Operations Navigator,
there is a simple, graphical way to administer AS/400 file and print shares.

• AS/400 NetServer simplifies network backup and recovery procedures,
because all save and restore is done on the AS/400 system. There is no need
to back up individual PCs in the network.

• AS/400 NetServer uses AS/400 user profiles and security. There is no need to
learn an additional operating system to take advantage of native file and print
serving capabilities on the AS/400 system.

• AS/400 NetServer supports clients that use different language code pages,
but need to share the same text file. In V4R4 and later, AS/400 NetServer
allows you to perform file data text conversion on the fly.

Details about the features that provide these benefits are the subject of the
remainder of the first part of this redbook.

1.3 Networking concepts

AS/400 NetServer enables an AS/400 system to provide file and print serving in a
Windows network without needing to install additional hardware or software on
the AS/400 system. AS/400 NetServer uses the Server Message Block (SMB)
protocol to communicate with the network. SMB is an industry standard protocol
for file and print sharing that allows computers to access network resources as if
they were local. It was originally written using the NetBIOS API running over the
NetBEUI communications protocol, but can now also use different protocols, for
example NetBIOS over TCP/IP, and IPX/SPX. Because NetBEUI has not been
implemented on the AS/400 system, AS/400 NetServer uses NetBIOS over
TCP/IP as its networking protocol.

AS/400 NetServer officially supports Windows for Workgroups (Windows 3.11),
Windows 95, Windows 98, Windows NT 3.51, Windows NT 4.0, Windows 2000,
and Terminal Server Edition. OS/2 Warp Connect, although it is an SMB client, is
not supported with AS/400 NetServer and will not work.

The directories that are shared by AS/400 NetServer reside in the integrated file
system on the AS/400 system. They are protected by AS/400 security. They can
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be saved with standard AS/400 methods during normal AS/400 save operations.
There is no need for additional backup programs or backup strategies.

Client Access Express is not necessary for the use of AS/400 NetServer.
However, you may want to use Client Access Express to provide 5250 emulation,
file transfer, and other functions for your users. You will use Operations Navigator
to configure AS/400 NetServer, but you do not have to purchase a license to use
Operations Navigator.

Client Access Express for Windows, unlike the other Client Access clients, does
not provide the functions of Network Drives and Network Printing. It relies on
AS/400 NetServer for these functions. That is one of the reasons why Client
Access Express for Windows does not support OS/400 releases prior to
Version 4 Release 2. Client Access for Windows 95/NT Network Drives and
Network Printers use background jobs on the PC to make their functions available
to the Windows desktop. AS/400 NetServer does not need background jobs on
the PC. This results in less overhead on the CPU of the PC and less memory and
disk space used. A comparison of features with Client Access for Windows 95/NT
is in 1.6, “AS/400 NetServer versus Client Access for Windows 95/NT” on page 7.

1.4 Broadcasts

AS/400 NetServer uses the SMB protocol to advertise its resources in the
network. Clients use the SMB protocol to find the AS/400 NetServer and its
shared resources.

One of the simplest PC network configurations is a NetBEUI network. All versions
of Microsoft Windows, as well as OS/2 and clients from other software
manufacturers, support NetBEUI. In a NetBEUI network, a computer is addressed
by its computer name. You can find the computer name in the Windows Network
properties of a Windows client PC. When a Windows client PC is set up to use
NetBEUI as the network protocol, SMB uses broadcasts to find other computers
in the network and to share information with each other.

A broadcast is a message that is sent out to many computers on the network, not
to a specific computer. Broadcasts add a load to a network. They are normally no
problem in smaller networks that contain only a few systems and are contained
within one physical network segment, for example, one physical Token-Ring.
Large NetBEUI-based networks fit into this definition when broadcasts are
forwarded across bridges and routers, which make these large networks appear
as a single physical network. Larger communication networks based on TCP/IP
intranets or the Internet are made up of many physical network segments
(TCP/IP subnets) that are connected through routers or gateways. They do not fit
this same model. Often these physical networks are not at the same location but
are connected with telephone or leased lines. The routers that connect TCP/IP
physical networks are typically configured to not route broadcasts in order to
reduce network traffic.
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1.5 Name resolution

Due to their increasing size, PC networks more often are using TCP/IP instead of
NetBEUI as their network protocol. In a TCP/IP network, a computer is addressed
by its computer name, which is resolved to an IP address. TCP/IP networks are
often implemented with name servers to resolve a computer name to an IP
address.

SMB in a TCP/IP network uses an intermediate network layer of NetBIOS over
TCP/IP (NBT) on top of TCP/IP as shown in Figure 1.

Figure 1. NetBIOS over TCP/IP

Windows client PCs that are set up to use NetBIOS over TCP/IP take advantage
of configured name services to resolve a computer name to an IP address before
defaulting to broadcasts on the network. The Windows client PC first sends a
directed datagram to a name service, for example a WINS Server or a DNS
(discussed later in 2.3, “Configuring your network clients” on page 18), to resolve
the server name into a TCP/IP address. Then, the client uses that TCP/IP
address to directly communicate with the server. Using a directed datagram
creates minimal network traffic. If no name server is available or if the name is not
found in a name server, the Windows client sends the SMB request as a User
Datagram Protocol (UDP) broadcast. In a typical TCP/IP network, the UDP
broadcasts are contained within a subnet. The TCP/IP routers do not send them
out into the rest of the network to keep the network traffic low. If no server
responds to the UDP broadcasts, the Windows client searches the LMHOSTS file
on the PC. If the server name is not in the LMHOSTS file, an error message
stating that the network path was not found is sent to the user.

Note: The order in which a server name is resolved to a TCP/IP address may
vary depending on the client software and the service pack level of the Windows
client software. Microsoft may change this order.

There is no NetBEUI implementation on the AS/400 system. AS/400 NetServer
uses NetBIOS over TCP/IP, which today is commonly used by SMB
implementations. Request for Comment 1001 (RFC 1001) and RFC 1002 contain
information about the NetBIOS over TCP/IP protocol. While using TCP/IP helps
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minimize network traffic and saves expensive network bandwidth, Windows
Network Neighborhood was not designed with TCP/IP in mind. Therefore, it lacks
some of the features that seem to happen automatically when pure NetBEUI is
involved. These automatic functions (for example, the domains and the
computers within domains that are displayed in Windows Network Neighborhood)
are only available because the noisier NetBEUI network protocol, which
increases network traffic, is used.

The ideal situation is when the AS/400 NetServer and the client PCs are in the
same domain or workgroup and also in the same physical network or TCP/IP
subnet. Since UDP broadcasts can flow freely within a subnet, AS/400 NetServer
automatically shows up in the client’s Network Neighborhood.

Unfortunately networks are not always this simple. There are some options that
can be used to help resolve a computer name to an IP address. You may have to
use one or more of them depending on your specific network situation. These
options include:

• Domain Name Service (DNS)
• WINS server
• LMHOSTS file

For more information on these alternatives, see 2.3, “Configuring your network
clients” on page 18.

1.6 AS/400 NetServer versus Client Access for Windows 95/NT

Both AS/400 NetServer and Client Access for Windows 95/NT provide file and
print services. Client Access Express does not provide these functions. It relies
on AS/400 NetServer to provide these capabilities, so this comparison does not
include this member of the Client Access Family. The following list highlights the
differences between the network drive and printer support provided by AS/400
NetServer and Client Access for Windows 95/NT:

• AS/400 NetServer does not require any additional software installed on the
client. It uses the native file and print sharing capabilities found in the
Windows operating system.

• Client Access exposes the entire integrated file system (IFS), while only those
directories and output queues shared by the administrator can be accessed
using AS/400 NetServer.

• You can share any directory in the IFS, even a directory that is nested several
subdirectories below the root, using AS/400 NetServer. With Client Access,
there is no concept of shares. You can only map drives to the root and
first-level directories and must work with nested subdirectories from that
mapped drive on the client. The AS/400 NetServer capability enhances
AS/400 security.

• Using AS/400 NetServer, you can share an IFS directory with read-only
access, which provides additional security on top of the IFS directory
permissions, to ensure that users cannot corrupt the contents of that directory.
Client Access relies solely on the IFS directory permissions of the AS/400
system.

• You can hide AS/400 NetServer shares from the network by ending them with
a $ (dollar sign). These shares are still accessible from the network when
Chapter 1. Introduction 7



accessed directly by name, but will not show up in Network Neighborhood.
The process for doing this is described in 4.2.1, “Hiding shared resources” on
page 54.

• You can hide AS/400 NetServer from the network by setting the AS/400
NetServer browsing announcement interval property value to zero.

• Client Access provides ASCII to EBCDIC translation on the fly. AS/400
NetServer provides this function in V4R4 and later. An example is given in
3.1.1, “File text conversion” on page 29.

• AS/400 NetServer allows network clients to access AS/400 shared IFS
directories and output queues using guest support, so an AS/400 user profile
is not needed for simple file and print services. An AS/400 user profile must be
configured for every Client Access user that accesses the AS/400 system.

• Client Access has richer support for clients using different code pages in V4R3
and V4R2. AS/400 NetServer provides this support in V4R4 or later.

• Client Access has richer functions not available in Windows or provided by
AS/400 NetServer including 5250 terminal emulation, ODBC, data transfer,
and so on. Therefore, you may wish to use AS/400 NetServer for file and print
serving and Client Access for these other functions.

Information about Client Access for Windows 95/NT can be found in Inside Client
Access for Windows 95/NT, SG24-4748. Information about Client Access Express
for Windows can be found in AS/400 Client Access Express for Windows:
Implementing V4R4M0, SG24-5191.

1.7 AS/400 NetServer positioning

Now that we have told you a little about AS/400 NetServer, you may wonder how
you decide if AS/400 NetServer is right for you. Consider the following cases:

• If you want to consolidate a number of Windows NT servers onto a single
AS/400 system, you can use Windows NT on the Integrated Netfinity Server,
or more likely, several Integrated Netfinity Servers. Windows NT on the
Integrated Netfinity Server is optimized for file sharing. You can read more
about Windows NT on the Integrated Netfinity Server in AS/400 -
Implementing Windows NT on the Integrated Netfinity Server, SG24-2164.

• For optimal file sharing performance with a large number of users, you should
consider Windows NT on the Integrated Netfinity Server.

• If you are migrating from OS/2 Warp Server for AS/400 or Novell NetWare on
the older models of the Integrated Netfinity Server (known as IPCS or FSIOP),
then AS/400 NetServer may be a good option. We tell you how to plan for and
perform the migration in Part 2, “Migrating to AS/400 NetServer” on page 65.

• If you have a smaller number of users, or your users' file serving capabilities
are light, AS/400 NetServer may be right for you. Even though Windows NT on
the Integrated Netfinity Server provides easier administration than Windows
NT on a standalone PC, it is even easier to administer all your file sharing
requirements from the Operations Navigator interface, which is used for
administering AS/400 NetServer. The remainder of this part of the redbook
shows you how to do this.

• If you have an AS/400 system that has spare CPU capacity, then AS/400
NetServer may suit your requirements. Many customers have AS/400 systems
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sized for overnight batch runs and find they have spare capacity during the
day. This provides an ideal opportunity for AS/400 NetServer.

• If you want file and print serving without the need to learn another operating
system, then AS/400 NetServer is a good choice.

• If you have clients that use different language code pages, but need to share the
same text file, AS/400 NetServer will meet your needs. In V4R4, AS/400
NetServer allows you to do file data text conversion on the fly. Using multiple file
shares for the same AS/400 integrated file system directory allows you to specify
different code page text conversion options for files in the same AS/400 integrated
file system directory.

Our advice is that, unless you clearly fall into one of the Integrated Netfinity
Server suggested scenarios in the previous list, you should try AS/400 NetServer.
There is no cost to you for trying it because AS/400 NetServer is integrated right
into the base of OS/400. There are clear advantages in the integration with
AS/400 data and backup operations.

There is nothing to stop you from having a mixture of Integrated Netfinity Server
and AS/400 NetServer file serving. You can put your application serving on an
Integrated Netfinity Server and take advantage of the tight integration with
OS/400 and use AS/400 NetServer for your file serving.

If you have Network Stations in your installation, or are considering their
introduction, you may want to use an Integrated Netfinity Server to provide the
Windows NT server 4.0, Terminal Server Edition capabilities. You can use AS/400
NetServer for the file serving to again integrate data. You can read more about
this in Chapter 8, “AS/400 NetServer and Network Stations” on page 113.
Chapter 1. Introduction 9
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Chapter 2. Getting started with AS/400 NetServer

AS/400 Support for Windows Network Neighborhood (AS/400 NetServer) is an
IBM Operating System/400 (OS/400) function that enables Windows clients to
access AS/400 shared directories and output queues. PC clients on a network
simply use the file and print sharing functions that are included in their operating
systems. Therefore, you do not need to install any additional software on your PC
to use AS/400 NetServer.

To function properly on an AS/400 system and with clients, AS/400 NetServer
requires:

• An AS/400 system properly connected with Version 4 Release 2 (V4R2)
OS/400, or later, configured and properly connected to a TCP/IP network.

• An AS/400 NetServer name that does not conflict with the AS/400 TCP/IP
name that Client Access for Windows 95/NT uses.

• An up and running Network Print Server so that you can use AS/400
NetServer print sharing capabilities.

• You need to have one of the following operating system components installed
on the client PC depending on your operating system:

– Client for Microsoft Networks for Windows 95/98
– Workstation for Windows NT
– Microsoft File and Print Client for Windows for Workgroups

Once this is installed and configured, you will have access to the integrated
file system directories and the AS/400 output queues that have been shared
with the network.

• An AS/400 NetServer server name and Internet protocol (IP) address
resolution strategy, for example, Domain Name Service (DNS), Windows
Internet Naming Service (WINS), or LMHOSTS file.

• Refer to the following Informational APARs for the AS/400 PTF requirements
so that AS/400 NetServer functions properly:

– II12091 for V4R4M0
– II11752 for V4R3M0
– II11081 for V4R2M0

Informational APARS can be found at http://as400service.ibm.com under Tech
Info and Databases.

AS/400 NetServer officially supports Windows for Workgroups (Windows 3.11),
Windows 95, Windows 98, Windows 2000, Windows NT 3.51, Windows NT 4.0,
and Windows NT server, Terminal Server Edition.

Supported clients
© Copyright IBM Corp. 1999 11



2.1 Configuring AS/400 NetServer

Note: This book assumes that the Client Access Express client is used for the
Operations Navigator interface.

For AS/400 NetServer to operate and perform correctly, it must be configured and
started on the AS/400 system. Both TCP/IP and the QSERVER subsystem must
be active so that AS/400 NetServer starts correctly. To verify that the QSERVER
subsystem is active, enter WRKSBS on a command line. If QSERVER is listed, then
it has already been started. If not, use the following command to start QSERVER:

STRSBS SBSD(QSERVER)

To verify that TCP/IP is started, enter CFGTCP on a command line. Select option 1,
and then select F11 (Display interface status). If information on the interface
status is available, then TCP/IP is active. Ensure that the specific TCP/IP
interface that you are using has a status of Active.

Once this is done, you can immediately begin to share data and printers with your
PC clients.

2.1.1 Starting AS/400 NetServer
You can start AS/400 NetServer using Operations Navigator by following these
steps:

1. Open a connection to your AS/400 using Operations Navigator.
2. Expand Network.
3. Expand Servers.
4. Select TCP/IP.
5. Right-click AS/400 NetServer, as shown in Figure 2 on page 13, and select

Start.

If you do not know how to configure and start TCP/IP on the AS/400 system,
refer to the TCP/IP articles in the AS/400e Information Center, which is located
at: http://www.as400.ibm.com/infocenter

For a list of necessary PTFs, check the AS/400 NetServer home page, which is
located at: http://www.as400.ibm.com/netserver

Notes
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Figure 2. Starting AS/400 NetServer

Express clients provide additional ways to access AS/400 NetServer using
Operations Navigator. Double-click on AS/400 NetServer in step 5 to open
AS/400 NetServer. Alternatively, you can expand File Systems from Operations
Navigator, right-click on File Shares, and select Open AS/400 NetServer. In
both cases, you then use the menu bar, tool bar, or right-click on AS/400
NetServer and select Start.

If you do not have Operations Navigator installed, use the following command to
start AS/400 NetServer:

• For V4R4 and later, use:

STRTCPSVR *NETSVR

• For V4R2 and V4R3, use:

CALL PGM(QZLSSTRS) PARM(‘0’ X’00000000’)

If you have trouble starting AS/400 NetServer, see 5.3, “File and print share
problems” on page 60.
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2.1.2 Working with AS/400 NetServer properties
You can begin to work with AS/400 NetServer by using the pop-up menu that
appears when you right-click on AS/400 NetServer in Operations Navigator. Or,
you can use the functions that are provided on the menu bar and tool bar within
Operations Navigator. When you right-click on AS/400 NetServer and select
Properties, the window shown in Figure 3 appears.

Figure 3. AS/400 NetServer general properties

The AS/400 NetServer Properties window shows the current configuration as well
as Advanced properties and WINS Configuration. To change any of the properties
on any of the three pages, click the Next Start button. Click OK to accept any
changes that you have made. Otherwise, click Reset to Current to undo any
changes.

The General page displays the following properties:

• Server name: Specifies the current server name. If you decide to change the
AS/400 NetServer name, review 2.2, “Changing the AS/400 NetServer name”
on page 17, before doing so.

• Allow AS/400 NetServer access using AS/400 name: If this property is set
to Yes, you can access your AS/400 NetServer by using the AS/400 system

If you do not want to start Operations Navigator each time you access AS/400
NetServer, you can create a shortcut on your Windows desktop. To create a
shortcut, follow these steps:

1. Open a connection to Operations Navigator on your AS/400 system.
2. Expand Network.
3. Expand Servers.
4. Select TCP/IP.
5. Right-click AS/400 NetServer, and select Create Shortcut.

You can start and stop AS/400 NetServer from here.

Tip
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name. If you decide to change the AS/400 NetServer name, review 2.2,
“Changing the AS/400 NetServer name” on page 17, before doing so.

• Domain name: Specifies the current domain name or workgroup where the
server is a member. The AS/400 NetServer domain name should match the
domain of those Windows clients that want to access AS/400 NetServer.
AS/400 NetServer access works best when your clients reside in the same
domain as your AS/400 NetServer and both are on the same subnet.

• Description: Specifies the current server description.

In V4R4, AS/400 NetServer automatically starts when TCP/IP is started. Uncheck
the Start when TCP/IP is started box if you do not want AS/400 NetServer
started automatically with TCP/IP. You will see this check box when you select
Next Start.

When you select the Advanced tab, the window shown in Figure 4 appears.

Figure 4. AS/400 NetServer Advanced Properties

The AS/400 NetServer Advanced includes the following properties:

• Guest user profile: Specifies the guest user profile used when someone
without an AS/400 user profile attempts to access shared resources on the
server. For more information on creating a guest user profile, refer to 2.4,
“Configuring the guest user profile” on page 20.

• Code page: Specifies the current code page that is used by all clients
connected to the server. The server converts the code page to the associated
AS/400 coded character set identifier (CCSID) for processing. A value of zero
specifies that the default ASCII CCSID of the current job used to change the

If you want to access Windows NT Server shared directories through the
AS/400 QNTC file system, AS/400 NetServer must be in the same domain
as the Windows NT Servers you want to access.

If you are running Windows NT Server on an Integrated Netfinity Server, we
recommend that the Windows NT Server domain and the AS/400 NetServer
domain match.

Note
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AS/400 NetServer properties will be used to set the value of the AS/400
NetServer code page.

– V4R2 and V4R3: When a PC client stores a file in an AS/400 shared
directory, the file name is sent in ASCII from the PC to the AS/400 system.
When the file is stored in the IFS, it has to be converted to UNICODE by
AS/400 NetServer so that it is readable on the AS/400 system.

– V4R4 and later: The PC will usually convert the file name from ASCII to
UNICODE and then send the UNICODE file name to the AS/400 for
storage in the integrated file system.

• Opportunistic lock time-out: Is not currently supported on the AS/400
system.

• Idle time out: Specifies whether a connection remains open even if activity on
that connection has stopped.

• Browsing announcement interval: Windows networks use a browser service
function to provide a list of available servers. When a computer wants to make
itself known on the network, it sends out announcements at various intervals.
However, frequent browse announcements result in increased network traffic
and, therefore, a decrease in network performance.

Finally, the WINS Configuration page that is shown in Figure 5 on page 17,
contains information pertaining to properties of the Windows Internet Name
Service (WINS). WINS is a dynamic naming service that resolves NetBIOS
computer names to IP addresses. Although the AS/400 system cannot act as a
WINS server, it can act as a WINS proxy. This enables non-WINS clients to obtain
name resolution from WINS. A WINS proxy receives broadcasted name requests
from non-WINS clients and resolves them by directing queries to a WINS server.
If you are using WINS, specify a primary server IP address. If you have a
secondary WINS server, you can also specify an IP address in the appropriate
field.

Under some circumstances, particularly on non-US AS/400 systems, a code
page value of 0 causes AS/400 NetServer to send invalid datagrams to the
network browser service. The following problem has been encountered:

Due to invalid datagrams, AS/400 NetServer does not register correctly with
the browser service and, as a result, will not show up in Windows Network
Neighborhood. To solve this problem, enter an appropriate code page ID.
For most western European countries, an ID of 850 will work.

Note
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Figure 5. AS/400 NetServer WINS configuration properties

The following explanation of Scope ID is offered by the Microsoft Windows NT
Server Resource Kit:

“NetBIOS Scope, also known as TCP/IP Scope, provides a method for adding
a second element to the single-elemented NetBIOS computer name. [...] By
installation default, the NetBIOS Scope value is NULL. [...] The effect of using
a NetBIOS Scope ID, other than the default NULL value, is to isolate a group
of computers on the network that can communicate only with other computers
that are configured with the identical NetBIOS Scope ID. [...] Note: Using
NetBIOS Scope is strongly discouraged if you are not already using it, or if you
use Domain Name System (DNS) on your network.”

2.2 Changing the AS/400 NetServer name

If you are not yet using AS/400 NetServer, you need to consider what to call it.
Depending on when and how your AS/400 system was installed, you may find
that the name is set to the AS/400 system name, the serial number of your
AS/400 system with a Q in front of it, or something else. If you are currently using

There may be additional traffic related to NetBIOS over TCP name resolution
on your network as a result of having AS/400 NetServer configured as a WINS
proxy. By default, AS/400 NetServer in V4R2, V4R3, and V4R4 acts as a WINS
Proxy when the Primary or Secondary WINS server is specified. Unless you
depend on WINS Proxy support, IBM strongly recommends that you disable
this support. To disable WINS, follow these steps:

1. Click Next Start on the WINS Configuration page.
2. Type the @ symbol in the first space of the Scope ID field.

This disables the WINS proxy support the next time that the server is started.
When there is an @ symbol in the first space of the Scope ID, AS/400
NetServer will be configured with a Scope ID starting with the first character
following the @ symbol.

Note
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AS/400 NetServer, you can change the name, but you need to consider the
existing clients who will have to change their drive mappings.

You can change the AS/400 NetServer name by following these guidelines:

• If you do not have Client Access for Windows 95/NT clients who have network
drives and printers mapped to AS/400 NetServer shared resources, then the
AS/400 NetServer server name should be the same as your AS/400 system
name.

• If you intend to use the Express client, have AS/400 NetServer users with
mapped drives, but no Client Access for Windows 95/NT clients, do not
change the AS/400 NetServer name. Select Allow AS/400 NetServer access
by using AS/400 name on the AS/400 NetServer General Next Start dialog
after you install the Express client.

• If you are migrating an entire network from the Client Access for Windows
95/NT client to Express client, migrate all Windows desktops to the Express
client. Then, select Allow AS/400 NetServer access using AS/400 name on
the AS/400 NetServer General Next Start dialog. After the AS/400 NetServer
Properties have been changed, use the AS/400 system name when
configuring additional Express clients and AS/400 NetServer users.

• If you have a mixed environment with both Client Access for Windows 95/NT
and Express clients, the AS/400 NetServer name and the AS/400 system
name need to be different.

Take care when configuring the AS/400 NetServer server name. Allowing users to
access your AS/400 NetServer by using the AS/400 system name may cause
conflicts if you still have Client Access for Windows 95/NT clients in your network.
That is, when Client Access family members (other than the Express client) and
AS/400 NetServer use the same server name, server jobs for both recognize the
name. The first one to satisfy the client's request takes control and produces
inconsistent results for the client. It is important that you follow the above
recommendations when enabling AS/400 NetServer and Express client support in
your network.

2.3 Configuring your network clients

Setting up a Windows client to use AS/400 NetServer allows you to easily access
shared resources. However, you must ensure that clients can locate AS/400
NetServer in the network. If AS/400 NetServer and your Windows PC are in the
same workgroup (domain) and in the same subnet (network segment), no
additional configuration is required.

In many TCP/IP networks, routers in the network filter out User Datagram
Protocol (UDP) broadcast frames. Routers in the network filter out UDP
broadcast frames when your AS/400 and PC clients are not in the same subnet. A
client on one side of a router cannot find AS/400 NetServer because the UDP
broadcasts cannot cross the router.
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Administrators of networks that are set up to filter UDP broadcasts should
consider using one of the following options:

• Domain Name Service
• Windows Internet Name Service (WINS)
• LMHOSTS file

Each of these options is described in more detail in the following sections.

2.3.1 Domain Name Service
Make an entry for AS/400 NetServer in the network Domain Name Service (DNS)
database. TCP/IP networks can use DNS to map server names to IP addresses.
In a DNS network, an entry tells clients in the network how to map the name of
the server to its proper TCP/IP address.

Configuring DNS entries, or aliases, for both Client Access and AS/400
NetServer allows PC clients to address Client Access as SYSTEMA, while
addressing AS/400 NetServer as QSYSTEMA, even though both use the same IP
address. This step avoids any potential conflicts in the client operating system.

We recommend that you use DNS since it is the easiest way to locate and
connect to AS/400 NetServer.

2.3.2 Windows Internet Name Service
The Windows Internet Name Service (WINS) is an industry de facto standard
defined by Microsoft, and has no relationship to the Internet at all. WINS is used
by network clients to register and resolve NetBIOS names (both computer and
application names) to IP addresses. You can think of WINS as a specialized DNS
for the Windows Network Neighborhood.

Implementing WINS in a network has two advantages:

• Traffic on the network is minimized because name resolution requests are
sent directly to the WINS server.

• If a Windows NT domain is made up of several subnets that are connected via
routers, WINS easily enables computers across subnets to share resources.

You can use a WINS server with AS/400 NetServer in the following ways:

• Configure PC clients with the WINS server IP address. Proper configuration
allows clients to send all WINS requests directly to the network WINS server.
This is the best solution for WINS clients that are in the same workgroup
(domain) as AS/400 NetServer, when you do not configure AS/400 NetServer
as a WINS proxy.

• Place PC clients in the same subnet (network segment) as the WINS server.
The WINS server automatically handles name resolution requests with no
additional PC client configuration. This is the best solution for WINS clients
that are in the same subnet as the WINS server, and when you configure
AS/400 NetServer as a WINS client, but not as a WINS Proxy.

• Place PC clients in the same subnet as the AS/400 system with AS/400
NetServer configured with a WINS server IP address. In this case, clients
connect to the AS/400 system as a WINS proxy server. AS/400 NetServer
routes all WINS requests to the WINS server. Using AS/400 NetServer as a
WINS proxy is the best solution for WINS clients that are in the same subnet
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as AS/400 NetServer, but a different subnet than the WINS server. In this
scenario, PC clients do not require any additional configuration to use WINS.

You can specify an address for a network WINS server on the AS/400
NetServer WINS Configuration, Next Start tab dialog in Operations Navigator.
You can then configure clients to connect to AS/400 NetServer by using the
WINS server.

2.3.3 LMHOSTS file
Create entries for AS/400 NetServer in the PC clients static configuration files
(such as LMHOSTS). PC client operating systems can provide static
configuration files that map server names to TCP/IP addresses. These files are
typically more difficult to manage than a solution that involves more centralized
control (for example, a DNS or WINS server). This difficulty results because your
network administrator must configure each PC client individually. Static
configuration files are useful, however, in large, distributed networks. In this
environment, clients and servers exist in different subnets (network segments)
and possibly different workgroups (domains). Static configuration files help
clients locate servers.

All PC clients supported by AS/400 NetServer can use an LMHOSTS file that
maps AS/400 NetServer names to IP addresses. Mapping the IP address for
AS/400 NetServer allows clients to find AS/400 NetServer in a large, distributed
network environment.

You may also add an entry into the LMHOSTS file that points to an LMHOSTS file
that is administered centrally on the AS/400 system. By pointing all clients to the
central file on the AS/400 system, you need maintain only one LMHOSTS file for
the network. For information on creating a LMHOSTS file, see 5.2.1, “Creating an
LMHOSTS file” on page 58.

2.4 Configuring the guest user profile

A guest user profile provides a base level of access for clients who do not have a
valid AS/400 user profile. AS/400 NetServer does not automatically configure
guest support. Therefore, users without valid AS/400 user profiles will not be able
to access integrated file system directories and output queues using AS/400
NetServer. To allow guests to have access to AS/400 shared resources, you must
configure the AS/400 NetServer Advanced Next Start properties with a user
profile for guest, or anonymous, users.

To configure a guest user profile, follow these steps:

1. Open a connection to Operations Navigator on your AS/400 system.

2. Expand Network.

If you want to use both DNS and WINS on a Windows NT client for computer
name to IP address resolution, configure the DNS page of the TCP/IP
properties found in the Windows NT Network properties. Then, enable DNS for
Windows resolutions on the WINS configuration page of the TCP/IP properties.

Note
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3. Expand Servers.

4. Click TCP/IP to retrieve a list of TCP/IP servers available.

5. Right-click AS/400 NetServer, and select Properties. The window shown in
Figure 6 appears.

Figure 6. Specifying the guest user profile

6. Go to the Advanced dialog, and click Next Start.

7. In the Guest User Profile field, enter the AS/400 user profile that you want
guests to use.

There are security implications involved with creating a guest user profile. For
more information, see 4.1.1, “Considerations for using the guest user profile” on
page 51.

2.5 Finding AS/400 NetServer on the network

To use AS/400 NetServer, you must be able to find it in your Windows Network
Neighborhood. If AS/400 NetServer and your PC client are in the same
workgroup (domain) and in the same subnet, follow these steps:

1. Open Windows Network Neighborhood.

2. Select AS/400NetServerName (where AS/400NetServerName is the name of
the AS/400 NetServer on the AS/400 system).

Another method is described here:

1. Open the Windows Start menu.

2. Select Find-> Computer.

You must have *IOSYSCFG and *SECADM special authority to change the
guest user profile. Changes will take effect the next time AS/400 NetServer
is started.

Note
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3. In the Find: Computer dialog, enter the server name of AS/400 NetServer on
the AS/400 system.

4. Click OK.

The possible results are displayed in Table 1.

Table 1. Find: Computer results

Figure 7 shows an example of AS/400 NetServer and its proper domain and
description. If you experience problems finding AS/400 NetServer, refer to 5.2,
“Troubleshooting the AS/400 NetServer location on the network” on page 56.

Figure 7. Find: Computer with correct AS/400 NetServer domain and description

Location Comment Result

Network Neighborhood No Comment You have connected using Client
Access/4001.

Unknown No Comment You are not authenticated. Your
Windows password and your
AS/400 password do not match.

AS/400 NetServer domain2 AS/400 NetServer
description3

You have successfully connected to
AS/400 NetServer and are
authenticated. Your Windows and
AS/400 passwords match.

Notes:

1. A description is not required for AS/400 NetServer, so there may not be a comment.
In addition, Windows clients sometimes show Network Neighborhood in the location
when the PC and AS/400 NetServer domains match.

2. The AS/400 NetServer domain is the actual domain of which your AS/400 NetServer
is a member.

3. The AS/400 NetServer description is the actual description that was specified when
AS/400 NetServer was configured.
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2.6 Starting AS/400 NetServer at IPL

In V4R4, AS/400 support for Windows Network Neighborhood (AS/400
NetServer) requires that TCP/IP be active. As a result, AS/400 NetServer is now
automatically started and ended as a TCP server when the Start TCP/IP (STRTCP)
or End TCP/IP (ENDTCP) commands are evoked. Additionally, AS/400 NetServer
can be started and ended as an individual TCP/IP server with the use of the Start
TCP/IP Server (STRTCPSVR SERVER(*NETSVR)) and End TCP/IP Server (ENDTCPSVR
SERVER(*NETSVR)) commands.

You can specify whether AS/400 NetServer starts automatically when TCP/IP is
started by selecting the Start when TCP/IP is started check box on the AS/400
NetServer General Next Start dialog. This value affects TCP/IP start behavior. It
is not an AS/400 NetServer property so the changes will take effect immediately.
When using AS/400 Operations Navigator in the Client Access Express for
Windows client (Express client), you can find this dialog by following these steps:

1. Follow the path Network-> Servers-> TCP/IP-> AS/400 NetServer.
2. Right-click on the AS/400 NetServer icon.
3. Select Properties.
4. Select the General tab.
5. Click the Next Start button.

2.6.1 Special AS/400 NetServer considerations for V4R2 and V4R3
AS/400 NetServer runs under the QSERVER subsystem, uses TCP/IP, and has
some unique startup considerations that vary depending upon which release of
OS/400 you are using. At release level V4R2M0 or V4R3M0, the QSERVER
subsystem is shipped with an autostart job entry to start AS/400 NetServer.
However, for AS/400 NetServer to start up, it requires that TCP/IP be started first.

When the AS/400 initial program loads (IPLs), a Control Language startup
program (by default, QSYS/QSTRUP) is executed. This starts the QSERVER
subsystem, and therefore, starts QZLSSERVER (AS/400 NetServer).

QZLSSERVER will log error messages in QSYSOPR, or will not fully initialize, if
TCP/IP is not started when QZLSSERVER is started. To avoid this situation, you
can modify the startup program defined in the system value QSTRUPPGM. The
autostart job in the controlling subsystem transfers control to the program
specified in the system value QSTRUPPGM during an IPL.

You can create your own program and change the QSTRUPPGM system value to
that program name. You can also use the shipped program QSTRUP in QSYS as
a base to create your own program. To do this, follow these steps:

The AS/400 NetServer job (QZLSSERVER) runs in the QSERVER subsystem.
In addition, the Start Server (QZSLSTRS) and End Server (QZLSENDS) APIs
still start and end the server. Because of this, no changes are needed in your
start-up program (from V4R2 and later) if the QSERVER subsystem is started
before TCP/IP is started.

Note
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1. Retrieve the source of the shipped program using the RTVCLSRC command,
for example:

RTVCLSRC PGM(QSYS/QSTRUP) SRCFILE(YOURLIB/YOURFILE)

You may want to use QGPL/QCLSRC for YOURLIB/YOURFILE because this file already
exists.

2. Change the program as described here:

a. Add a statement to start TCP/IP (STRTCP) after QSYS/QSTRUP has
completed.

b. Add a call to start QZLSSERVER after starting TCP/IP (CALL QZLSSTRS

PARM('0' X'00000000')).

3. Create the program using the Create CL Program (CRTCLPGM) command, and
place it into your own library or QGPL.

4. Remove the Autostart Job Entry for QZLSSERVER from the QSERVER
subsystem description.

5. Test the program to ensure that it works.

6. Change the system value QSTRUPPGM to the program name and library you
specified on the CRTCLPGM command.

More information about the system value QSTRUPPGM can be found in Work
Management, SC41-5306.
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Chapter 3. Using AS/400 NetServer

Using AS/400 NetServer, you have the ability to access AS/400 shared resources
using the native file and print serving services of the Windows operating system.
Appendix B, “Using applications with AS/400 NetServer” on page 135, contains
an example of installing and using some common applications with AS/400
NetServer.

Integrated file system resources with AS/400 NetServer must be shared or they
will not be visible or available on the network.

There are two types of shared objects:

File shares Shared integrated file system directories on the AS/400 system
Print shares Shared AS/400 output queues

You can click Shared Objects to view all directories and output queues that are
currently shared. If you have never used AS/400 NetServer before, you may see
some objects that already exist. The list may include QCA400 and QIBM, which
contain files that are associated with Client Access. An example of a list of
shared objects is shown in Figure 8.

Figure 8. AS/400 shared objects

You can view a list of shared objects by performing the following steps:

1. Open a connection to Operations Navigator on your AS/400 system.
2. Expand Network.
3. Expand Servers.
4. Click TCP/IP to view a list of TCP/IP servers available.
5. Right-click AS/400 NetServer, and select Open.
6. Expand Shared Objects to display a list of currently shared objects.

You must have *IOSYSCFG special authority to add or change the AS/400
NetServer file or print share configuration, or own the directory or output queue
in V4R4 and later.

Note
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3.1 AS/400 NetServer file shares

An AS/400 NetServer file share is a directory path that AS/400 NetServer shares
with PC clients on the network. A file share can be configured for any integrated
file system directory on the AS/400 system. You can create, display, configure,
and end AS/400 NetServer file shares.

To create a new file share by using Operations Navigator, follow these steps:

1. Open a connection to Operations Navigator on your AS/400 system.

2. Expand Network.

3. Expand Servers.

4. Click TCP/IP to retrieve a list of TCP/IP servers available.

5. Right-click AS/400 NetServer, and select Open.

6. Right-click Shared Objects, and select New-> File.

7. Use the General Properties page, as shown in Figure 9, to configure the new
file share with a name, description, access, maximum number of users, and
directory path name.

Figure 9. Create a new file share

If you do not know the directory path, you can click on the Browse button to
get a list of the integrated file system. An example is shown in Figure 10 on
page 27.

Unlike Client Access, AS/400 NetServer does not share the entire integrated
file system with the network by default. The directories that are automatically
shared with the network are QCA400 (by AS/400 NetServer) and QIBM (by Client
Access Express for Windows).

Note
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Figure 10. Browsing the integrated file system

You have to explicitly share a directory or library on the AS/400 system to
make it available through AS/400 NetServer. Unlike the Network Drive of
Client Access for Windows clients, the entire integrated file system including
QSYS.LIB is not visible to all clients, only those objects that are shared.

8. Use the Text Conversion page to identify which file types will have their
contents converted from the AS/400 file code page to the code page you
specify for the share. For more information, see 3.1.1, “File text conversion” on
page 29.

To create a new folder in the AS/400 integrated file system, using Operations
Navigator, follow these steps:

1. Expand File Systems.

2. Expand Integrated File System.

3. Right-click Root, and select New Folder.

4. Enter the name for the new object. This new folder now displays when you
browse to the location of where you want to place your new file share.

You can stop the sharing of an integrated file system directory by right-clicking on
the shared resource and selecting Stop Sharing. However, a file share that is
stopped is still available to clients that are already using the share. A file share
that has been ended is not available for any new client requests. Any attempts to
create a new connection to this share will fail. In addition, once you have selected
to stop sharing a resource, the share is removed entirely, but the directory is not
removed.

To remove the directory, follow these steps:

1. Expand File Systems.
2. Expand Integrated File System.

You can also create a share on an existing integrated file system directory
from within Operations Navigator if you right-click on the directory, and
select Sharing-> New Share.

Tip
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3. Select Root.
4. Find the directory that you want to remove, right-click, and select Delete.

At this point, keep in mind that when you create a new folder in the integrated file
system, by default, the AS/400 system gives *PUBLIC all rights to this object. If
you do not want to allow this type of permission, in the integrated file system
under the Root folder, right-click on the new object that you just created and
select Permissions. The display shown in Figure 11 appears.

Figure 11. Folder permissions

At this point, if you prefer to limit access to selected users that you choose, select
the Exclude check box from the Public name. If a share is defined with
Read/Write access and the objects accessible through this share have their
permissions set to *PUBLIC *ALL, all users have access to your files. Add specific
authorities for selected users by name or group.

If a share that you create is defined as Read/Write, normal AS/400 security is
in effect. That is, the authority that is granted under the AS/400 user profile and
the permissions set for that particular directory will be used.

However, if a share is set to Read only, the privileges granted by the AS/400
user profile do not matter. Files in that directory cannot be altered, moved, or
deleted.

Note
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3.1.1 File text conversion
In V4R4 and later, you can specify AS/400 file types that are automatically
converted from EBCDIC to ASCII and vice versa. With text conversion enabled,
AS/400 EBCDIC data is automatically translated to ASCII when it is downloaded
to the PC to be viewed, for example, using Windows Notepad.

To configure text conversion on an existing file share, information on the Text
Conversion page must be added as shown in Figure 12.

Figure 12. File text conversion

Using Operations Navigator, follow these steps:

1. Open a connection to Operations Navigator on your AS/400 system.

2. Expand Network.

3. Expand Servers.

4. Click TCP/IP to retrieve a list of TCP/IP servers available.

5. Right-click AS/400 NetServer, and select Open.

6. Double-click Shared Objects.

7. Locate the file share that requires the text conversion, and right-click on it.
Select Properties.

8. Click on the Text Conversion tab.

The Code Page parameter defines the ASCII code page used for converting data
for this share. The default is to use the AS/400 NetServer code page. You define
the AS/400 NetServer code page on the AS/400 NetServer Properties page
shown in Figure 4 on page 15.

The text conversion is triggered by file extensions. For example, an AS/400 file
member is displayed in the Network Neighborhood with the file extension .mbr. To
enable automatic text conversion for file members, follow these steps:

1. Type the extension type of the files that you want to convert. In the example
shown in Figure 12, the .mbr file type is added.
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2. Click the Add button.

3. Click OK.

This functionality may be particularly useful for customers who wish to edit files
such as the source of the AS/400 startup program (by default QSYS/QSTRUP).
Figure 13 shows the source of the QSTRUP program as seen on the AS/400
when using Source Entry Utility (SEU).

Figure 13. QSTRUP program

Using AS/400 NetServer, you can now edit the source physical file member with a
PC text editor. An AS/400 NetServer file share is configured to the location where
the source physical file member resides. The Text Conversion properties are
modified as shown in Figure 12 on page 29.

Figure 14 on page 31 shows the directory representation of the source physical
file that holds the member we want to change.

• Text conversion is disabled when the option Allow file text conversion is
deselected.

• If necessary, you can share a file more than once. This may be a useful
solution if more than one user wants to perform text conversion for different
languages on the same file.

Notes

Columns . . . : 1 71 Browse QGPL/STRUP
SEU==> QSTRUP
FMT ** ...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7

*************** Beginning of data *************************************
0001.00 /********************************************************************/
0002.00 /* */
0003.00 /* 5769SS1 V4R4M0 990521 RTVCLSRC Output 10/19/99 10:07:11 */
0004.00 /* */
0005.00 /* Program name . . . . . . . . . . . . . . : QSTRUP PN*/
0006.00 /* Library name . . . . . . . . . . . . . . : QSYS PL*/
0007.00 /* Original source file . . . . . . . . . . : QCLSRC SN*/
0008.00 /* Library name . . . . . . . . . . . . . . : QGPL SL*/
0009.00 /* Original source member . . . . . . . . . : QSTRUP SM*/
0010.00 /* Source file change */
0011.00 /* date/time . . . . . . . . . . . . . . : 10/13/99 19:05:55 SC*/
0012.00 /* Patch option . . . . . . . . . . . . . . : *NOPATCH PO*/
0013.00 /* User profile . . . . . . . . . . . . . . : *USER UP*/
0014.00 /* Text . . . : TX*/
0015.00 /* Owner . . . . . . . . . . . . . . . . . : DEEPAKP OW*/
0016.00 /* Patch change ID . . . . . . . . . . . . : PC*/

F3=Exit F5=Refresh F9=Retrieve F10=Cursor F11=Toggle F12=Cancel
F16=Repeat find F24=More keys
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Figure 14. File share

If files with extension .mbr are not associated with any text editors on the PC, you
can hold the Shift key down and right-click on the file to obtain an Open With...
command. You can then select which editor you wish to use to view and amend
the file.

In Figure 15, we use the Notepad utility to edit the Qstrup.mbr file.

Figure 15. Notepad view of file member

In our environment, we deleted some lines using Notepad. When the file was
saved by using File-> Save, the changes could be seen in the AS/400 file
member when it was viewed as an EBCDIC file with SEU.

3.2 Mapping network drives

You can use your Windows clients to access AS/400 file shares with AS/400
NetServer by simply mapping a logical drive. Depending on your operating
system, the procedures used to accomplish this may be somewhat different.
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Windows 95/98/NT
There are several ways to map network drives:

• Select Find-> Computer. Locate your AS/400 NetServer. Then, open it by
double-clicking on it. Select the file share you need, and right-click on it to get
the context menu. Select Map Network Drive.

• Using Windows Explorer, open the Tools file pull-down menu, and select Map
Network Drive.

• Through Operations Navigator, select File Systems-> File Shares.

• Use the NET USE command.

To map a network drive using Windows Explorer, follow these steps:

1. Right-click the Start button, and choose Explore to open the Windows
Explorer.

2. Open the Tools pull-down menu on the Windows Explorer, and select Map
Network Drive.

3. Select the letter of a free drive for the file share.

4. Enter the Universal Naming Convention (UNC) name of an AS/400 NetServer
file share, where AS/400NetServerName is the server name of AS/400 NetServer
on AS/400, and Sharename is the name of the file share you want to use.

For example, you could enter the following name:

\\AS/400NetServerName\Sharename

5. Click OK.

Windows 3.11
To map an AS/400 NetServer file share to a logical drive on your Windows 3.11
PC, follow these steps:

1. Open the Windows File Manager.

2. Open the File menu, and select the Connect Network Drive menu item.

3. Specify the UNC name of the file share in the Path field, where
AS/400NetServerName is the name of AS/400 NetServer on AS/400 and
Sharename is the name of the file share you want to use. For example, you
could enter:

\\AS/400NetServerName\Sharename

4. Click OK.

Operations Navigator
An AS/400 NetServer administrator can use Operations Navigator to map a drive
to a share that was created using AS/400 NetServer. To do this, follow these
steps:

The UNC is a naming format used to specify the location of resources on a
local area network (LAN). UNC uses the following format:

\\server-name\shared-resource-pathname

Note
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1. Open a connection to your AS/400 using Operations Navigator.

2. Expand File Systems.

3. Open File Shares.

4. Right-click on the share to which you want to map, as shown in Figure 16.

Figure 16. Map a network drive

5. Select Map Network Drive....

6. Select a drive letter that is currently not being used.

If you do not know what operating system you are using, the following example
creates a logical drive, regardless of the Windows platform:

1. Open an MS-DOS window.

2. Enter the following command (where z: is a drive not in use,
AS/400NetServerName is the name of your AS/400 NetServer, and Sharename is
the name of the file share that you want to map):

net use Z: \\AS/400NetServerName\Sharename

You do not always need to map a drive to access files in a shared directory.
Instead, you can use the Windows drag and drop function to place the shared
file or folder on your desktop. To do this, follow these steps:

1. Use Find-> Computer to access AS/400 NetServer.
2. Select the shared resource.
3. Drag and drop the shared resource to your desktop.

Notes
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Provided that you have the proper authority, you can also use the Copy and
Paste function or the drag-and-drop technique to copy and move files between
AS/400 NetServer and other clients on the Microsoft network. For example, in
Figure 17, you can copy the test.txt file from the AS/400 NetServer (Qas08) to
the Test directory in the AS/400 NetServer (Qas23) by using either the Copy
function or the drag-and-drop technique. You can drag the test.txt icon from within
the window on Qas08 onto the icon for the Test directory on QAS23. The file will
be copied into the directory.

Figure 17. Copying the test.txt file to the Test folder

3.3 AS/400 NetServer print shares

You can share any AS/400 output queue with PC clients in the network by using
AS/400 NetServer. Consequently, you can create, display, configure, and end
print shares.

AS/400 NetServer uses the QNPSERVD and QNPSERVS jobs for printing. These
are the same jobs used by Client Access for Windows 95/NT. These Network
Print Server jobs can be started by using the following command once the
QSYSWRK and QUSRWRK subsystems are started:

STRHOSTSVR SERVER(*NETPRT)

To create a print share by using Operations Navigator, follow this process:

1. Open a connection to Operations Navigator on your AS/400 system.
2. Expand Network.
3. Expand Servers.
4. Click TCP/IP to retrieve a list of the TCP/IP servers available.
5. Right-click AS/400 NetServer, and select Open.
6. Right-click Shared Objects, and select New. Then, select Printer.

The window shown in Figure 18 on page 35 appears. If you are using OS/400
V4R2 or V4R3, your display will look slightly different since you will not have a
Printer file option and you cannot specify the Spooled file type to be
Auto-select.
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Figure 18. Create a print share

7. Configure the new print share with a name, description, output queue, printer
driver, spooled file type, and printer file.

3.3.1 Authority considerations
Authority to access the AS/400 output queues is required and can be set by using
the Edit Object Authority (EDTOBJAUT) command. It is important to review the
necessary authorities to prevent unauthorized actions on the spooled files in the
output queues.

At least *USE authority must be defined for the users who should use an output
queue. It may be easier to give *PUBLIC the *USE authority. This level of
authority allows the following operations on the output queue:

• Spooled files can be sent to that output queue.

• All spooled files on the output queue can be seen.

• Only the users’ individual spooled files can be manipulated. Alterations,
including deleting, to any other spooled files will be rejected with an authority
error.

A user created with *SPLCTL special authority on the AS/400 system can perform
all functions on all the entries in an output queue. The security of spooled files
and output queues is covered in OS/400 Security, SC41-5302.

The default printer file is *LIBL/QPNPSPRTF and is located in the QSYS
library by default.

Note
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3.4 Installing a network printer

Once you share an AS/400 output queue with the network, you have to enable
the PC client to direct the output to this particular output queue. This is achieved
by installing a network printer in Windows. A print share consists of an AS/400
output queue and output queue library, printer driver, and spooled file type. The
following spooled file types are supported:

• User ASCII: Is used when the application is able to generate printer output
specific to a certain type of printer.

• Advanced Function Printing (AFP): Is a printer definition language that is
used on laser printers attached to the AS/400 system. It is used to mix text
and graphics.

• SNA Character String (SCS): Is widely used with matrix and line printers
attached to the AS/400 system. SCS printers are typically used to print lists.

• Auto-select: AS/400 NetServer determines which type of printer data stream
is used in the output sent to the AS/400 system and creates the spooled file.
Auto-select is available in V4R4 and later.

A printer that you share may be attached to the AS/400 system in one of three
ways:

• Locally
• Over a LAN
• Through a PC5250 printer emulation

3.4.1 Using an IBM AFP or SCS printer

To use an IBM AFP or SCS printer, you can install the printer drivers shipped with
Client Access Express for Windows. Follow these steps to install the network
printer:

1. Connect to AS/400 NetServer, and open the explorer view of the AS/400
NetServer shares, as shown in Figure 19 on page 37.

The spooled file types determine how the spooled files are created on your
AS/400 system. If Auto-select is not used, the spooled file type must
correspond exactly to the output queue destination or you will experience a
print error. IBM recommends using Auto-select unless you experience
problems with printing. For more information, refer to AS/400 Printing V,
SG24-2160.

Note

It is important to note that the printer driver specified in the AS/400 NetServer
print share configuration (shown in Figure 18 on page 35) must match the
printer model. This is so the correct driver is used when adding a printer on the
PC client.

Note
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Figure 19. Available AS/400 NetServer shares

2. Double-click on the print share that you want to use. The message box shown
in Figure 20 appears.

Figure 20. Installing a printer driver

3. Click Yes and proceed through the Add Printer Wizard display shown in Figure
21.

Figure 21. Add Printer Wizard

The procedure that is used to access print shares, and this wizard, is
somewhat different depending on the Windows operating system that you
use. Refer to 3.5, “Using your Windows clients to access print shares” on
page 39, for more information.

Note
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4. If you have not installed the specified printer driver on the client PC that was
defined in the Printer Driver box within the print share definition (see Figure 18
on page 35), then you will be prompted with a list of drivers, as displayed in
Figure 22. This choice is also necessary if no printer driver was specified in
the Printer Driver options within the print share definition.

Figure 22. Add Printer Wizard

Select the appropriate printer model. The name of the printer model is the
Printer Driver name you need to specify when defining a print share as shown
in Figure 18 on page 35.

When you click Next on this panel, a printer object is added to your PC printer
folder. You can now use this printer from any Windows application.

3.4.1.1 AS/400 AS/400 NetServer without Express client
If you are using AS/400 AS/400 NetServer without Client Access Express for
Windows, you can find stand-alone AFP and SCS printer drivers in the Client
Access for Windows 95/NT directory (\QCA400\Win32\Install\Printer) on the
AS/400 system. AFP print drivers are also available for free as a download from
the IBM Printing Systems Company Web site at: http://www.printers.ibm.com

Note, however, that you do not need a Client Access/400 Windows Family license
(5769XW1) to use the AFP and SCS printer drivers available from Client Access
Express for Windows install images accessed by using the QIBM AS/400
NetServer file share.

Client Access family members (prior to Express client) must use a custom
installation and select printer drivers under Operations Navigator to cause
IBM to show up as a printer manufacturer.

Note
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3.5 Using your Windows clients to access print shares

There are several ways to install network printers with Windows 95/98/NT:

• Select Find-> Computer. Locate your AS/400 NetServer. Then, open it by
double-clicking on it. Select the print share. Then, right-click to get the context
menu with Open or Install.

• Double-click on the print share you wish to install.

• Select Start-> Settings-> Printers, double-click Add Printer, and specify the
UNC name of the network printer in the format:

\\AS/400ServerName\ShareName

• Use the NET USE command.

You can use your Windows clients to access print shares with AS/400 NetServer
by completing the steps described in the following sections.

Windows 95/98
To access print share using Windows 95 or 98, complete this series of steps:

1. Open the Windows Start menu.
2. Select Find, and then select Computer.
3. Enter the AS/400 NetServer server name.
4. Click Find Now.
5. When the computer is found, double-click on it.
6. Double-click on the shared printer.
7. Select Yes to setup the printer.
8. Select the appropriate response for MS-DOS based programs.
9. If prompted, select the appropriate driver for your printer.
10.Click Next
11.If prompted, enter a printer name for your shared printer, and then click Next.
12.Choose whether to print a test page from the shared printer.
13.Click Finish.

Windows NT
When using Windows NT to access the print shares, follow these steps:

1. Open the Windows Start menu.
2. Select Find, and then select Computer.
3. Enter the AS/400 NetServer server name.
4. Click OK.
5. Open AS/400 NetServer by double-clicking the computer that was found.
6. Right-click a shared printer, and select Open.
7. If prompted, select Yes to set up the printer on your computer.
8. If prompted, select the appropriate driver for your printer.
9. Click Next.
10.When you have properly set up the shared printer, click Finish.

Windows 3.11
You can use your Windows 3.11 (Windows for Workgroups) PC client to access
print shares from the AS/400 system with AS/400 NetServer by following these
steps:

1. Map an AS/400 printer output queue to a logical printer on the Windows 3.11
PC client:
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a. Open an MS-DOS window.

b. Enter the following command at the DOS prompt to get a list of AS/400
print shares:

net view \\AS/400NetServerName

c. Choose a print share (output queue) name from the list provided.

d. Enter the following command:

net use lpt2: \\AS/400NetServerName\Sharename

2. Map the AS/400 NetServer print share to a Windows 3.11 PC client printer
driver:

a. Open Control Panel in the Main program group.

b. Open Printers.

c. Click the Add button on the Printers window.

d. Select the appropriate printer from the list provided.

e. Click Install. You may need to provide the necessary printer driver with
your Microsoft Windows 3.11 installation diskettes.

f. Select the installed printer driver.

g. Click Connect.

h. Select the logical printer port you mapped in earlier (for example, lpt2), and
click OK.

In this example, the name of the logical printer port that you want to map
the print share to is lpt2. AS/400NetServerName is the name of AS/400
NetServer on AS/400. Sharename is the name of the desired print share.

Note

If you choose to delete a configured printer, you may be prompted with a
message indicating that certain files are no longer in use and will also be
deleted. These files include the necessary printer driver. Select Yes if you are
sure that the printer will not be used again. If you then find that you want to use
it later, you have to reinstall the driver.

Note
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3.6 PC5250 printer emulation session

Consider the example shown in Figure 23.

Figure 23. PC5250 printer emulation

PC2 is connected to an AS/400 system on the Token-Ring using Client Access.
Printer NP12, which is an IBM Network Printer 12, is attached to the parallel port
of PC2. The printer is a Postscript printer.

There is a PC5250 printer emulation session on PC2 that connects NP12 to the
AS/400 system. In Figure 23, this connection is represented with the arrow
marked with a "1". The AS/400 system cannot print to NP12 because the printer
is a Postscript printer, and the AS/400 system cannot produce Postscript output.

In our example, the AS/400 system shares an output queue for printer NP12
using the spooled file type User ASCII.

PC1 is connected to the AS/400 system and the AS/400 NetServer, and has
requested to install a network printer for the print share NP12. In the course of
installing the printer, the printer driver is requested, as shown in Figure 20 on
page 37. The printer driver used will be IBM Network Printer 12 because that is
the type of printer installed on PC2.

The (virtual) connection between PC1 and NP12 is shown as an arrow marked
with a "2" in Figure 23.

Connection 1 is PC5250 printer emulation. The printer data stream is sent from
the AS/400 system to PC2, which in turn sends it to the printer attached to it.

Connection 2 is printer sharing. PC1 sends its printer data stream to the AS/400
system, which forwards it to the printer attached to PC2.

In this example, PC1 is spooling data to a PC attached printer. Therefore, the
print share on AS/400 NetServer is configured to spooled file type User ASCII.
That means the AS/400 system does not process the data sent from PC1, but
sends it directly to PC2, which, in turn, passes it on to NP12. The output queue
on the AS/400 system that is created for this printer emulation session can be
shared using AS/400 NetServer.

PC1

PC2

AS/400

NP121

2
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For more information on PC5250 printer emulation, refer to AS/400 Client Access
Express for Windows: Implementing V4R4M0, SG24-5191.

3.7 Using AS/400 NetServer from a DOS window

There are still users who prefer a simple command line over a GUI. There are still
methods in Windows that allow network administration and resource access
using a command prompt. Of course, these commands can also be used in batch
files. Here are a few examples:

net view \\qas400
Gives a list of all shared resources for AS/400 NetServer Qas400

net use x: \\qas400\qibm
Maps the directory shared with AS/400 NetServer file share qibm to network
drive x:

net use x: /del
Disconnects the drive mapped x:

dir \\qas400\qibm
Displays the contents of the directory shared with AS/400 NetServer file
share qibm

net print \\qas400\printer
Displays the list of spooled files in the output queue shared with AS/400
NetServer print share printer

net use lpt3: \\qas400\printer
Redirects a local print port towards the output queue shared with the AS/400
NetServer print share printer

net use lpt3: /del
Disconnects the redirected port lpt3:

3.8 AS/400 NetServer session properties

AS/400 NetServer starts a session on the AS/400 system whenever a client
accesses a shared file or print resource. You can view the current statistics for a
workstation session connection to AS/400 NetServer through Operations
Navigator. The session displays the PC client and user name, as well as the
properties that document the activity of the user since the session was
established. However, you cannot change or reconfigure the session connection
statistics, because they are records of client activity that only contain information.

After you view the list of available sessions, double-click a session. Then,
right-click the share connection, and select Status. In addition, you can end a
session by right-clicking on the user session and selecting Stop. This stops all
client workstation use of file and print shares on that session.

If the printer that you share is neither an AFP or a SCS printer or a PC5250
printer emulation session, you need to install the driver of the printer
manufacturer.

Note
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To display the properties for an AS/400 NetServer session, follow these steps:

1. Open a connection to your AS/400 using Operations Navigator.

2. Expand Network.

3. Expand Servers.

4. Click TCP/IP to retrieve a list of the TCP/IP servers available.

5. Right-click AS/400 NetServer, and select Open.

6. Expand Sessions. If any sessions have been established, they will be
displayed as shown in Figure 24.

Figure 24. AS/400 NetServer sessions

7. Right-click a user session, and select Properties. Information about a
particular session is displayed, as shown in Figure 25.

Figure 25. AS/400 NetServer session properties
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3.8.1 Multiple user support
AS/400 NetServer now supports multiple users, including guests, logged on from
the same workstation. Information for each session now displays the actual user
name even if the guest account was used for authentication. If guest support is
used to establish the session, the value of the Logon Type indicates Guest as
shown in Figure 26.

Figure 26. Multiple session support

As a result, you can see duplicate sessions with the same workstation and user
name, when you display session properties for the duplicate session. The
cumulative total from all sessions with the same workstation and user name is
retrieved for the following fields:

• Number of connections
• Number of files opened

The shortest idle time and the longest session establishment time retrieved from
all sessions with the same workstation and user are also displayed. This also
applies if multiple sessions are established for a workstation with different users,
and the User profile name field contains a value of *.

There may be more AS/400 NetServer sessions than there are users accessing
AS/400 NetServer. These additional sessions are established by the client for
various reasons, and they may have active user activity. Because AS/400
NetServer now allows the establishment of multiple sessions from the same
workstation, many times clients take advantage of this support even for a single
user.

When listing explored shared objects for an individual session, connection
information for all sessions with the same workstation name are displayed.

When the AS/400 NetServer idle time-out value has expired for a session, then
that session will end. This occurs regardless of whether there are open files for
that session.

When you attempt to end an AS/400 NetServer session for a workstation from
which multiple sessions are established, an unpredictable subset of sessions with
the same workstation name is ended. AS/400 NetServer ends the first NetBIOS
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over TCP/IP (NBT) session found for that workstation, which could result in the
specified AS/400 NetServer session being ended along with all other user activity
for that NBT session, or another AS/400 NetServer session altogether. For more
information on this topic, see 8.5.1, “Multiple session support” on page 122.

Multiple users can be active from the same workstation session. Ending a user
session ends all AS/400 NetServer file and print activity for that workstation
session.

3.9 Monitoring AS/400 NetServer

This section demonstrates how to view the AS/400 NetServer status and
statistics.

3.9.1 Viewing AS/400 NetServer status
The AS/400 NetServer status screen provides an overview of various statistics
relating to an active AS/400 NetServer. To display the AS/400 NetServer status
screen, follow these steps:

1. Open a connection to your AS/400 using Operations Navigator.
2. Expand Network.
3. Expand Servers.
4. Click TCP/IP to retrieve a list of the TCP/IP servers available.
5. Right-click AS/400 NetServer, and select Status.

Figure 27 shows the status information available for AS/400 NetServer.

Figure 27. AS/400 NetServer status
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In addition, there are three buttons that are available:

• Refresh Now: When used, this button refreshes the screen immediately.

• Timed Refresh: The frequency of the refresh can be configured. When the
Timed Refresh window appears, check the Timed Refresh box. This enables
a value (in minutes) to be entered.

• Reset Status: When used, this button resets all statistics to zero.

Because there is no longer a one-to-one correlation between the NBT and
AS/400 NetServer sessions, the AS/400 NetServer Statistics have different
meanings. Values for Sessions ended with errors and Duplicate sessions are no
longer supported and will always be zero. Sessions disconnected normally
include sessions disconnected for any reason except being idle timed out.

For further details on the individual statistics, consult the Operations Navigator
Help information.

3.9.2 Displaying server jobs
Starting with V4R4, it is possible to view the server jobs running on the AS/400
system. This also includes all AS/400 NetServer related jobs.

To view the server jobs, perform the following steps:

1. Open a connection to your AS/400 using Operations Navigator.
2. Expand Job Management.
3. Expand Server Jobs.

From this window, you can manipulate an AS/400 NetServer job and gather
information about it. This is done by selecting the job and right-clicking on it.

3.9.3 Viewing shared object status
The Shared Object Status screen displays the current statistics for the shared
object connection to the server. To view the shared object status window,
complete the following tasks:

1. Open a connection to your AS/400 using Operations Navigator.

2. Expand Network.

3. Expand Servers.

4. Expand TCP/IP.

5. Right-click AS/400 NetServer, and select Open.

6. Expand Sessions.

7. Click on the object for which the status information is required. The shared
object connections are listed in the right column of the screen.

8. Right-click on the required shared object connection, and select Status. The
window shown in Figure 28 on page 47 is displayed.
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Figure 28. Shared object status

For further details on the individual statistics, refer to the Operations Navigator
Help information.

3.9.4 Viewing session status
The Session Status screen displays the current statistics for the workstation
connection to the server. To view the session status window, complete the
following steps:

1. Open a connection to your AS/400 using Operations Navigator.

2. Expand Network.

3. Expand Servers.

4. Expand TCP/IP.

5. Right-click AS/400 NetServer, and select Open.

6. Expand Shared Objects.

7. Double-click on the client for which the status information is required. The
session connections are listed in the right column of the screen.

8. Right-click on the required session connection, and select Status. The
window shown in Figure 29 on page 48 is displayed.
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Figure 29. Session status

For further details on the individual statistics, refer to the Operations Navigator
Help information.

3.10 Backup and recovery of configuration and share information

AS/400 NetServer uses files in the integrated file system to store configuration
values and share information. User data is also in the integrated file system. All
these files can be saved using normal AS/400 commands:

• SAVOBJ or SAVLIB: Used if the data resides in QSYS or libraries within
QSYS.

• SAV: Used if the data is stored somewhere else in the integrated file system.

• SAVDLO: Used if the data is in a folder.

Because the configuration file and data files are in the integrated file system, you
will back them up every time that you save the entire AS/400 system. You should
also back up the configuration files each time you change the administration of
AS/400 NetServer. You should plan the frequency of your save operations
carefully to ensure that you always have a usable backup available if your system
should fail.

The location of the AS/400 NetServer configuration and share data files on the
AS/400 system is: /QIBM/UserData/OS400/NetServer. The files that are needed are:

• Qazlscfg: Contains configuration information.

• Qazlsshr: Contains share information.

• Qazlsextxxx: Contains text conversion information for a file share, where xxxx
is a file share name. This file only exists if text conversion is used.

Both the AS/400 NetServer configuration files and the user data can be backed
up using the Entire System Save (option 21 on the SAVE menu). You can save
individual directories and subdirectories with the SAV command. For further
information on these commands and other useful save and restore options, refer
to OS/400 Backup and Recovery, SC41-5304.
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3.11 AS/400 NetServer administration using AS/400 APIs

The administration interface for AS/400 NetServer is provided through AS/400
Operations Navigator, which is part of Client Access. All administrative functions
available through AS/400 Operations Navigator are accessible through AS/400
APIs. You may use the AS/400 System API Reference, SC41-5801, as a guide
when implementing AS/400 administration through your CL, COBOL, RPG, C,
and C++ programs. The available APIs include:

• Add File Server Share (QZLSADFS)
• Add Print Server Share (QZLSADPS)
• Change File Server Share (QZLSCHFS)
• Change Print Server Share (QZLSCHPS)
• Change Server Guest (QZLSCHSG)
• Change Server Information (QZLSCHSI)
• Change Server Name (QZLSCHSN)
• End Server (QZLSENDS)
• End Server Session (QZLSENSS)
• List Server Information (QZLSLSTI)
• Open List of Server Information (QZLSOLST)
• Remove Server Share (QZLSRMS)
• Start Server (QZLSSTRS)

3.12 Exit programs

AS/400 NetServer uses the same host servers as Client Access for Windows
95/NT. Therefore, the same user exit points are used. In fact, there is no way that
the host server can tell the difference between a Client Access client and an
AS/400 NetServer client. If you are using an AS/400 application for security,
nothing needs to be changed if your clients use AS/400 NetServer instead of
Client Access for Windows 95/NT for network drives and printers.

See Appendix C, “Exit program” on page 145, for an example of an exit program
that may be useful for debugging.
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Chapter 4. AS/400 NetServer security

The use of AS/400 security ensures that unauthorized users do not have access
to AS/400 NetServer resources, configuration, or share data. Unlike file serving
from a Windows NT Server running on the Integrated Netfinity Server, you do not
need to be concerned with another security model. That is, everything that
applies to AS/400 user rights and permissions also applies to AS/400 NetServer.

4.1 AS/400 NetServer user profile authority requirements

You must have *IOSYSCFG special authority to change AS/400 NetServer
configuration properties. In addition, you must have *SECADM and *IOSYSCFG
special authorities to set the guest user profile for AS/400 NetServer.

4.1.1 Considerations for using the guest user profile
AS/400 NetServer supports guest user profiles (also known as an anonymous
user profile). The guest user profile may be used if a user needs access to an
AS/400 shared resource without a valid AS/400 user profile. The AS/400 system
can automatically assign an unknown AS/400 user to the guest user profile to
allow limited access to AS/400 NetServer shared resources.

If you want to use AS/400 NetServer print shares with a guest user profile, the
guest user profile on the AS/400 system cannot have a password of *NONE and
must be enabled. The Network Print Server on the AS/400 system requires the
user profile to have a password and be enabled. See Figure 30 for an example of
the Create User Profile (CRTUSRPRF) command. Here, it is being used to create
a guest user profile that can be used for AS/400 NetServer print shares.

Figure 30. Create User Profile

Create User Profile (CRTUSRPRF)

Type choices, press Enter.

User profile . . . . . . . . . . Guest Name
User password . . . . . . . . . gu3st Name, *USRPRF, *NONE
Set password to expired . . . . *NO *NO, *YES
Status . . . . . . . . . . . . . *ENABLED *ENABLED, *DISABLED
User class . . . . . . . . . . . *USER *USER, *SYSOPR, *PGMR...
Assistance level . . . . . . . . *SYSVAL *SYSVAL, *BASIC, *INTERMED...
Current library . . . . . . . . *CRTDFT Name, *CRTDFT
Initial program to call . . . . *NONE Name, *NONE
Library . . . . . . . . . . . Name, *LIBL, *CURLIB

Initial menu . . . . . . . . . . > *SIGNOFF Name, *SIGNOFF
Library . . . . . . . . . . . Name, *LIBL, *CURLIB

Limit capabilities . . . . . . . *NO *NO, *PARTIAL, *YES
Text 'description' . . . . . . . AS/400 NetServer Guest user profile

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Your network administrator can specify and change the guest user profile that
AS/400 NetServer uses, if necessary, on the AS/400 NetServer Advanced - Next
start page within Operations Navigator. In general, the guest user profile should
have few authorities because the guest user is considered a non-trusted user.

If you are creating this user through Operations Navigator, ensure that the user
has no special authority, as indicated in Figure 31.

Figure 31. Guest user authority

Otherwise, if you are using the guest user profile, we recommend that you specify
an initial menu parameter of *SIGNOFF. Consequently, the profile cannot be used to
actually sign on to the AS/400 system.

4.1.2 Understanding user names and passwords
AS/400 NetServer authenticates client file and print requests that are based on
the user ID and password that are used in the Windows desktop logon. If an
AS/400 user profile matches the Windows desktop client user profile, then the
passwords are checked. If the passwords do not match, AS/400 NetServer
prompts the client to enter the correct one. For a better understanding of AS/400
NetServer user profile authentication, refer to Table 2.

Table 2. AS/400 NetServer logon scenarios

AS/400 and
Windows user name

AS/400 and
Windows password

Guest user
enabled

Logon to AS/400
NetServer allowed

Same Same No Yes, as user

Same Different No Password prompt

Different Same or different No No1

Same Same Yes Yes, as user

Same Different Yes Password prompt2

Different Same or different Yes Yes, as guest
52 The AS/400 NetServer Advantage



To access AS/400 NetServer shared resources, clients may not need an AS/400
user profile that matches their Windows desktop user. AS/400 NetServer can
provide guest support for those clients that need only basic file and print services.
This support is not automatically enabled, but can be configured by following
these steps:

1. Right-click on the AS/400 NetServer icon, and select Properties.
2. Select the Advanced tab.
3. Click the Next Start button.
4. Specify the guest profile that you create in the guest user profile field.
5. Click OK.

4.1.2.1 User profiles become disabled
AS/400 NetServer uses AS/400 user profiles and passwords to allow network
administrators to control how users can access data. In addition, an AS/400
system value named QMAXSIGN specifies how many unauthorized sign-on
attempts disable the AS/400 NetServer or any other AS/400 user.

A user profile becomes disabled for AS/400 NetServer use when the user tries to
access AS/400 NetServer with an incorrect password more than the number of
times specified by QMAXSIGN. A user profile cannot become completely
disabled when connecting to an AS/400 system with AS/400 NetServer. If a user

1. The user is prompted for a password. Windows 95/98 asks for a password only, so
logon is not possible. Windows NT prompts for a user name and password. If the
information provided is correct, logon is possible.

2. Logon is only possible with the correct AS/400 password. Guest user access is not
used.

AS/400 and
Windows user name

AS/400 and
Windows password

Guest user
enabled

Logon to AS/400
NetServer allowed

On the AS/400 system, you can create an entirely numeric password by
specifying Q as the first character. If a user specifies Q12345 as the password
on the Change Password display, the user can specify either 12345 or Q12345
as the password on the Sign On display. This is because the AS/400 system
adds a Q in front of the password when it is all numeric.

When the Windows profile and password are used for AS/400 authentication,
as they are for AS/400 NetServer, Microsoft does not add a Q in front of the
numeric password to make it valid. Therefore, we recommend that you use an
AS/400 password that has an alphabetic character in the first position.
Subsequent characters may be alphanumeric.

Note

• The guest user profile that you specify will take effect the next time you
start AS/400 NetServer.

• If you want to change the profile that you specify to the currently
configured and active profile, click the Reset to Current button.

Note
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exceeds the maximum number of sign-on attempts, the user profile becomes
disabled only for AS/400 NetServer use. Other types of access, such as a system
signon, are not prevented. If a user profile becomes disabled, you can enable it
by changing the user profile, for example:

CHGUSRPRF USRPRF(ELWAY)

In addition, stopping and then restarting AS/400 NetServer also enables the user
profile.

AS/400 NetServer uses the "last-changed" date on AS/400 user profiles to
determine if they have changed since becoming disabled. If the "last-changed"
date is newer than the date of becoming disabled, then the user profile becomes
enabled for use with AS/400 NetServer, and authentication is verified once again.

4.1.2.2 Windows profile and password incompatibilities
The AS/400 user profiles and passwords are limited to 10 characters, but
Windows clients can have profiles and passwords that are greater than 10.
Therefore, when using AS/400 NetServer, you must consider these points:

• If you have a Windows user profile that is greater than 10 characters, the user
will adopt the guest user profile, if enabled.

• If your Windows password is greater than 10 characters, and you have a
known AS/400 user profile, the guest user profile is not adopted, and you are
prompted for a password. You must then enter a password valid for the
AS/400 user profile.

4.2 Hiding AS/400 NetServer

You can hide AS/400 NetServer from Windows Network Neighborhood to add an
additional measure of security. To hide AS/400 NetServer, follow these steps:

1. Open a connection to Operations Navigator on your AS/400 system.

2. Expand Network.

3. Expand Servers.

4. Click TCP/IP to display a list of TCP/IP servers available.

5. Right-click AS/400 NetServer, and select Properties.

6. Go to the Advanced page, and click Next Start. In the Browsing
announcement interval field, enter 0. If this interval is set to 0, the host stops
all announcements to the network.

4.2.1 Hiding shared resources
Both file and print shares can be hidden by adding a $ (dollar sign) to a share
name. For example, the file SECRET$ is not displayed when you view shares
from Windows Network Neighborhood using AS/400 NetServer.

Even though the share is hidden, you can connect to AS/400 NetServer and use
the hidden share if you know its name.
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Chapter 5. Troubleshooting AS/400 NetServer

The following sections help solve common AS/400 NetServer problems. For
example, you may experience various difficulties when trying to locate AS/400
NetServer on the AS/400 network or use AS/400 NetServer resources. These
difficulties may relate to the status of AS/400 NetServer on AS/400, the PC client
connections, or the user profile that you use to operate AS/400 NetServer.

5.1 Troubleshooting AS/400 NetServer user profile connections

When you are trying to access a file share, an error code may appear for any of
the following reasons:

• User profiles may not be authorized to a particular shared directory. If this
occurs, ensure that the user can access the directory by using Operations
Navigator. To do this, follow these steps:

1. Right click on the share.
2. Select Permissions.

• Users may be unable to use AS/400 NetServer if they attempt to connect to
the AS/400 system with an incorrect password too many times. If this occurs,
then the AS/400 system sends message CPIB682 to the QSYSOPR message
queue:

User profile FAVRE disabled for AS/400 Support for Windows Network
Neighborhood access.

This message indicates that the user profile has been disabled for AS/400
NetServer access. This does not disable the user profile for the AS/400
system or Client Access, but it stops the user profile from accessing AS/400
NetServer. To enable the user profile, update the change date on the user
profile to a time later than when AS/400 NetServer disabled the user profile.
The easiest way to do this is to use the Change User Profile (CHGUSRPRF) CL
command:

1. Enter the command:

CHGUSRPRF USRPFR(FAVRE)

2. Press Enter.

For more information on this, see 4.1.2.1, “User profiles become disabled” on
page 53.

• Clients will connect to the AS/400 system and AS/400 NetServer by using
their user profile and not the guest user profile, if they have a valid user
profile. There is one QZLSFILE job in the QSERVER subsystem for each
active client that connects to an AS/400 NetServer file share. A message in
the job log indicates to which user the QZLSFILE job belongs.

In addition, there is one QNPSERVS job in the QSYSWRK subsystem for
each active client that connects to an AS/400 NetServer print share. A
message in the job log indicates to which user the QNPSERVS job belongs.
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5.2 Troubleshooting the AS/400 NetServer location on the network

One of the most common problems associated with AS/400 NetServer users is
finding AS/400 NetServer on the network. Follow the troubleshooting guide to
help resolve this problem:

1. Verify that you have the correct server name for AS/400 NetServer. If the
AS/400 system was recently started, one method is to use the QSYSOPR
message queue. You can access this message queue by entering the DSPMSG

QSYSOPR command.

Messages are logged to QSYSOPR each time that AS/400 NetServer starts
and stops and when there are any specific errors to report. The following
message appears:

Job 043444/QPGMR/QZLSSERVER was ended by user QSECOFR.
All prestart jobs are ending for program QZLSFILE in QSYS.
AS/400 Support for Windows Network Neighborhood (NetServer)
AS/400NetServerName ended.
Subsystem QSERVER prestart job entry for program QZLSFILE in QSYS is no
longer active.
AS/400 Support for Windows Network Neighborhood (NetServer)
AS/400NetServerName
initialization complete.

From this message, you can see whether the AS/400 NetServer has started
properly and the AS/400 NetServer server name (AS/400NetServerName).

If AS/400 NetServer fails to start properly, the QSYSOPR message queue logs
an error that indicates a reason for the failure. If you receive a Reason Code
6, with return code 16 for message ID CPIB683, there is a duplicate name on
the network.

Otherwise, if AS/400 NetServer has been stopped and restarted, you can use
the DSPLOG MSGID(CPIB680) command to check the AS/400 NetServer name.
The following statement appears:

AS/400 Support for Windows Network Neighborhood (NetServer)
AS/400NetServerName initialization complete.

2. Verify that AS/400 NetServer is active. You can use the Work with TCP/IP
Status (NETSTAT *CNN) command to verify this. Verify that the following entries
appear in the NETSTAT output file. If you cannot find these entries, then you
must restart AS/400 NetServer.

** netbios>001:27:44 Listen
** netbios>000:00:01 *UDP
** netbios>000:00:00 *UDP
** netbios>000:30:57 Listen

For more information on verifying that AS/400 NetServer is active, see 5.3,
“File and print share problems” on page 60.

In V4R4, QNPSERVS jobs were moved to the QUSRWRK subsystem by
default, but can be configured to run elsewhere.

Note
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3. From your PC, perform a ping to the AS/400 NetServer server name. Pinging
the AS/400 NetServer server name verifies that your network server
name-to-IP address resolution strategy is working properly. If you cannot find
the AS/400 NetServer when using Windows NT, try entering a fully qualified
domain name in the Find: Computer window. For example, enter:

AS/400NetServerName.DOMAIN.COM

4. If this does not work, perform a ping to the AS/400 NetServer using the IP
address.

5. The NBTSTAT command is a Windows command line tool that gathers and
displays protocol statistics and current TCP/IP connections using NetBIOS
over TCP/IP. See the following practical examples:

• If you enter NBTSTAT -c, you can see the names that are currently in the
cache on the local PC.

• If you enter NBTSTAT -a AS/400NetServerName, you see the names that are
currently in the cache for a remote computer.

• If you enter NBTSTAT -R, the NBT cache reloads using the LMHOSTS file.

A complete list of parameters is shown in Table 3.

Table 3. NBTSTAT parameters

6. If these steps are not successful, there is a problem with the PC client ability
to resolve the AS/400 NetServer name to an IP address. Depending on your
environment, you may need to perform one of the following steps to solve this
problem:

• If you are using Domain Name Service (DNS), resolve the AS/400
NetServer name server name to its IP address by using DNS.

• If you are using Windows Internet Name Service (WINS), resolve the
AS/400 NetServer server name to its IP address using WINS.

NBTSTAT parameter Description

-a (adapter status) Lists the remote machine's name table given its name

-A (Adapter status) Lists the remote machine's name table given its IP address

-c (cache) Lists the remote name cache including the IP addresses

-n (names) Lists local NetBIOS names

-r (resolved) Lists names resolved by broadcast and via WINS

-R (Reload) Purges and reloads the remote cache name table

-S (Sessions) Lists the sessions table with the destination IP addresses

-s (sessions) Lists the sessions table converting destination IP addresses to
host names through the hosts file

RemoteName Remote host machine name

IP address Dotted decimal representation of the IP address

interval Re-displays selected statistics and pauses interval seconds
between each display; press Ctrl+C to stop re-displaying
statistics
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See 2.3, “Configuring your network clients” on page 18, for more
information about DNS and WINS.

• Resolve the AS/400 NetServer server name to its IP address by adding an
entry to the LMHOSTS file. Refer to 5.2.1, “Creating an LMHOSTS file” on
page 58, for more information on how to do this.

In a Windows NT environment, you can specify to use the LMHOSTS file for
name resolution by selecting the appropriate checkbox as shown in Figure 32.
In addition, if there is an existing LMHOSTS file that you want to use, click the
Import LMHOSTS button, and specify the file to use.

Figure 32. Enable LMHOSTS

5.2.1 Creating an LMHOSTS file
To create a LMHOSTS file, follow these steps:

1. Go to the directory that contains the LMHOSTS.SAM file. For Windows 95 and
Windows 98, it is Windows. For Windows NT, it may be
winnt\system32\drivers\etc.

2. Copy the LMHOSTS.SAM file.

Save it as LMHOSTS (with no file extension) in the same directory as it was
found. For example, in Windows 95, the LMHOSTS.SAM file is found in the
C:\Windows directory. You are presented with a window similar to the example
shown in Figure 33 on page 59.

During tests that we conducted, we also had success by adding an entry
to the PC HOSTS file to resolve the AS/400 NetServer name to its IP
address. This may not work on all client PCs.

Note
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Figure 33. Creating an LMHOSTS file

3. Select Yes.

4. Open the file in Notepad.

5. Add an entry like the following example:

10.5.5.99 AS/400NetServerName #PRE

AS/400NetServerName is the TCP/IP name of your AS/400 NetServer. If you
specify #PRE, the entry will be preloaded into the NBT cache when your PC is
started.

The sample file LMHOSTS.SAM contains information on how you can use an
LMHOSTS file in another location such as an AS/400 NetServer file share.

5.2.2 Early versions of Windows 95 and 3.11
If you are using a pre-Operating System Release 2 (OSR2) version of Windows
95 or Windows 3.11, the Universal Naming Convention (UNC) file name access
may fail until you explicitly map a network drive to an AS/400 NetServer share.
When the UNC access fails, you may also experience problems when finding
AS/400 NetServer. To solve this problem, you must specify that the LMHOSTS
entry be pre-loaded on your pre-OSR2 operating system. The LMHOSTS file
contains the mappings of IP addresses to computer names. Follow these steps to
resolve this error:

1. If you suspect that you may have this problem, you can determine the version
of your operating system by following these steps:

a. Right-click My Computer.

b. Select Properties.

The General properties dialog specifies which version you have installed. If
you do not see the following message on a Windows 95 system, you are
running a pre-OSR2 version of Windows 95:

System:
Microsoft Windows 95
4.00.950 B

Note: The character B can actually be B or higher (for example, C)

2. Find your LMHOSTS file:

Do not create an LMHOSTS file directly in Notepad because Notepad
sometimes adds the extension .txt.

LMHOSTS and Notepad
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a. Click Start-> Find-> Files or Folders

b. In the Named: field, enter: LMHOSTS*

c. If you have an existing LMHOSTS file, Windows should find two entries:
LMHOSTS and LMHOSTS.SAM.

d. Edit the LMHOSTS file and add the following entry:

10.5.5.99 AS/400NetServerName #PRE

AS/400NetServerName represents your AS/400 NetServer server name. If you
specify #PRE, the entry that you just added will be preloaded into the NBT
cache when your PC is started.

If Windows found only the LMHOSTS.SAM file, see 5.2.1, “Creating an
LMHOSTS file” on page 58.

5.3 File and print share problems

This section describes problems that you may run into with file or print shares and
how you can resolve them.

5.3.1 File shares
If you experience problems with AS/400 NetServer file share readiness on the
AS/400 system, you should check the status of AS/400 NetServer on the AS/400
system. In addition, you can also use this troubleshooting guide if you have
problems starting AS/400 NetServer. To do so, follow these steps:

1. Verify that TCP/IP is started.

2. Verify that the AS/400 system has started the QSERVER subsystem. If the
AS/400 system has not already started the QSERVER subsystem, start it by
using the STRSBS QSERVER command.

3. Use the Work with Active Job (WRKACTJOB) command to verify that the
AS/400 system has started the QZLSSERVER job within QSERVER.
Alternatively, you can use Operations Navigator to verify that QZLSSERVER
is active:

a. Open a connection to your AS/400 using Operations Navigator.

b. Expand Network.

c. Expand Servers.

d. Select TCP/IP.

e. Right-click on AS/400 NetServer, and select Open.

f. Right-click on AS/400 NetServer, and select Server Jobs. The window
shown in Figure 34 on page 61 appears.

If you had to start TCP/IP started in step 1, then restart AS/400 NetServer
even if it is already active.

Note
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Figure 34. Displaying server jobs

g. Find QZLSSERVER, and ensure that it is active.

If it is not started, you must restart AS/400 NetServer.

4. Verify that the QZLSFILE prestarted job is waiting for a program start request
(PSRW status on the Work with Active Jobs screen). If the QZLSFILE
prestarted job is not waiting for a program start request, then use the Start
Prestart Jobs (STRPJ) CL command. Enter the following command:

STRPJ SBS(QSERVER) PGM(QZLSFILE)

This starts the prestarted job.

5. Add the QZLSFILE prestarted job entry to the QSERVER subsystem
description if it is not already present. You can use the Add Prestarted Job
Entry (ADDPJE) CL command to add the prestarted job entry. Enter the following
command:

ADDPJE SBSD(QSERVER) PGM(QZLSFILE)

5.3.2 Print shares
You may experience trouble when using an AS/400 NetServer network printer for
any of the following reasons:

AS/400 NetServer should automatically start a QZLSFILE job on the AS/400
system when a PC client accesses a file share for the first time. Each
QZLSFILE job supports one session and all of the file shares that are
accessed by that session when using AS/400 NetServer.

Note
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• The network printer may not work because the user does not have
authorization to the AS/400 output queue. If this occurs, you should ensure
that the user has access to the object by using OS/400 CL commands, such
as the Edit Object Authority (EDTOBJAUT) command.

• The Network Print Server is not up and running. If you do not start it, then
AS/400 NetServer print shares will not function properly. To start the Network
Print Server, enter the following command:

STRHOSTSVR SERVER(*NETPRT)

• All users who will use the service are not enabled or do not have a password.
Network Print Server requires them to be enabled and have a password.

• Clients connect to the AS/400 system and AS/400 NetServer by using their
user profile and not the guest user profile, if they have a valid user profile.
There is one QNPSERVS job entry in the QSYSWRK subsystem for each
active session connected to AS/400 NetServer. The QNPSERVS job starts
when a session is connected to a shared print resource.

In V4R4, QNPSERVS jobs are configured by default to be in the QUSRWRK
subsystem.

• A maximum of 350 spooled files are displayed in a network printer window
when accessing OS/400 V4R4 or later.

• The TCP/IP LOOPBACK interface for IP address 127.0.0.1 is not started. This
interface must be started so that AS/400 NetServer can communicate with the
Network Print Server. Use option 1 of the Configure TCP/IP (CFGTCP) menu
interface (Work with TCP/IP Interfaces) to verify that this interface is active,
and start the interface if necessary.

5.3.3 Guest user print problems
If you are using AS/400 NetServer guest user support, there may be problems
when trying to access AS/400 output queues, or the specified printer may go
offline. Typically, this is because the guest user profile that you specify must have
a password and must be enabled. The Network Print Server must have a
password for its authentication. However, in the case of the guest user profile, it
will not prompt the user for one. Ensure that the guest user profile also has an
initial menu parameter set to *SIGNOFF to deny signon access. Use the Change
User Profile (CHGUSRPRF) comamnd to set the parameter INLMNU to the value
*SIGNOFF.

5.4 AS/400 NetServer properties causes an illegal operation error

An illegal operation performed error may be encountered from cwbunzls.dll when
you select the properties menu item in AS/400 NetServer. The problem occurs if
the comct132.dll file on your PC is out of date. If you are running Windows NT, the
file is located in \WINNT\system32. If you are running Windows 95, the file is
located in \Windows\system. If the date on the file is 07/11/95, or earlier, you must
obtain an update from Microsoft. Download com32upd.exe from
ftp://ftp.microsoft.com/softlib/mslfiles/
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5.5 File name case sensitivity

All AS/400 file systems, except for three, are case insensitive and do not cause
case sensitivity conflicts with supported PC clients. However, the following three
AS/400 file systems are case sensitive:

• QOpenSys

• User-Defined File System (UDFS): If specified, it is case-sensitive when
created.

• Network File System (NFS): It depends on which remote file system you
access.

The case of file names is significant in case-sensitive file systems. The names
can consist of both upper-case and lower-case characters. For example, the
QOpenSys file system could have three files in it with the following names:

• NETSERVE.DAT
• NetServe.DAT
• netserve.DAT

These three files have technically different names (because QOpenSys is case
sensitive) and represent three distinct, separate objects on the AS/400 system.

All the PC clients that AS/400 NetServer supports (Windows 3.11, Windows 95,
Windows 98, and Windows NT) are case insensitive. The case of file names is
insignificant because all file names are translated automatically into upper case.
For example, from the three example files that are listed above, all the PC clients
AS/400 NetServer supports would recognize only the NETSERVE.DAT file.

Therefore, AS/400 NetServer may not work correctly when using files in
case-sensitive file systems. This is particularly true when working with
case-sensitive file systems while you are using a graphical user interface such as
the Windows 95 Explorer or the Windows 3.11 File Manager.

All other AS/400 file systems are case insensitive and do not cause
case-sensitivity conflicts with supported PC clients.

5.6 File name length considerations

If you are using old utilities that only support short names (8.3 syntax), you may
experience strange behavior when you attempt to use those utilities against
AS/400 NetServer shares.

The AS/400 system supports only long names. Windows 32-bit systems support
up to two names per object: the real name (long name) and if the real name does
not meet the 8.3 syntax, a short name. The short name is typically made up of the
first six characters of the name, a tilde ~, and a number, followed by an extension
truncated to three characters. If an object already exists with that name, the
system increments the number until a free name is found. Fewer characters of
the original name are used if the number of collisions is greater than nine. Short
names are not supported by any system other than Windows. Other systems
have been long name enabled from the start and do not have legacy DOS
applications that cannot handle longer names. Short names and long names may
collide.
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When you move a file from one Windows machine or directory to another, the
shortname may change since the number of collisions that occurr may be
different. When you move the file to a non-Windows directory, no collisions occur
since no short names are created. Some file serving solutions make up for this
when they are asked for a short name by simply truncating the names to fit the
8.3 format, but without worrying about the name being unique.

The long file name problem occurs for 16-bit applications: DOS windows, Install
Shield, etc. It can occur for any component in the path. For example, the third
nested directory may actually cause trouble in
\dir1\dir2\longdirectoryname3\dir4\filename. Most 32-bit applications use the long
file name only.

Consider these two recommendations for the customer to work around this
incompatibility:

• Use a modern application that uses long names. Forget that shortnames ever
existed since they are problem prone and inconsistent.

• Create additional links to the file that meet the 8.3 convention and are unique.

5.7 Unreadable text when printing

When using the AFP print drivers downloaded from the IBM Printing Systems
Company Web site, http://www.printers.ibm.com/, you may experience
unreadable printed text. This most likely occurs because font substitution is done
by using information directly embedded into the print stream of the print job.

Because of this, one of the following two actions must be done when using this
driver:

• Turn off Font Substitution from the properties of the printer on the PC.

• Install License Program AFP Fonts 5769FN1 or AFP DBCS Fonts 5769FNT
(depending on whether you are using DBCS) on the AS/400 system.

The QCA400 NetServer shared directory makes available stand-alone print
drivers for Advanced Function Printing (AFP) and SNA Character String (SCS).
These printer drivers can be found under the directory appropriate for your client
type. You can also use the AFP and SCS printer drivers from Client Access
Express for Windows.

5.8 Incorrect disk space shown for a file share

When attempting to ascertain the disk space left on an AS/400 NetServer file
share, the result may be misleading.

When using Windows for Workgroups or Windows 95/98, the maximum disk
space shown does not exceed 2,147,483 KB. This is a limitation of the Windows
operating system (4-byte arithmetic limit).

For Windows NT users, the disk space shown is correct since Windows NT does
not have this limitation (8-byte arithmetic).
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Part 2. Migrating to AS/400 NetServer

The following two chapters cover the migration to AS/400 NetServer from Warp
Server and Novell NetWare. An example scenario also follows at the end of each
chapter.

Why migration to AS/400 NetServer should be considered

IBM announced with V4R3 and V4R4 that the following licensed programs would
not be available in future releases of OS/400 after V4R4M0:

• 5769SA3 IBM OS/400 Integration for Novell NetWare (V4R2M0)
• 5769XZ1 OS/2 Warp Server for AS/400 (V4R1M0)

While 5769SA2 IBM Integration Services for FSIOP, will be supported in the next
OS/400 release, support for 5769SA2 will have a early end of currency.
Therefore, it is better to not continue using 5769SA2 to support an AS/400
system LAN Adapter configuration once 5769XZ1 and 5769SA3 are no longer
used. See Informational APAR II11689 for options for migrating from using the
Integrated Netfinity Server LAN adapter as the AS/400 system LAN adapter.
Informational APARS can be found at http://as400service.ibm.com under Tech
Info and Databases.)

For customers currently using either of the above products, some consideration
should be given to the file and print sharing strategy that may need to be adopted
in the near future. There are, of course, a number of options to be reviewed.
These are referred to in Informational APAR II11689.

Note: This redbook deals only with migration from the two products listed above
to AS/400 NetServer.

There may also be some customers who are interested in what AS/400 NetServer
has to offer compared with their current business configurations.

Benefits of migrating to AS/400 NetServer

There are a number of potential benefits that become apparent when considering
migration from the Integrated Netfinity Server-based products OS/2 Warp Server
for AS/400 or Novell NetWare to AS/400 NetServer. These benefits include:

• The licensing requirements are reduced. There is no need for additional Warp
Server or Novell NetWare licenses.

• Since AS/400 NetServer is part of the AS/400 Operating System, there are no
additional licensed programs required. This reduces the DASD requirement on
the AS/400 system.

For customers upgrading to future releases beyond V4R4 without migrating
first, user data contained in the Network Server storage spaces is no longer
accessible using the *LANSERVER or *NETWARE Network Server
Descriptions.

Important
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• Potentially simpler to administer because all configuring can be done with the
AS/400 system.

• All backup and restore functions are dealt with by the AS/400 system. There is
no need for additional products or skills.

• No additional client applications are required. The client requirements come
with the client operating systems. Consequently, this reduces the PC hard disk
drive usage.

• Eliminates the potential cost of administering multiple servers and platforms.

• Uses AS/400 user profiles and security.

• Potentially reduces the need for additional AS/400-based hardware since an
Integrated Netfinity Server is not required.
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Chapter 6. Migration from Warp Server

This chapter covers the steps and considerations that are necessary to migrate
from OS/2 Warp Server for AS/400 to AS/400 NetServer.

6.1 Migration from Warp Server to AS/400 NetServer

The topics to consider when migrating are divided into six categories:

• File migration: Migration of files and directories from the Warp Server on the
Integrated Netfinity Server, and any additional Warp Servers to the AS/400
integrated file system and administration of the security of the file server.

• Printer migration: Considerations when migrating printers from the Warp
Server environment to the AS/400 NetServer environment.

• Client migration: Removal of the DOS LAN Services client and
re-configuration of file and printer shares.

• User migration: Moving user IDs from Warp Server to AS/400 NetServer.

• Cleaning up the AS/400 system: What consideration to give to the objects
that can be removed on the AS/400 system once the previous tasks are
completed.

• Backup considerations: The changes that need to be made in backing up
the migrated data.

Section 6.2, “Example scenario: Warp Server to AS/400 NetServer” on page 83,
shows an example of the steps taken when migrating from Warp Server to
AS/400 NetServer.

6.1.1 File migration

The object of the file migration exercise is to transfer all user files and directories
(typically those stored in the Network Server Storage Spaces) from the Warp
Server to the AS/400 integrated file system. There are two possible ways to
perform this transfer:

Prior to V4R4, if you are using multiple Warp Servers to serve clients using
different languages, it is not possible to consolidate all of the user data onto
one AS/400 NetServer setup. This is because AS/400 NetServer cannot handle
clients with different code pages. At V4R4 and above, this restriction no longer
applies.

Note

We advise that you make a backup copy of the Warp Server data before any
migration is attempted. In the event of an error, the data can be restored back,
and therefore, will not be totally lost.

Note
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• Use AS/400 commands.

• Use a PC that has both DOS LAN Services for Warp Server and a connection
to an AS/400 NetServer file share.

The basis of the first transfer solution relies on a directory link that is found within
the AS/400 integrated file system called QLANSRv. The QLANSRv file system
provides access to the directories and files on the Warp Servers in your domain.
It is required that you have the Warp Server licensed program installed on the
AS/400 system and a Primary Domain Controller or Backup Domain Controller on
the Integrated Netfinity Server. The Integrated Netfinity Server must also be
varied on and in ACTIVE status when viewed using the Work with Network Server
Status (WRKNWSSTS) command. For additional information on the QLANSRv
file system, refer to OS/2 Warp Server for AS/400 Administration, SC41-5423.

The second method involves using Network Neighborhood or File Manager to
copy and paste from the Warp Server drives to the AS/400 NetServer shares.

To create the new directories in the AS/400 integrated file system to which the
Warp Server data will be transferred, you can use the Create Directory (CRTDIR)
or Make Directory (MKDIR) commands. To create a directory called USERDATA,
see Figure 35.

Figure 35. CRTDIR command

The newly created directory will be owned by the user profile who created it. This
profile will have all rights to it.

It is possible to define the authorities for *PUBLIC as well. Both data and object
authorities for *PUBLIC can be defined within the CRTDIR or MKDIR command.
As a general guide, we recommend that the data and object authorities for
*PUBLIC are set to *EXCLUDE and *NONE respectively. If *INDIR is selected,
the *PUBLIC rights from the directory above will be assumed (in this case, /root).

Create Directory (CRTDIR)

Type choices, press Enter.

Directory . . . . . . . . . . . /USERDATA___________________________________
______
Public authority for data . . . *EXCLUDE Name, *INDIR, *RWX, *RW...
Public authority for object . . *NONE *INDIR, *NONE, *ALL...

+ for more values
Auditing value for objects . . . *SYSVAL *SYSVAL, *NONE, *USRPRF...

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Once the necessary directories are created within the AS/400 integrated file
system, you can begin copying the Warp Server files from Network Server
Storage Spaces to the AS/400 integrated file system.

6.1.1.1 File migration using QLANSRv
This section describes the considerations for migrating files from the Warp Server
domain to the AS/400 integrated file system using the QLANSRv directory
structure. It is possible to use either of the following two AS/400 commands to
place the Warp Server files into the new directories within the AS/400 integrated
file system:

• MOV
• CPY

Both of these commands may give slightly different results in addition to the fact
that the CPY command only produces a replica of the file. There are authority and
attribute considerations of which you need to be aware. They are covered later in
this chapter.

You must ensure that the user profile you use to migrate the data to the AS/400
integrated file system also has an appropriate high level of authority. If possible,
you should use a profile with *ALLOBJ authority.

The MOV command is generally recommended because it preserves the
ownership of objects. If the CPY command is used, the user who copies the
objects becomes their owner (if the file system supports this).

It must also be noted that when using either of these commands, some attributes,
extended attributes, and authorities may be discarded. Therefore, it is important
that you review these considerations thoroughly before file migration. For
additional information, refer to the Integrated File System book, which is on the
Web at: http://www.as400.ibm.com/infocenter

The MOV and CPY commands are fairly similar in appearance and can be used
on single or multiple files.

In Figure 36 on page 70, the CPY command is being used for a single file
(test.fm) within the userdata/sales directory on the Warp Server K: drive. The
target directory for this file copy is the userdata directory. Notice that the access
to this file is through QLANSRv. KDRIVE is an already existing alias that was set
up to allow Warp Server users to have access to the K: drive.

Because the Warp Server data is migrated across into other areas of the
AS/400 integrated file system, it is worth noting that some parts of the AS/400
integrated file system have different constraints. Some areas of the integrated
file system, for example, are case sensitive.

For further information on AS/400 integrated file system constraints, refer to
the Integrated File System book on the Web at:
http://www.as400.ibm.com/infocenter

Note
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Figure 36. CPY Object command for a single file

To copy a single file from Warp Server to another area within the AS/400
integrated file system, follow these steps:

1. Type WRKLNK on an empty command line, and press Enter.

2. Locate the QLANSRv link, and type 5 next to it. Press Enter to go to the next
level. Keep using option 5 to progress down through your aliases until you
locate your chosen file.

3. Type option 3 next to the file you wish to copy, and press F4 to prompt. We see
the same basic screen as shown in Figure 36.

4. Add the name of the destination directory in the To directory line. In this
example, we used the userdata directory that was created earlier by using the
CRTDIR or MKDIR command. Press Enter. The file is then copied to the new
directory.

5. Once you are satisfied that the copy has succeeded and if you have no further
use for it, you may delete the original by typing option 4 next to it. If preferred,
file deletion can be done after all necessary files are migrated. To do so,
remove the Network Server Storage Space where the files reside (see 6.1.5,
“Cleaning up the AS/400 system” on page 82).

Multiple file copy can also be achieved to save time. Refer to Figure 37 on page
71 to see how this can be done.

Copy Object (CPY)

Type choices, press Enter.

Object . . . . . . . . . . . . . > '/QLANSrv/KDRIVE/userdata/sales/test.fm'

To directory . . . . . . . . . . '/userdata’

To object . . . . . . . . . . .

Symbolic link . . . . . . . . . *NO *NO, *YES
From Code Page . . . . . . . . . *OBJ 1-32767, *OBJ, *PCASCII
To Code Page . . . . . . . . . . *OBJ 1-32767, *OBJ, *CALC...
Data Format . . . . . . . . . . *BINARY *BINARY, *TEXT

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Figure 37. CPY command method for multiple files

Enter option 3 next to all of the files in one directory on the Warp Server and
specify the parameter todir(‘/userdata’) on the command line. By doing so, all of
the files with option 3 next to them are copied to the userdata directory when you
press Enter.

As mentioned earlier, the MOV command is generally recommended. However,
since the MOV and CPY commands are similar in use, the same techniques can
be applied.

Figure 38. MOV command for a single object

Work with Object Links

Directory . . . . : /QLANSrv/KDRIVE/userdata/sales

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
3 test.fm DSTMF
3 useful.txt DSTMF
3 vpb32r10.exe DSTMF
3 AV32.exe DSTMF
3 CSOCK.EXE DSTMF
3 IBMNTNO.NUK DSTMF
3 IBM95.nuk DSTMF

Bottom
Parameters or command
===> todir('/userdata')
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F12=Cancel F17=Position to
F22=Display entire field F23=More options

Move Object (MOV)

Type choices, press Enter.

Object . . . . . . . . . . . . . > '/QLANSrv/KDRIVE/userdata/sales/test.fm'

To directory . . . . . . . . . . > '/userdata'

To object . . . . . . . . . . .

From Code Page . . . . . . . . . *OBJ 1-32767, *OBJ, *PCASCII
To Code Page . . . . . . . . . . *OBJ 1-32767, *OBJ, *CALC...
Data Format . . . . . . . . . . *BINARY *BINARY, *TEXT

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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A comparison of Figure 38 and Figure 36 on page 70 clearly shows that the two
commands are similar. This is also true for multiple object moving. To move a file,
use option 2, not option 3 (Figure 39).

Figure 39. MOV command for multiple objects

Using either of these methods, all of the files you need to migrate can be
transferred to the other areas in the AS/400 integrated file system. These
directories will eventually be made into shares for the AS/400 NetServer users.

6.1.1.2 File migration using a client
There are two reasons why you may decide to use this method of file migration
rather than the QLANSRv method:

• The Warp Server on the Integrated Netfinity Server is a *SERVER. The Warp
Server on the Integrated Netfinity Server must be a Primary or Backup
Domain Controller to use QLANSRv.

• Using the AS/400 integrated file system to migrate files can be a
time-consuming exercise since only file objects can be migrated, not
directories. For customers who have many sub-directories, there is also an
increased risk that some files may be overlooked in error.

This method of data migration requires a PC client that has a connection to the
Warp Server share and an AS/400 NetServer file share to the empty destination
directory. Then, using either File Manager, Network Neighborhood, or even a
DOS command line, files can be copied from one drive to another. This method
can ultimately prove to be the fastest since entire directory structures can be
transferred at a single time. If you have not already set up your AS/400 NetServer
shares, refer to Chapter 2, “Getting started with AS/400 NetServer” on page 11,
and Chapter 3, “Using AS/400 NetServer” on page 25, for information on setting
up AS/400 NetServer and defining file shares. You must also ensure that the user
profiles you are using have adequate authority to copy or move objects from one
directory to another. A profile with *ALLOBJ authority is advisable for AS/400

Work with Object Links

Directory . . . . : /QLANSrv/KDRIVE/userdata/sales

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
2 test.fm DSTMF
2 useful.txt DSTMF
2 vpb32r10.exe DSTMF
2 AV32.exe DSTMF
2 CSOCK.EXE DSTMF
2 IBMNTNO.NUK DSTMF
2 IBM95.nuk DSTMF

Bottom
Parameters or command
===> todir('/userdata')
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F12=Cancel F17=Position to
F22=Display entire field F23=More options
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NetServer and similarly a Warp Server administrator profile for Warp Server
access.

As a general guide, it may be easier to use the same user profile. For many
customers, a profile from the AS/400 system that has *ALLOBJ authority is
propagated down to the Warp Server and this becomes the administrator.
Therefore, this profile can be used for AS/400 NetServer. When the PC is started,
make sure that this profile and password are used to log onto the Windows
Network. When starting DOS LAN Services, use the profile and password there
as well.

Figure 40 shows the window that is seen when using Windows Explorer in
Windows 95. The F: drive is the Warp Server KDRIVE alias, which points to the
Network Server Storage Space linked as the K: drive on the Network Server
Description. The G: drive is the AS/400 NetServer file share to the directory
called /userdata in the AS/400 integrated file system.

Figure 40. Warp Server and AS/400 NetServer shares on one PC (Windows 95)

Perform the following steps to migrate the files from Network Server Storage
Spaces to the AS/400 integrated file system:

1. Start DOS LAN Services and map a drive to the Warp Server alias that has the
files to be migrated. In the example shown in Figure 40, the F: drive is used.

2. Select Start-> Programs-> Windows Explorer.

3. When Windows Explorer has started, go to Tools-> Map Network Drive.

4. In the Path, enter the name of the share you want to map the drive to. In the
example in Figure 40 on page 73, the AS/400 NetServer is called “Qas01”,
and the file share is called “userdata”. The following path is entered:
\\Qas01\userdata to achieve a mapped network drive to this directory on the
AS/400 system.

5. Select all of the directories within the userdata directory on the Warp Server
share (F: drive).

6. Right-click and select Copy. Then, right-click, and select Paste on the
destination directory (G: drive). Entire directories and files can be copied in
one step.
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6.1.1.3 Authority considerations
Give special attention to the authorities of the files and directories migrated from
Warp Server to AS/400 NetServer. If this part of the migration is neglected, then
there may be potential security issues. Users may be prevented from accessing
their own data, and unauthorized users may have access to data that is not
intended for public viewing.

The resulting authorities on any files or directories that have been migrated from
Warp Server to AS/400 NetServer are likely to be different from what was
originally set up. The AS/400 NetServer does not use aliases like Warp Server
does. You need to spend some time revising security issues on the individual
directory shares.

Because of the size of many customers data directories, you may want to migrate
over a period of time, rather than all at once. We observed that when moving data
around the AS/400 integrated file system, certain authorities are removed and
new ones are placed. This requires some attention by the administration.

The following two sections briefly show the changes in authority that we
experienced when migrating data from Warp Server to AS/400 NetServer. The
key to successful data migration is to consider creating many directories in
AS/400 NetServer rather than having many subdirectories. The authorities can be
set in the initial first-level directory. Files or directories migrated into it will take on
those authorities. The results in the following two sections represent our findings
when migrating data in lab conditions.

Authority considerations when using QLANSRv methods
There are distinct differences between resulting authorities on files that are
migrated to other areas of the AS/400 integrated file system depending on
whether the MOV or CPY command is used. Use the Work with Authority (WRKAUT)
command to examine and modify object authorities.

As shown in Figure 41 on page 75, the two profiles ITSCID13 and ARTHURM are
listed as having all data and object authorities for the destination directory within
the AS/400 integrated file system (userdata), while *PUBLIC is *EXCLUDE.
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Figure 41. Work with Authority (WRKAUT) display

Figure 42 shows the authorities assigned to the file ACCOUNTS.TXT in the
userdata/accounting directory on the Warp Server. If a CPY command is used to
copy this file to the userdata directory elsewhere in the AS/400 integrated file
system, some changes occur.

Figure 42. WRKAUT for the ACCOUNTS.TXT file

The resulting copied file, which is shown in Figure 43 on page 76, retains its
previous data and object authority settings for any profiles already specified.

Work with Authority

Object . . . . . . . . . . . . : /userdata
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ARTHURM *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys

Work with Authority

Object . . . . . . . . . . . . : /QLANSrv/KDRIVE/userdata/accounting/acco >
Owner . . . . . . . . . . . . : QDFTOWN
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data -------------Data Authorities-------------
Opt User Authority Objopr Read Add Update Delete Execute

ITSCID13 USER DEF X X X X X
ACCOUNTS *R X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display object authorities F12=Cancel F24=More keys
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Figure 43. WRKAUT for a copied file using the CPY command

However, there are two differences:

• Ownership of the file has now changed to the profile that copied it.
• *PUBLIC *RWX data authority to this file has been added.

When moving the file using the MOV command, a slightly different result is
achieved.

In Figure 44 on page 77, the object ownership has remained the same this time
and that the same authority of ITSCID13 (the profile used to perform the MOV
command) has been given to QDFTOWN. *PUBLIC *RWX data authority has
been granted for this file, and the other data and object authority information has
been retained.

Work with Authority

Object . . . . . . . . . . . . : /userdata/accounts.txt
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data -------------Data Authorities-------------
Opt User Authority Objopr Read Add Update Delete Execute

*PUBLIC *RWX X X X X X X
ITSCID13 USER DEF X X X X X
ACCOUNTS *R X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display object authorities F12=Cancel F24=More keys
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Figure 44. WRKAUT on a file moved using the MOV command

Authority considerations when using a client to migrate data
As mentioned earlier, it is possible that this may be the faster of the two methods.
However, by using the copy and paste method from DOS, Windows for
Workgroups (Windows 3.11), or Windows 95, 98, or NT, the authorities on the
files and directories are lost. For this reason, it is important that when the AS/400
NetServer directory is created, it has the correct authorities on it. This way, any
files or directories that are migrated assume the correct security from the
directory into which they are copied.

Figure 45 on page 78 shows the userdata directory that was created earlier.
Notice that the *PUBLIC has been excluded. The owner is the profile that created
it, and therefore, has all authority to it. The ACCOUNTS user profile has been
added manually to the userdata directory and given *RWX and all object rights.

Work with Authority

Object . . . . . . . . . . . . : /userdata/accounts.txt
Owner . . . . . . . . . . . . : QDFTOWN
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data -------------Data Authorities-------------
Opt User Authority Objopr Read Add Update Delete Execute

*PUBLIC *RWX X X X X X X
QDFTOWN USER DEF X X X X X
ACCOUNTS *R X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display object authorities F12=Cancel F24=More keys
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Figure 45. Work with Authority

Figure 46 shows the list of authorized users for the sales directory. The
ACCOUNTS profile has *RW and ACC2 has only *R. Notice also that QDFTOWN
is the owner of the directory.

Figure 46. WRKAUT for Warp Server directory

These authorities change when migrated using the copy and paste method from a
client PC to the userdata directory, which is to be used for AS/400 NetServer.

Work with Authority

Object . . . . . . . . . . . . : /userdata
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ACCOUNTS *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys

Work with Authority

Object . . . . . . . . . . . . : /QLANSrv/KDRIVE/userdata/sales
Owner . . . . . . . . . . . . : QDFTOWN
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

ITSCID13 *RWX X X
ACCOUNTS *RW
ACC2 *R

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
78 The AS/400 NetServer Advantage



Figure 47 shows the resulting authorities on the sales directory after being
migrated from the Warp Server KDRIVE to the directory (userdata) within the
AS/400 integrated file system. Notice how the authorities that were present as
shown in Figure 46 on page 78, have been altered. The new authorities for this
directory (and the files contained within it) have adopted the /userdata authorities
(see Figure 45 on page 78).

Figure 47. WRKAUT after migration from Warp Server to AS/400 NetServer

With this in mind, it is clear that if the authorities are set correctly at the first level
directory, then all other authorities will fall into place when the data is migrated
across from Warp Server. This is why customers may find it easier to create a
directory for every user, rather than set up authorities for many sub-directories.

6.1.2 Printer migration
This section explains considerations for migrating printers from Warp Server to
AS/400 NetServer.

6.1.2.1 Overview
Warp Server supports LAN-to-LAN printing. That is, it supports a PC on a LAN
printing to a printer, which is also on the LAN. It is not designed to support
printers attached to other PCs, nor AS/400-attached printers. The PC sends the
printer output to the Warp Server, which in turn, communicates with the network
printer using either IEEE802.2 or TCP/IP.

AS/400 NetServer supports both LAN-to-LAN and LAN-to-HOST printing
techniques. This means that printers on the LAN and printers attached to other
PCs or AS/400 systems can be accessed.

The printers that are configured for use with the Warp Server domain are not
visible to the AS/400 system since the print serving is done by Warp Server. For
the AS/400 NetServer to use these printers, you need to make the printers visible

Work with Authority

Object . . . . . . . . . . . . : /userdata/sales
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ACCOUNTS *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
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to the AS/400. This is done by using the Create Output Queue (CRTOUTQ)
command, which sets up an output queue to the printer. Once this is done, it can
be shared for the AS/400 NetServer users.

Network printers
Network printers that were used for Warp Server printing must be configured for
TCP/IP. Details of how to do this are provided in the supporting printer and LAN
card documentation.

Depending on the printer make and model or how it is attached to the LAN, it may
be possible to set up either LPR/LPD from the AS/400 system to the printer using
a remote output queue (RMTOUTQ) or if the printer is PCL/PJL compatible, a
LAN Device Description can be used. For details on how to set up these
connections, refer to AS/400 Printing V, SG24-2160.

Host printers
As mentioned earlier, AS/400 NetServer can also support LAN-to-HOST printing.
This involves printers that are connected to other PCs or AS/400 systems and
are, therefore, not connected directly to the LAN. It is possible to use printer
emulation, where printers connected to PC LPT ports can be accessed from the
AS/400 system. IBM Client Access is one product with which this can be
achieved. It is also possible to use LPR/LPD from the AS/400 system to the host
with the attached printer.

6.1.2.2 Authority considerations
Authority to allow users access to AS/400 output queues is required. It is
important to review the necessary authorities to prevent unauthorized functions
on the spooled files in the output queues.

After migration, there may be a requirement to restrict certain users from using
some printers. The authority considerations are covered in 3.3.1, “Authority
considerations” on page 35. The security of spooled files and output queues is
covered in OS/400 Security, SC41-5302.

6.1.2.3 Client installation
For details on how to set up the printers on the client, refer to 3.3, “AS/400
NetServer print shares” on page 34.

6.1.3 Client migration
To use AS/400 NetServer, the PC requires no special applications. This is
different from Warp Server where your clients may have software such as DOS
LAN Services. The functionality to use AS/400 NetServer is available with the
supported Windows operating systems and requires only minimal additions to the
current setups (if any).

When migrating clients, the client PCs will effectively fall into one of the two
following categories:

• Operating systems supported with AS/400 NetServer. These include:

– Windows for Workgroups (Windows 3.11)
– Windows 95/98/NT/2000/Terminal Server Edition
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• Operating systems not supported with AS/400 NetServer. These include:

– OS/2
– DOS
– Windows 3.1

The clients that are not supported for use with AS/400 NetServer also have to be
migrated to a supported operating system.

The clients that are supported ideally should have the DOS LAN Services or OS/2
LAN Requestor client removed from the PC since this application is no longer
required. The removal of this application will depend upon the operating system
on which it is installed.

Once the DOS LAN Services or OS/2 LAN Requestor application has been
removed and the PC has been configured with one of the above listed supported
operating systems, the task of redefining the network drives and printers to point
toward the new locations can begin. This involves setting up mapped drives and
network printers provided by AS/400 NetServer. Setting up file and printer shares
is explained in Chapter 3, “Using AS/400 NetServer” on page 25.

It is worth noting that since the new network drives and printers will reference the
new AS/400 NetServer shares (a new drive on a different server), it is easy to
revert back to the old drive mappings. If the DOS LAN Services or OS/2 LAN
Requestor client is not removed, then the mapped drives on Warp Server can be
redefined again by pointing to the old Warp Server aliases. This provides the
customer with an option to revert back to Warp Server if necessary.

6.1.4 User migration
The Warp Server solution allows users to be enrolled into the domain in two
ways:

• Create an AS/400 user profile using the Create User Profile (CRTUSRPRF)
command. Then, allow the profile to be propagated down to Warp Server.

• Create Warp Server users within Warp Server without creating an AS/400
user.

There are advantages and disadvantages of these two methods which are not
discussed here. However, it is highly likely that most business setups have a
mixture of both AS/400 users and Warp Server only users.

All AS/400 NetServer users must be set up as AS/400 users, unless they are to
assume the optionally configured guest user profile. The configuration of the
guest user profile is covered in detail in 2.4, “Configuring the guest user profile”
on page 20.

Warp Server users who are already AS/400 users should now log on to the
Windows Network with their AS/400 user profile and password.

Users who have no AS/400 profile and password can log on to the Windows
Network as any user and, if configured, they assume the guest profile on AS/400
NetServer. Should they need access to further shares, we recommend that you
create AS/400 profiles and make sure that the users log on to the Windows
Network with these profiles and their associated passwords.
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6.1.5 Cleaning up the AS/400 system
Once you have completed the migration process up to this point, you need to
assess what redundant objects on the AS/400 system can be removed. The
objects that can be removed will depend on different business environments. The
following list defines what objects can be considered for removal:

• 5769XZ1 Warp Server licensed program

• 5769SA2 Integration Services if there are no other Integrated Netfinity Server
products on your AS/400 system that require it. To use any Integrated Netfinity
Server hardware as a simple LAN adapter on your AS/400 system, you need
the 5769SA2 licensed program.

• Network Server Storage Spaces

• Warp Server Network Server Description and Line Description

• Integrated Netfinity Server hardware

The Integrated Netfinity Server on which Warp Server, Windows Server and
Novell NetWare run can also perform as a LAN adapter for the AS/400 system by
providing a communications link between the network and OS/400. Many
customers use the Integrated Netfinity Server for both purposes. This means that
considerations for these setups need to be addressed once the Integrated
Netfinity Server based products are no longer needed or available.

For customers that have separate LAN cards in addition to their Integrated
Netfinity Servers, this is not a problem. Once the Integrated Netfinity Server
products are redundant, both the software and Integrated Netfinity Server can be
removed from the AS/400 system. The separate LAN card can be used as the link
for the AS/400 system onto the network.

For customers that still want to use the Integrated Netfinity Server as a LAN
adapter, you can continue to use it in this fashion when running Windows Server
on the Integrated Netfinity Server or 5769SA2 Integration Services. We do not
recommend this. The options for resolving this issue are detailed in the following
list:

• If physical constraints allow, purchase a new LAN card.

• Depending on the system hardware environment, it may be possible to move
the LAN card away from the Integrated Netfinity Server to be used separately.
For further assistance, contact your hardware representative.

Should you still require the Integrated Netfinity Server just as a LAN card, we
advise that you delete the old Warp Server Network Server Description and
create a new *BASE Network Server Description. For more information, refer to
OS/400 Integration Services for the Integrated PC Server, SC41-5123. You also
need to redefine the TCP/IP interfaces. For more information, refer to TCP/IP
Configuration and Reference, SC41-5420.

If you find that the Integrated Netfinity Server is totally redundant now, the
hardware can be removed and the licensed programs can be removed by
completing the following steps:

1. Type GO LICPGM. Press Enter. Then, type option 12. Press Enter.

2. Locate the unnecessary licensed programs, and enter option 4 next to them.
Press Enter.
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3. Press Enter again to confirm the deletion.

Once this is done, the Warp Server Network Server Description and the Network
Server Storage Spaces can be removed. For more information relating to this
removal and the objects involved, refer to OS/2 Warp Server for AS/400
Administration, SC41-5423.

The current business requirements for each customer dictate what happens to
any stand-alone Warp Server PCs. Some customers may choose to keep these
PCs as part of the original Warp Server domain, but redundant PCs can be
re-used elsewhere within the business for other purposes.

6.1.6 Backup considerations
Now that all of the data has been migrated from the Warp Server domain to
AS/400 NetServer, there are likely to be some changes in the way the data is
backed up. With Warp Server, there are a number of stages to back up the data.
These include:

• Using the QLANSRv directory structure to save files and directories on both
local and remote Warp Servers or use the directory QFPNWSSTG to save all
of the Integrated Netfinity Server network server storage spaces

• Saving the Warp Server on Integrated Netfinity Server configuration objects

• Client backup using ADSM or similar third-party product

However, with AS/400 NetServer, all of the user data resides within the AS/400
integrated file system. This simplifies matters since it means that all of the user
data can be saved using conventional AS/400 backup techniques.

The SAV command can be used from the AS/400 command line. This also means
that an entire system save (option 21 from the SAVE menu) will back up all
AS/400 NetServer data. One example of this command is given here:

SAV DEV(qsys.lib/tap01.devd) OBJ('/*) ('/QSYS.LIB' *OMIT) ('/QDLS' *OMIT)
UPDHST(*YES)

The SAV command specified saves all information in the AS/400 integrated file
system, with the exception of QSYS.LIB and QDLS.

It is unlikely that any client backup is required. It this is not the case, the previous
client backup methods can be used. For additional information on backing up
AS/400 integrated file system data, refer to OS/400 Backup and Recovery,
SC41-5304.

6.2 Example scenario: Warp Server to AS/400 NetServer

This section provides a simple fictional business scenario. It explains the
necessary steps that were undertaken to migrate from Warp Server to AS/400
NetServer.

6.2.1 Introduction
Coffey Industries is a small business that has a head office and one regional
branch. They currently have a Warp Server domain that is comprised of a Primary
Domain Controller at the head office on an Integrated Netfinity Server in a
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V4R3M0 AS/400 system and a Backup Domain Controller on a standalone PC at
the regional office.

With new recruits arriving soon, the decision was made to move the few existing
users from Warp Server and use the AS/400 NetServer functionality.

6.2.1.1 Business setup
Figure 48 shows the current setup of the business infrastructure. There are two
Token-Ring networks connected by routers. One PC at the head office has a
locally attached printer. There is a standalone printer at the regional office. The
PC user (PAULINEB) at the regional office is just a Warp Server user and has no
AS/400 user profile. The PC user at the head office is a Warp Server user and an
AS/400 user. This AS/400 profile has been propagated down to the Warp Server
(ARTHURM).

The PCs, which are both running Windows 95, are configured for NetBIOS over
TCP/IP and the network printer uses TCP/IP.

Figure 48. Example scenario - Setup

Each of the two users has their own data directory. They also share another
directory that has had a word processor and other applications loaded into it.
When they want to use applications, they simply run a desktop shortcut, which
points to the executable file on the mapped drive letter.

The mapped drives, using DOS LAN Services, are assigned as follows:

• Both users have a K: drive. This is for their own user data. Two aliases have
been created for this and are listed here:

– Alias ARTHURM links to k:/userdata/arthurm on the Warp Server.
– Alias PAULINEB links to k:/userdata/paulineb on the Warp Server.

Each user has no access to other users aliases.
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• Each user has a G: drive, which is used for the word processor and other
applications. The alias links to k:/shared/apps. Both users can use this alias
but cannot make changes.

Therefore, each PC has a G: and a K: drive.

User ARTHURM has access to both the locally attached printer and the network
printer. User PAULINEB has access only to the network printer.

There is an administrator of the Warp Server domain, and the user profile was
propagated down from the AS/400 system. The steps to migrate from Warp
Server to AS/400 NetServer are detailed here and follow the same format that is
described 6.1, “Migration from Warp Server to AS/400 NetServer” on page 67.

6.2.1.2 File migration
The file migration exercise migrates all data, both individual and shared, across
to another part of the AS/400 integrated file system so that it can be shared once
again using AS/400 NetServer. Using the Integrated File System book, on the
Web at http://www.as400.ibm.com/infocenter, it was decided that the directory
structures, as shown in Figure 49, would be created for the migrated data.

Figure 49. File migration proposal

The following steps are performed to migrate the data:

1. The administrator creates the directories /home/arthurm, /home/paulineb and
/shared in the AS/400 Integrated File System using the CRTDIR command.

2. *PUBLIC * EXCLUDE is specified for the users directories, but *PUBLIC *RX
is specified for the /shared directory since it has been agreed that all users
should have access to these applications.

3. User PAULINEB is added to the AS/400 system using the Create User Profile
(CRTUSRPRF) command. It is not necessary to add ARTHURM since this
user already has an AS/400 profile.

4. The administrator adds authority for the users to their own directories, *RWX
and all object authorities in both cases.

5. Operations Navigator is used to share the three new directories using AS/400
NetServer.

6. Using the method detailed in 6.1.1.2, “File migration using a client” on page
72, the administrator obtains mapped drives to all relevant Warp Server
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shares. The AS/400 NetServer shares are also mapped using the Map
Network Drive function. The administrator logs onto the Windows Network with
the AS/400 user profile so that in both environments, the administrator has all
authorities.

7. All files and directories are copied and pasted into their new directories using
Windows Explorer.

6.2.1.3 Printer migration
There are two printers to consider in this example. The first is the network
LAN-attached printer, and the second is the locally attached printer in the head
office. Both of these printers need to become visible to the AS/400 system if they
are to be used with AS/400 NetServer.

LAN-attached printer migration
The administrator should refer to AS/400 Printing V, SG24-2160, to find out the
options that are available when considering connecting an ASCII LAN-attached
printer to the AS/400 system. Once an output queue has been created, it can be
shared to the AS/400 NetServer users using Operations Navigator. The following
tasks were used to migrate the network printer to a simple LPR/LPD
configuration:

1. The printer is configured for TCP/IP using the supporting information provided
with the printer and the LAN card. This has already been done previously for
Warp Server.

2. The administrator creates a remote output queue on the AS/400 system using
the Create Output Queue (CRTOUTQ) command and specifying the IP
address of the printer.

3. *PUBLIC *USE authority is given to the output queue using the Edit Object
Authority (EDTOBJAUT) command.

4. If not already started, the writer is started by using the Start Remote Writer
(STRRMTWTR) command.

5. With the output queue created, the administrator shares it by using Operations
Navigator (see 3.3, “AS/400 NetServer print shares” on page 34).

6. The new print share can be installed as a network printer on the client. Follow
the information in 3.3, “AS/400 NetServer print shares” on page 34.

PC-attached printer migration
In the case of a printer attached to a PC in the network, it is also necessary to
make the printer visible to the AS/400 system. This printer was not used before
by Warp Server since this product only supports LAN-to-LAN printing.

This can be done with Client Access/400 or by using LPR/LPD. Client Access
provides a printer emulation function that allows the locally attached printer to
become visible to the AS/400 system.

LPD functionality is not shipped with Windows 95 although it can be obtained
from third-party suppliers. The configuration of this method is not covered here.
Please refer to the instructions provided by the third-party manufacturers.

The following steps are necessary to allow this printer to be used:

1. Client Access Express is loaded on the PC with the locally attached printer,
and a PC printer emulation session is configured (see AS/400 Client Access
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Express for Windows, SG24-5191). An output queue for the printer is created
automatically on the AS/400 system. *PUBLIC *USE authority is given to the
output queue.

2. The session is started, and the printer writer is started.

3. The output queue is shared by the administrator (see 3.3, “AS/400 NetServer
print shares” on page 34).

4. The new print share can be installed as a network printer on the AS/400
NetServer client. You can refer to 3.3, “AS/400 NetServer print shares” on
page 34.

6.2.1.4 Client migration
The administrator can remove the DOS LAN Services client since it is no longer
required. In this example, the PCs already have TCP/IP setup on them. However,
it would have been necessary to add TCP/IP if the customer used Warp Server
with the NetBEUI protocol instead.

Once AS/400 NetServer is running and the data has been migrated across, new
file and printer shares can be created (refer to Chapter 3, “Using AS/400
NetServer” on page 25). To ensure the users have minimal changes to consider,
set new mapped drives using the original letters used with Warp Server. This
change in client will not affect the applications called from the remote application
directories.

When the users now log on to the Windows network, they are asked for their
AS/400 user profiles and associated passwords.

6.2.1.5 User migration
The only user migration was the addition of an AS/400 user profile for the user
PAULINEB, which was achieved using the Create User Profile (CRTUSRPRF)
command. This had to be done at an early stage to allow the administrator to set
the correct authorities on the new AS/400 integrated file system directories. User
ARTHURM already exists on the AS/400 system.

6.2.1.6 Backup considerations
The backup strategy can be classified into:

• Client backup
• Warp Server backup

There are no requirements to back up the clients in our example. Normal routines
apply to customers who want to back up clients. There will be no change in this
strategy if it already exists.

The previous Warp Server backup strategy included:

• Nightly incremental backup of the user data only
• Weekly backup of Warp Server E: drive
• Monthly backup of the entire AS/400 system
• Monthly backup of the Warp Server objects

The nightly incremental backup can still be done, except when specifying the
QLANSRv/*, the user data directories can be specified. The weekly backup of the
E: drive is not needed anymore. The entire system save will capture all AS/400
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NetServer data and objects. The final part of the backup strategy can be
disregarded.

6.2.1.7 AS/400 cleanup
Once the administrator is satisfied that everything is working, they can consider
cleaning up the AS/400 system.

In this example, the AS/400 system has no separate LAN card so the Integrated
Netfinity Server is still required to provide a LAN connection for the AS/400
system. The administrator performs the following steps:

1. Power off the external Warp Server at the regional office.

2. Vary off the existing Warp Server Network Server Description.

3. Create a new *BASE Network Server Description and line description (refer to
OS/400 Integration Services for the Integrated PC Server, SC41-5123).

4. Remove and redefine the TCP/IP interfaces for the AS/400 system (use
TCP/IP Configuration and Reference, SC41-5420).

5. Vary on the *BASE Network Server Description.

6. The Warp Server objects can be deleted (use OS/2 Warp Server for AS/400
Administration, SC41-5423).

7. Remove the 5769XZ1 Warp Server licensed program.
88 The AS/400 NetServer Advantage



Chapter 7. Migration from Novell NetWare

This chapter covers the steps and considerations necessary to migrate from
Novell NetWare on an Integrated Netfinity Server to AS/400 NetServer.

7.1 Migration from Novell NetWare to AS/400 NetServer

The topics to consider when migrating are divided into six categories:

• File migration: Migration of files and directories from the NetWare server on
the Integrated Netfinity Server, and any additional NetWare servers to the
AS/400 integrated file system and administration of the security of the file
server.

• Printer migration: Considerations when migrating printers from Novell
NetWare to the AS/400 NetServer environment.

• Client migration: Removal of the NetWare client and re-configuration of file
and printer shares.

• User migration: Moving user IDs from Novell NetWare to AS/400 NetServer.

• Cleanup of the AS/400 system: What consideration to give to the objects
that can be removed on the AS/400 system once the previous tasks are
complete.

• Backup considerations: The changes that need to be made in backing up
the migrated data.

Section 7.2, “Example scenario: Novell NetWare to AS/400 NetServer” on page
106, shows an example of the steps to be considered when migrating from Novell
NetWare to AS/400 NetServer.

This chapter was compiled from information gathered during a migration using
Novell NetWare 4.11. For further information on the supported versions of Novell
NetWare and their constraints, refer to OS/400 Integrating AS/400 with Novell
NetWare, SC41-5124.

7.1.1 File migration

Prior to V4R4, if you are using multiple Novell NetWare servers to serve clients
using different languages, then it is not possible to consolidate all of the user
data onto one AS/400 NetServer setup. This is because AS/400 NetServer
cannot handle clients with different code pages. At V4R4 and above, this
restriction no longer applies.

Note

We advise that you make a backup copy of the NetWare data before any
migration is attempted. In the event of an error, the user data can be restored
back, and therefore, will not be totally lost.

Note
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The object of the file migration exercise is to transfer all user files and directories
(typically those stored in the Network Server Storage Spaces) from the NetWare
servers to the AS/400 integrated file system. There are two possible ways of
achieving this transfer:

• Use AS/400 commands

• Use a PC that has both the NetWare Client for a connection to the NetWare
servers and a connection to an AS/400 NetServer share.

The basis of the first transfer solution relies on a directory link that is found within
the AS/400 integrated file system called QNETWARE. The QNETWARE file
system provides access to the directories and files on both local and remote
NetWare servers. It is required that you have the 5769SS1 option 25 OS/400 -
NetWare Enhanced Integration licensed program installed, as well as the
5769SA3 IBM OS/400 Integration for Novell NetWare licensed program on the
AS/400 system. For further information on the QNETWARE file system, refer to
OS/400 Integrating AS/400 with Novell NetWare, SC41-5124.

The second method involves using Network Neighborhood or File Manager to
copy and paste from the NetWare server drives to the Netserver shares.

To create the new directories in the AS/400 integrated file system to which the
NetWare server data will be transferred, you can use the Create Directory
(CRTDIR) or Make Directory (MKDIR) commands. To create a directory called
USERDATA, see Figure 50.

Figure 50. CRTDIR command

The newly created directory will be owned by the user profile who created it. This
profile will have all rights to it.

It is possible to define the authorities for *PUBLIC as well. Both data and object
authorities can be defined within the CRTDIR or MKDIR command. As a general
guide, we recommend that the data and object authorities for *PUBLIC are set to

Create Directory (CRTDIR)

Type choices, press Enter.

Directory . . . . . . . . . . . /USERDATA___________________________________
______
Public authority for data . . . *EXCLUDE Name, *INDIR, *RWX, *RW...
Public authority for object . . *NONE *INDIR, *NONE, *ALL...

+ for more values
Auditing value for objects . . . *SYSVAL *SYSVAL, *NONE, *USRPRF...

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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*EXCLUDE and *NONE respectively. If *INDIR is selected, the *PUBLIC rights
from the directory above will be assumed (in this case, /root).

Once the necessary directories are created within the AS/400 integrated file
system, you can begin copying the NetWare server files from Network Server
Storage Space to the AS/400 integrated file system.

7.1.1.1 File migration using QNETWARE
This section describes the considerations for migrating files from the NetWare
servers to the AS/400 integrated file system using the QNETWARE directory
structure. The configuration of the Enhanced Integration to allow the use of the
QNETWARE directory structure is not detailed here. The following migration
method assumes that this has already been done. For further information, refer to
Chapter 15 of OS/400 Integrating AS/400 with Novell NetWare, SC41-5124.

It is possible to use either of the following two AS/400 commands to migrate both
the local and remote NetWare server files into the new directories within the
AS/400 integrated file system:

• MOV
• CPY

Both of these commands may give slightly different results in addition to the fact
that the CPY command only produces a replica of the file. There are authority and
attribute considerations of which you need to be aware. They are covered later in
this chapter.

You must ensure that the user profile you use to migrate the data to the AS/400
integrated file system also has an appropriate high level of authority. If possible,
you should use a profile with *ALLOBJ authority. This profile must also have been
authenticated for use with the NetWare servers.

The MOV command is generally recommended because it preserves the
ownership of objects. If the CPY command is used, the user who copies the
objects becomes their owner (if the file system supports this).

It must also be noted that when using either of these commands, some attributes,
extended attributes, and authorities may be discarded. Therefore, it is important
that you review these considerations thoroughly before file migration.

The MOV and CPY commands are fairly similar in appearance and can be used
on single or multiple files.

Because the NetWare server data is migrated across into the AS/400
integrated file system, it is worth noting that some parts of the AS/400
integrated file system have different constraints. Some areas of the integrated
file system, for example, are case sensitive.

For further information on AS/400 integrated file system constraints, refer to
the Integrated File System book, which is located on the Web at:
http://www.as400.ibm.com/infocenter

Note
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In Figure 51, the CPY command is being used for a single file (accounts.txt)
within the ITSCID13 user directory on the NetWare Server. Notice that the access
to this file is through QNETWARE. The destination directory is called userdata.

Figure 51. CPY Object command for a single file

To copy a single file from a NetWare Server to another area within the AS/400
integrated file system, follow these steps:

1. Type WRKLNK on an empty command line, and press Enter.

2. Locate the QNETWARE link, and type 5 next to it. Press Enter to go to the
next level. Locate the name of the desired NetWare server, and type option 5

next to it. Keep using option 5 to progress down until you locate your chosen
file.

3. Type option 3 next to the file that you want to copy, and press F4 to prompt.
We see the same basic screen as shown in Figure 51.

4. Add the name of the destination directory in the To directory line. In this
example, we used the /userdata directory that was created earlier by using the
CRTDIR or MKDIR command. Press Enter. The file is then copied to the new
directory.

5. Once you are satisfied that the copy has succeeded and if you have no further
use for it, you may delete the original by typing option 4 next to it. If preferred,
file deletion can be done after all necessary files are migrated. To do so,
remove the Network Server Storage Space where the files reside (see 7.1.5,
“Cleaning up the AS/400 system” on page 104).

Multiple file copy can also be achieved to save time. Refer to Figure 52 on page
93 to see how this can be done.

Copy Object (CPY)

Type choices, press Enter.

Object . . . . . . . . . . . . . > '/QNetWare/Netware.SVR/SYS/ITSCID13/ACCOUNTS
.TXT'
To directory . . . . . . . . . . '/userdata'

To object . . . . . . . . . . .

Symbolic link . . . . . . . . . *NO *NO, *YES
From Code Page . . . . . . . . . *OBJ 1-32767, *OBJ, *PCASCII
To Code Page . . . . . . . . . . *OBJ 1-32767, *OBJ, *CALC...
Data Format . . . . . . . . . . *BINARY *BINARY, *TEXT

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Figure 52. CPY command method for multiple files

Enter option 3 next to all of the files in one directory on the Warp Server and
specify the parameter todir(‘/userdata’) on the command line. By doing so, all of
the files with the option 3 next to them are copied to the userdata directory when
you press Enter.

As mentioned earlier, the MOV command is generally recommended. However,
since the MOV and CPY commands are similar in use, the same techniques can
be applied.

A comparison of Figure 53 on page 94 and Figure 51 on page 92 clearly shows
that the two commands are similar. This is also true for multiple object moving.

Work with Object Links

Directory . . . . : /QNetWare/Netware.SVR/SYS/ITSCID13

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
3 ACCOUNTS.TXT DSTMF
3 IBMNTNO.NUK DSTMF
3 IBM95.NUK DSTMF
3 TEST.FM DSTMF

Bottom
Parameters or command
===> todir('/userdata')
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F12=Cancel F17=Position to
F22=Display entire field F23=More options
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Figure 53. MOV command for a single object

To move a file, use option 2, not option 3 (Figure 54).

Figure 54. MOV command for multiple objects

Using either of these methods, all of the files you need to migrate can be
transferred to the other areas in the AS/400 integrated file system. These
directories will eventually be made into shares for the AS/400 NetServer users.

Move Object (MOV)

Type choices, press Enter.

Object . . . . . . . . . . . . . > '/QNetWare/Netware.SVR/SYS/ITSCID13/ACCOUNTS
.TXT'
To directory . . . . . . . . . . '/userdata'

To object . . . . . . . . . . .

From Code Page . . . . . . . . . *OBJ 1-32767, *OBJ, *PCASCII
To Code Page . . . . . . . . . . *OBJ 1-32767, *OBJ, *CALC...
Data Format . . . . . . . . . . *BINARY *BINARY, *TEXT

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Work with Object Links

Directory . . . . : /QNetWare/Netware.SVR/SYS/ITSCID13

Type options, press Enter.
3=Copy 4=Remove 5=Next level 7=Rename 8=Display attributes
11=Change current directory ...

Opt Object link Type Attribute Text
2 IBMNTNO.NUK DSTMF
2 IBM95.NUK DSTMF
2 TEST.FM DSTMF

Bottom
Parameters or command
===> todir('/userdata')
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F12=Cancel F17=Position to
F22=Display entire field F23=More options
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7.1.1.2 File migration using a client
There are two reasons why you may decide to use this method of file migration,
rather than the QNETWARE method:

• The Enhanced Integration part of the OS/400 operating system (option 25) is
not loaded or used. This prevents access to the local and remote NetWare
servers using the AS/400 integrated file system.

• Using the AS/400 integrated file system to migrate files can be a
time-consuming exercise since only file objects can be migrated, not
directories. For customers who have many sub-directories, there is also an
increased risk that some files may be overlooked in error.

This method of data migration relies on a PC client that has a connection to
NetWare and an AS/400 NetServer file share to the empty destination directory.
Then, using either File Manager, Network Neighborhood, or even DOS command
line files can be copied from one drive to another. This method can ultimately
prove to be the fastest since entire directory structures can be transferred at a
single time. If you have not already set up your AS/400 NetServer shares, refer to
Chapter 2, “Getting started with AS/400 NetServer” on page 11, and Chapter 3,
“Using AS/400 NetServer” on page 25, for information on setting up AS/400
NetServer and defining file shares.

You must also ensure that the user profiles you are using have adequate
authority to copy or move objects from one directory to another. A profile with
*ALLOBJ authority is advisable for AS/400 NetServer and similarly a NetWare
Administrator profile for Netware Access.

As a general guide, it may be easier to use the same user profile and password.
For example, if the NetWare Administrator profile is called ADMIN, create the
same profile on the AS/400 system, and give *ALLOBJ authority and the same
password as used with NetWare. The same user identification can be used to
migrate the files. This prevents encountering authority problems with the guest
profile and maybe even not connecting to the AS/400 NetServer share as
Windows uses the profile and password entered for the NetWare connection.

For customers running Enhanced Integration, the user profiles from the AS/400
system can be propagated down to the NDS tree. An AS/400 profile with
adequate authority may already exist.

Figure 55 on page 96 shows the window that is seen when using Windows
Explorer in Windows 95. The H: drive is the NetWare drive and ITSCID13 is the
user directory. The E: drive is the AS/400 NetServer file share to the directory
called /userdata in the AS/400 integrated file system.
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Figure 55. NetWare drives and AS/400 NetServer shares on one PC (Windows 95)

To migrate the data, perform the following steps:

1. Logon to NetWare and map a drive to the directory that has the files to be
migrated. In the example shown in Figure 55, the H: drive is used.

2. Select Start-> Programs-> Windows Explorer.

3. When Windows Explorer has started, go to the Tools menu, and select Map
Network Drive.

4. In the Path, enter the name of the share to which you want to map the drive. In
the example in Figure 55, the AS/400 NetServer is called “Qas01”, and the file
share is called “userdata”. In the Path box, the \\Qas01\userdata path was
entered to achieve a mapped network drive to this directory on the AS/400
system.

5. Select all of the directories required within the users NetWare directory on the
NetWare drive (H: drive).

6. Right-click, and select Copy. Then right-click, and select Paste on the
destination directory (E: drive). Entire directories and files can be copied in
one step.

7.1.1.3 Authority considerations
Give special attention to the authorities of the files and directories migrated from
NetWare to AS/400 NetServer. If this part of the migration is neglected, there may
be potential security issues. Users may be prevented from accessing their own
data, and unauthorized users may have access to data that is not intended for
public viewing.

The resulting authorities on any files or directories that have been migrated from
NetWare to AS/400 NetServer are likely to be different from what was originally
set up because the migrated data now obeys AS/400 object security.

Because of the size of many customer data directories, you may want to migrate
over a period of time, rather than all at once. We observed that when moving data
around the AS/400 integrated file system, certain authorities are removed and
new ones are placed. This requires some attention by the administrator.
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The following two sections briefly show the changes in authority that we
experienced when migrating data from NetWare to AS/400 NetServer. The key to
successful data migration is to consider creating many directories in the AS/400
integrated file system rather than having many subdirectories. The authorities
can be set in the initial first-level directory. Files or directories migrated into it will
take on those authorities. The results in the following two sections represent our
findings when migrating data in lab conditions.

Authority considerations when using QNETWARE methods
There are distinct differences between resulting authorities on files that are
migrated to other areas of the AS/400 Integrated FIle System depending on
whether the MOV or CPY command is used. Use the Work with Authority (WRKAUT)
command to examine or modify object authorities.

As shown in Figure 56, the two profiles ITSCID13 and ARTHURM are listed as
having all data and object authorities for the destination directory (called
userdata), while *PUBLIC is *EXCLUDE.

Figure 56. Work with Authority (WRKAUT) display

Figure 57 on page 98 shows the authorities assigned to the file ARTHURM.TXT
in the sys:arthurm directory on the NetWare Server.

Work with Authority

Object . . . . . . . . . . . . : /userdata
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ARTHURM *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
(C) COPYRIGHT IBM CORP. 1980, 1998.
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Figure 57. WRKAUT for the ARTHURM.TXT file

If the CPY command is used to copy this file to the userdata directory elsewhere
in the AS/400 integrated file system, some changes occur.

Figure 58. WRKAUT for a copied file using the CPY command

The resulting copied file has had the authority settings changed. The differences
are listed here:

Work with Authority

Object . . . . . . . . . . . . : /qnetware/Netware.SVR/SYS/ARTHURM/ARTHUR >
Owner . . . . . . . . . . . . : ARTHURM
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*NTWIRF *RWX X X X
*NTWEFF *RWX X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
(C) COPYRIGHT IBM CORP. 1980, 1998.

Work with Authority

Object . . . . . . . . . . . . : /userdata/ARTHURM.TXT
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *RW
ITSCID13 *RW X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
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• Ownership of the file has now changed to the profile that copied it, and all
object and data authorities have been added except EXECUTE. This is
because the ARTHURM.TXT file is not an executable file.

• *PUBLIC *RW data authority to this file has been added.

When moving the file using the MOV command, a slightly different result is
achieved.

In Figure 59, the object ownership has remained the same this time. *PUBLIC
*RW data authority has been granted for this file. User ARTHURM has been
added as an authorized user and given all rights, except EXECUTE. As before,
the userdata directory lists both ARTHURM and ITSCID13 as having all data and
object authorities. Also *PUBLIC is *EXCLUDE.

Figure 59. WRKAUT on a file moved using the MOV command

Authority considerations when using a client to migrate data
As mentioned earlier, it is possible that this may be the faster of the two methods.
However, by using the copy and paste method from DOS, Windows for
Workgroups (3.11), or Windows 95, 98, or NT, the authorities on the files and
directories are lost. For this reason, it is important that when the AS/400
NetServer directory is created, it has the correct authorities on it. This way, any
files or directories that are migrated acquire the correct security from the directory
into which they are copied.

In Figure 60 on page 100, notice the userdata directory that was created earlier.
Notice that *PUBLIC has been excluded. The owner is the profile that created it,
and therefore, has all authority to it. The ACCOUNTS user profile has been
added manually to the userdata directory and given *RX rights, and ARTHURM
has been provided with all data and object authorities.

Work with Authority

Object . . . . . . . . . . . . : /userdata/ARTHURM.TXT
Owner . . . . . . . . . . . . : ARTHURM
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *RW
ARTHURM *RW X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
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Figure 60. Work with Authority

In Figure 61, the list of authorized users for the /A directory is shown. Notice that
ARTHURM is the owner of the directory.

Figure 61. WRKAUT for NetWare directory

These authorities change when migrated by using the copy and paste method to
the userdata directory, which is to be used for AS/400 NetServer.

Work with Authority

Object . . . . . . . . . . . . : /userdata
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ACCOUNTS *RX
ARTHURM *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
(C) COPYRIGHT IBM CORP. 1980, 1998.

Work with Authority

Object . . . . . . . . . . . . : /qnetware/Netware.SVR/SYS/ARTHURM/A
Owner . . . . . . . . . . . . : ARTHURM
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*NTWIRF *RWX X X X
*NTWEFF *RWX X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
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Figure 62 shows the resulting authorities on the /A directory after being migrated
from the NetWare user directory to a directory within the AS/400 integrated file
system, userdata. Notice how the authorities that were present, as shown in
Figure 61 on page 100, have been altered. The new authorities for this directory
and the files contained within it have adopted the userdata authorities (see Figure
60 on page 100).

Figure 62. WRKAUT after migration from NetWare user directory to AS/400 NetServer

With this in mind, it is clear that if the authorities are set correctly at the first level
directory, then all other authorities will fall into place when the data is migrated
across from the NetWare Server. This is why customers may find it easier to
create a directory for every user, rather than set up authorities for many
sub-directories.

7.1.2 Printer migration
This section explains considerations for migrating printers from Novell NetWare
to AS/400 NetServer.

7.1.2.1 Overview
NetWare supports the following printing possibilities:

• LAN-to-LAN printing. That is, it supports a PC on a LAN printing to a printer,
which is also on the LAN.

• Using a third-party product called HostPrint/400, it is possible to print from
NetWare to AS/400 printers.

• Using the Enhanced Integration, it is possible to print from the AS/400 system
to NetWare printers.

AS/400 NetServer supports both LAN-to-LAN and LAN-to-HOST printing
techniques. This means that printers on the LAN and printers attached to other
PCs or AS/400 systems can be accessed.

Work with Authority

Object . . . . . . . . . . . . : /userdata/A
Owner . . . . . . . . . . . . : ITSCID13
Primary group . . . . . . . . : *NONE
Authorization list . . . . . . : *NONE

Type options, press Enter.
1=Add user 2=Change user authority 4=Remove user

Data --Object Authorities--
Opt User Authority Exist Mgt Alter Ref

*PUBLIC *EXCLUDE
ITSCID13 *RWX X X X X
ACCOUNTS *RX
ARTHURM *RWX X X X X

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve
F11=Display detail data authorities F12=Cancel F24=More keys
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The printers that are configured for use with NetWare are not necessarily visible
to the AS/400 system since the standard print serving is done by the NetWare
Server. When using Enhanced Integration to print to NetWare printers, an output
queue exists on the AS/400 system, but it is configured for use with the NetWare
server and needs to be modified.

For the AS/400 NetServer to use any printers, you need to make the printers
visible to the AS/400 system. This is done by using the Create Output Queue
(CRTOUTQ) command, which sets up an output queue to the printer. Once this has
been done, it can be shared for the AS/400 NetServer users.

Network printers
Network printers that were used for NetWare printing alone must be configured
for TCP/IP. Details of how to do that are provided in the supporting
documentation for the printer LAN card or associated hardware. Printers that
were visible to the AS/400 system by means of the Enhanced Integration
functions need their output queues modified to point directly to the printers rather
than the server.

Depending on the printer make and model or how it is attached to the LAN, it may
be possible to setup either LPR/LPD from the AS/400 system to the printer using
a remote output queue (RMTOUTQ). If the printer is PCL/PJL compatible, a LAN
Device Description can be used. For details on how to set up these connections,
refer to AS/400 Printing V, SG24-2160.

Host printers
As mentioned earlier, AS/400 NetServer can also support LAN-to-HOST printing.
This includes printers that are connected to other PCs or AS/400 systems and
are therefore, not connected directly to the LAN. It is possible to use printer
emulation, where printers connected to PC LPT ports can be accessed from the
AS/400 system. IBM Client Access is one product with which this can be
achieved. It is also possible to use LPR/LPD from the AS/400 system to the host
with the attached printer.

7.1.2.2 Authority considerations
Authority to allow users access to AS/400 output queues is required. It is
important to review the necessary authorities to prevent unauthorized functions
on the spooled files in the output queues.

After migration, there may be a requirement to restrict certain users from using
some printers. The authority considerations are covered in 3.3.1, “Authority
considerations” on page 35. The security of spooled files and output queues is
covered in OS/400 Security, SC41-5302.

7.1.2.3 Client installation
For details on how to set up the printers on the client, refer to 3.3, “AS/400
NetServer print shares” on page 34.

7.1.3 Client migration
To use AS/400 NetServer, the PC requires no special applications, unlike
NetWare which requires a client application. The functionality to use AS/400
NetServer is available with the supported Windows operating systems and
requires only minimal additions to the current setups.
102 The AS/400 NetServer Advantage



When migrating clients, the client PCs effectively fall into one of the two following
categories:

• Operating systems supported with AS/400 NetServer. These include:

– Windows for Workgroups (3.11)
– Windows 95/98/NT/2000/Terminal Server Edition

• Operating systems not supported with AS/400 NetServer. These include:

– OS/2
– DOS
– Windows 3.1

The clients that are not supported for use with AS/400 NetServer also have to be
migrated to a supported operating system.

The clients that are supported must first have the NetWare client removed from
the PC since this application is no longer required. The removal of this application
depends on the operating system on which it is installed.

Once the NetWare client application is removed, the PC is configured with one of
the listed supported operating systems, and TCP/IP installed and configured, the
task of redefining the network drive and printers to point toward the new shares
can begin. This involves setting up mapped network drives and network printers
that are provided by AS/400 NetServer. Setting up file and printer shares is
explained in Chapter 3, “Using AS/400 NetServer” on page 25.

It is worth noting that since the network drives and printers will reference the new
AS/400 NetServer shares (a new drive on a different server), it is easy to revert
back to the old drive mappings. If the NetWare client and the IPX protocol are not
removed, the mapped drives in the NetWare environment can be redefined again
by invoking the NetWare client. This provides the customer with an option to
revert back to NetWare if necessary.

7.1.4 User migration
The NetWare solution allows users to be enrolled into the NDS tree in two ways:

• Create an AS/400 user profile using the Create User Profile (CRTUSRPRF)
command. Then, allow the profile to be propagated down to the NDS tree
(Enhanced Integration only).

• Create NetWare users within NetWare using the standard NetWare
applications without creating an AS/400 user.

There are advantages and disadvantages of these two methods which are not
discussed here. However, it is possible that most business setups will have a
mixture of both AS/400 users and NetWare-only users.

All AS/400 NetServer users must be set up as AS/400 users, unless they are to
assume the optionally configured guest user profile. The configuration of the
guest user profile is covered in detail in 2.4, “Configuring the guest user profile”
on page 20.

NetWare users who are already AS/400 users should now log on to the Windows
Network with their AS/400 user profile and password.
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Users who have no AS/400 profile and password can log on to the Windows
Network as any user and, if configured, they assume the guest profile on AS/400
NetServer. Should they need access to further shares, we recommend that you
create AS/400 profiles and make sure that the users log on to the Windows
Network with these profiles and their associated passwords.

7.1.5 Cleaning up the AS/400 system
Once you have completed the migration process up to this point, you need to
assess what redundant objects on the AS/400 system can be removed. The
objects that can be removed depend on different business environments. The
following list defines what objects can be considered for removal:

• 5769SA3 IBM OS/400 Integration for Novell NetWare licensed program

• 5769SS1 option 25 NetWare Enhanced Integration licensed program

• 5769SA2 Integration Services if there are no other Integrated Netfinity Server
products on your AS/400 system that require it. To use any Integrated Netfinity
Server hardware as a simple LAN adapter on your AS/400 system, you need
the 5769SA2 licensed program.

• Network Server Storage Spaces

• NetWare Network Server Description and Line Description

• Integrated Netfinity Server hardware

The Integrated Netfinity Server on which Warp Server, Windows Server, and
Novell NetWare run can also perform as a LAN adapter for the AS/400 system by
providing a communications link between the network and OS/400. Many
customers use the Integrated Netfinity Server for both purposes. This means that
considerations for these setups need to be addressed once the Integrated
Netfinity Server based products are no longer needed or available.

For customers that have separate LAN cards in addition to their Integrated
Netfinity Servers, this is not a problem. Once the Integrated Netfinity Server
products are redundant, both the software and Integrated Netfinity Server can be
removed from the AS/400 system. The separate LAN card can be used as the link
for the AS/400 onto the network.

For customers that still want to use the Integrated Netfinity Server as a LAN
adapter, you can continue to use it in this fashion when running Windows Server
on the Integrated Netfinity Server or 5769SA2 Integration Services. We do not
recommend this. The options for resolving this issue are detailed in the following
list:

• If physical constraints allow, purchase a new LAN card.

• Depending on the system hardware environment, it may be possible to move
the LAN card away from the Integrated Netfinity Server to be used separately.
For further assistance, contact your hardware representative.

Should you still require the Integrated Netfinity Server just as a LAN card, we
advise that you delete the old NetWare Network Server Description and create a
new *BASE Network Server Description. For more information, refer to OS/400
Integration Services for the Integrated PC Server, SC41-5123. You also need to
redefine the TCP/IP interfaces. For more information, refer to TCP/IP
Configuration and Reference, SC41-5420.
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If you find that the Integrated Netfinity Server is totally redundant now, the
hardware can be removed and the licensed programs can be removed by
completing the following steps:

1. Type GO LICPGM. Press Enter. Then, type option 12. Press Enter.

2. Locate the unnecessary licensed programs, and enter option 4 next to them.
Press Enter.

3. Press Enter again to confirm the deletion.

Once this is done, the NetWare Network Server Description and the Network
Server Storage Spaces can be removed. For more information relating to this
removal and the objects involved, refer to OS/400 Integrating AS/400 with Novell
NetWare, SC41-5124.

The current business requirements for each customer dictate what happens to
any stand-alone NetWare servers. Some customers may choose to keep these
PCs as part of the original NetWare tree, but redundant PCs can obviously be
re-used elsewhere within the business for other purposes.

7.1.6 Backup considerations
Now that all of the data has been migrated from the NetWare servers to AS/400
NetServer, there are likely to be some changes in the way that the data is backed
up. With Novell NetWare, there are a number of options to back up the data.
These include:

• Using the QNETWARE directory structure to save files and directories on both
local and remote servers or use the directory QFPNWSSTG to save all of the
Integrated Netfinity Server network server storage spaces

• Saving the Novell NetWare on Integrated Netfinity Server configuration
objects

• Using SBACKUP or ARCserve products to backup all NetWare servers and
workstations

However, with AS/400 NetServer, all of the user data resides within the AS/400
integrated file system. This simplifies matters since it means that all of the user
data can be saved using conventional AS/400 backup techniques.

The SAV command can be used from the AS/400 command line. This also means
that an entire system save (option 21 from the SAVE menu) will back up all
AS/400 NetServer data. One example of this command is given here:

SAV DEV(qsys.lib/tap01.devd) OBJ(('/*) ('/QSYS.LIB' *OMIT) ('/QDLS' *OMIT)
UPDHST(*YES)

The SAV command specified will save all information in the AS/400 integrated file
system with the exception of QSYS.LIB and QDLS.

It is unlikely that any client backup is required. If this is not the case, the previous
client backup methods can be used. For additional information on backing up
AS/400 integrated file system data, refer to OS/400 Backup and Recovery,
SC41-5304.
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7.2 Example scenario: Novell NetWare to AS/400 NetServer

This section provides a simple fictional business scenario. It explains the
necessary steps that were taken to migrate from Novell NetWare to AS/400
NetServer.

7.2.1 Introduction
Coffey Industries is a small business that has a head office and one regional
branch. They currently have a NetWare setup that is comprised of NetWare on
the Integrated Netfinity Server at the head office in a V4R3M0 AS/400 system
(NetWare1) and another NetWare server, which is part of the same NDS tree on a
stand-alone PC at the regional office (NetWare2).

With some new recruits arriving soon, the decision was made to move the few
existing users from NetWare and use the AS/400 NetServer functionality.

7.2.1.1 Business setup
Figure 63 shows the current setup of the business infrastructure. There are two
Token-Ring networks connected by routers. One PC at the head office has a
locally attached printer. There is a stand-alone printer at the regional office. The
PC client at the regional office is just a NetWare user and has no AS/400 user
profile. The PC client at the head office is the NetWare administrator and user
and also has an *ALLOBJ AS/400 user profile. Enhanced Integration is not used
on the AS/400 system. Both PCs are running Windows 95 and use IPX to
communicate with the NetWare servers.

Figure 63. Example Scenario - Setup

Each of the two users has their own data directory. They also share another
directory that has had a word processor and other applications loaded into it.
When they want to use applications, they simply run a desktop shortcut, which
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points to the executable file on a mapped drive letter. The mapped drives, using
the NetWare client, are assigned as follows:

• Both users have a K: drive. This is for their own user data.

– For user ARTHURM, the K: drive is mapped to Netware1_SYS/arthurm.
– For user PAULINEB, the K: drive is mapped to Netware2_SYS/paulineb.

Each user has no access to other users directories.

• Each user has a G: drive, which is used for the word processor and other
applications. The mapped drive points to a shared directory on the
stand-alone NetWare server. Both users can use this directory, but not make
changes.

Therefore, each PC has a G: and a K: drive.

User ARTHURM has access to both the locally attached printer and the network
printer. User PAULINEB has access only to the network printer.

The steps to migrate from NetWare to AS/400 NetServer are detailed here and
follow the same format that is described in 7.1, “Migration from Novell NetWare to
AS/400 NetServer” on page 89.

7.2.1.2 File migration
The file migration exercise migrates all data, both individual and shared, across
to another part of the AS/400 integrated file system so that it can be shared once
again using AS/400 NetServer. Using the Integrated File System book, at
http://www.as400.ibm.com/infocenter, it was decided that the directory structures
shown in Figure 64 would be created for the migrated data.

Figure 64. File migration proposal

The following steps are performed to migrate the data:

1. The AS/400 administrator creates the directories /home/arthurm,
/home/paulineb, and /shared in the AS/400 integrated file system using the
CRTDIR command.

2. *PUBLIC * EXCLUDE is specified for the users’ directories, but *PUBLIC *RX
is specified for the /shared directory since it has been agreed that all users
should have access to these applications.

3. User PAULINEB is added to the AS/400 system using the Create User Profile
(CRTUSRPRF) command.
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4. The AS/400 administrator adds authority for the users to their own directories,
*RWX and all object authorities in both cases.

5. Operations Navigator is used to share the three new directories using AS/400
NetServer.

6. Using the method described in 7.1.1.2, “File migration using a client” on page
95, the NetWare administrator obtains mapped drives to all relevant NetWare
directories. The AS/400 NetServer shares are also mapped using the Map
Network Drive function.

7. All files and directories are copied and pasted into their new directories using
Windows Explorer.

7.2.1.3 Printer migration
There are two printers to consider in this example. The first is the network
LAN-attached printer, and the second is the locally attached printer in the head
office. Both of these printers need to become visible to the AS/400 system if they
are to be used with AS/400 NetServer.

LAN-attached printer migration
The administrator should refer to AS/400 Printing V, SG24-2160, to find out the
options that are available when considering connecting an ASCII LAN-attached
printer to the AS/400 system. Once an output queue is created, it can be shared
to the AS/400 NetServer users by using Operations Navigator. The following
tasks were used to migrate the network printer to a simple LPR/LPD
configuration:

1. The printer is configured for TCP/IP using the supporting information provided
with the printer and the LAN card.

2. The administrator creates a remote output queue to the AS/400 system using
the Create Output Queue (CRTOUTQ) command and specifying the IP address of
the printer.

3. *PUBLIC *USE authority is given to the output queue using the Edit Object
Authority (EDTOBJAUT) command.

4. If not already started, the writer is started by using the STRRMTWTR command.

5. With the output queue created, the administrator shares it by using Operations
Navigator (see 3.3, “AS/400 NetServer print shares” on page 34).

6. The new printer share can be configured on the client. Follow the information
in 3.3, “AS/400 NetServer print shares” on page 34.

PC-attached printer migration
In the case of a printer attached to a PC on the network, it is also necessary to
make the printer visible to the AS/400 system. This printer was not used before
by NetWare.

This can be done with Client Access/400 or by using LPR/LPD. Client Access
provides a printer emulation function that allows the locally attached printer to
become visible to the AS/400 system.

LPD functionality is not shipped with Windows 95 although it can be obtained
from third-party suppliers. The configuration of this method is not covered here.
Please refer to the instructions provided by the third-party manufacturers.
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The following steps are necessary to allow this printer to be used:

1. Client Access Express is loaded on the PC with the locally attached printer,
and a PC printer emulation session is configured (see AS/400 Client Access
Express for Windows, SG24-5191). An output queue for the printer is created
automatically on the AS/400 system.

2. *PUBLIC *USE authority is given to the output queue using the Edit Object
Authority (EDTOBJAUT) command.

3. The session is started and the printer writer is started.

4. The output queue is then shared by the by the AS/400 administrator (see 3.3,
“AS/400 NetServer print shares” on page 34).

5. The new print share can be installed as a network printer on the client. You
can refer to 3.3, “AS/400 NetServer print shares” on page 34.

7.2.1.4 Client migration
The administrator can remove the NetWare client since it is no longer required. In
this example, the PCs have only IPX setup on them. Therefore, TCP/IP needs to
be configured additionally on each PC.

Once AS/400 NetServer is running and the data has been migrated across, new
file and printer shares can be created (refer to Chapter 3, “Using AS/400
NetServer” on page 25). To ensure the users have minimal changes to consider,
set new mapped drives using the original letters used with the NetWare client.
This change in client will not affect the applications called from the remote
application directories.

When the users now log on to the Windows network, they are asked for their
AS/400 user profiles and associated passwords.

7.2.1.5 User migration
The only user migration was the addition of an AS/400 user profile for the user
PAULINEB, which was achieved using the CRTUSRPRF command. This had to be
done at an early stage to allow the administrator to set the correct authorities on
the new AS/400 integrated file system directories. User ARTHURM already exists
on the AS/400 system.

7.2.1.6 Backup considerations
The backup strategy can be classified into:

• Client backup
• NetWare Server backup

There are no requirements to backup the clients in our example. Normal routines
apply to customers who want to backup clients using third-party products. There
will be no change in this strategy if it already exists. For further information,
customers should consult their third-party product support.

The previous NetWare backup strategy included:

• Weekly backup of NetWare Server (NETWARE1) E: drive
• Weekly backup of the NetWare server data using SBACKUP utility
• Monthly backup of the entire AS/400 system
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Now, the weekly backup of the E: drive is not needed anymore. The entire system
save will capture all AS/400 NetServer data, but this was done only monthly.
Therefore, the customer can now use the AS/400 SAV command to back up data
from specific areas within the AS/400 integrated file system on a more frequent
basis. For further information, refer to OS/400 Backup and Recovery, SC41-5304.

The SBACKUP utility is also now redundant.

7.2.1.7 AS/400 cleanup
Once the administrator is satisfied that everything is working, they can consider
cleaning up the AS/400 system. In this example, the AS/400 system has no
separate LAN card so the Integrated Netfinity Server is still required to provide a
LAN connection for the AS/400 system. The administrator performs the following
steps:

1. Bring down the external NetWare Server at the regional office.

2. Vary off the existing NetWare Server Network Server Description.

3. The administrator creates a new *BASE Network Server Description and a line
description (refer to OS/400 Integration Services for the Integrated PC Server,
SC41-5123).

4. Remove and redefine the TCP/IP interfaces for the AS/400 system (use
TCP/IP Configuration and Reference, SC41-5420).

5. Vary on the *BASE Network Server Description.

6. The NetWare Server objects can be deleted (use OS/400 Integrating AS/400
with Novell NetWare, SC41-5124).

7. Remove the 5769SA3 Novell NetWare licensed program.
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Part 3. AS/400 NetServer and Network Stations

Part 3 describes how to use AS/400 NetServer with Network Stations in a
Windows NT server 4.0, Terminal Server Edition environment.

We present an overview of using AS/400 NetServer with Network Stations and
describe the benefits that you can achieve by setting up this environment. We
describe the main steps in administering a Terminal Server Edition server and
Citrix Metaframe for use with Network Stations. We give a practical example for
using this environment.
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Chapter 8. AS/400 NetServer and Network Stations

Network Stations, also called thin clients, are diskless computers that get their
boot kernel from a boot server, which in our environment is the AS/400 system. If
you want to use Network Stations as Windows NT clients in a Windows NT
domain, you need a special Windows NT server, called Windows NT server,
Terminal Server Edition. It allows you to run applications on the Windows NT
server. The Network Stations are connected using the Independent Computing
Architecture (ICA) protocol to the Windows NT server, Terminal Server Edition
server. This protocol is supplied by the Citrix Metaframe software, which is
installed on the Windows NT server, Terminal Server Edition server.

8.1 Benefits of using Network Stations with AS/400 NetServer

You are now in the position to set up the security and administration of your
Network Stations, file servers, and print servers from one system, namely the
AS/400 system. This is because you can use the Network Station Manager and
AS/400 NetServer on the AS/400 system. It reduces the costs of your server
software because AS/400 NetServer is included in the basic package of the
OS/400. You only have to pay for the PC Server products that you are using. You
do not have to buy special hardware because you are using the hardware from
the AS/400 system. Also, you do not need to buy special backup software,
because you can use the backup utilities from OS/400 to save your data.

If you are using the Integrated Netfinity Server as your Windows NT server,
Terminal Server Edition server (application server), you can use the OS/400
utilities as well for backing up its files.

8.2 Getting started

This section lists the steps that need to be followed before you can implement the
solution described in this chapter.

8.2.1 Prerequisites
The following prerequisites must be installed to use Network Stations with AS/400
NetServer in a Windows NT server, Terminal Server Edition environment:

• The Integrated Netfinity Server or Integrated PC Server must be up and ready.
The earliest model Integrated Netfinity Servers, known as FSIOPs, do not
work with Windows NT server, Terminal Server Edition server.

• OS/400 Operating System V4R3M0 or higher, with recommended PTFs, (refer
to 8.5.1, “Multiple session support” on page 122), must be installed on the
AS/400 system.

• Network Station Manager V3R7M0 or higher must be installed and configured.
For setting up Network Station Manager, please refer to IBM Network Station
Manager Installation and Use, SC41-0664.

• The Windows NT server, Terminal Server Edition server must be installed and
configured. For setting up this server, please refer to the related Microsoft
publication or AS/400 - Implementing Windows NT on the Integrated Netfinity
Server, SG24-2164.
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• The Citrix Metaframe program must be installed on the Windows NT server,
Terminal Server Edition server. We used Version 1.8 in this redbook. For
setting up this program, please refer to the related Citrix publications.

• Network Stations must be configured and connected to the system that
contains the Network Station Manager program (in our environment, the
AS/400 system) and to the Windows NT server, Terminal Server Edition
server. For setting up Network Stations, please consult AS/400 - IBM Network
Station - Getting Started, SG24-2153, and IBM Network Station Manager
Installation and Use, SC41-0664.

• AS/400 NetServer must be started on the AS/400 system. For administration
topics, refer to Chapter 2, “Getting started with AS/400 NetServer” on page
11.

8.2.2 Required skills
This section shows the required skills for using Network Station in a Windows NT
server, Terminal Server Edition and AS/400 NetServer environment.

• AS/400 skills

Basic operations skills are required, as well as some experience with using
Operations Navigator. You should also be familiar with administering user
authority and configuring TCP/IP.

• Windows NT server, Terminal Server Edition skills

It is essential to have a knowledge of Windows NT administration functions,
especially in user administration, security, and resource sharing.

• Network Station skills

A basic skill in using Network Station Manager is required.

8.3 Windows NT server, Terminal Server Edition

This section shows:

• The two options for installing applications on a Windows NT server, Terminal
Server Edition server.

• The considerations for a domain user, using Network Stations, to log on to a
Windows NT server, Terminal Server Edition server.

• How to install a WINS server on a Windows NT server, Terminal Server Edition
server.

8.3.1 Applications and Windows NT server, Terminal Server Edition
Multiple concurrent users accessing Terminal Server Edition, will log on and
access applications in separate, protected sessions on a single server.

Normally the Windows NT server, Terminal Server Edition server is in a mode
called execute mode. If we want to install applications on a Windows NT server,
Terminal Server Edition server, we have to put the server into a special mode,
called installation mode. There are two different ways to do this, which are
explained in the following sections.
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8.3.1.1 DOS commands
If you want to put the server into installation mode, perform the following tasks:

1. Log on to Windows NT server, Terminal Server Edition server with
administrator authority.

2. Click Start-> Programs-> Command Prompt to open a DOS box.

3. Type change user /install and press Enter. The message User session is

ready to install applications appears as shown in Figure 65.

Figure 65. Installation Mode

Now the Windows NT server, Terminal Server Edition server is in the mode
that allows you to install applications.

When you are finished installing the applications, before rebooting the server,
perform the following steps:

1. Open a DOS Box as previously described.

2. Type change user /execute and press Enter. Then, the message User session

is ready to execute applications appears as shown in Figure 66.

Figure 66. Execute Mode

Now the Windows NT server, Terminal Server Edition server is ready for
normal use and can be rebooted if necessary.

8.3.1.2 Add/Remove Program tool
Perform the following tasks to install applications on a Windows NT server,
Terminal Server Edition server using the Add/Remove Programs tool:

1. Log on to Windows NT server, Terminal Server Edition server with
administrator authority.

2. Click Start-> Settings-> Control Panel

Microsoft(R) Windows NT(TM)
(C) Copyright 1985-1998 Microsoft Corp.

E:\WINNT\Profiles\hartig>change user /install
User session is ready to install applications.

E:\WINNT\Profiles\hartig>

Microsoft(R) Windows NT(TM)
(C) Copyright 1985-1998 Microsoft Corp.

E:\WINNT\Profiles\hartig>change user /execute
User session is ready to execute applications.

E:\WINNT\Profiles\hartig>
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3. Select Add/Remove Programs icon.

4. Click Install.

5. Click Next.

6. In the Run Installation Program window, shown in Figure 67, type in the path
where the installation program is located (for example, the CD-ROM drive).
Click Next.

Figure 67. Run Installation Program

7. The Change User Option window appears. Leave the default as shown in
Figure 68. Click Next.

Figure 68. Change User Option

8. The installation starts. Go through the normal installation steps of your
program to be installed.

9. If your installation program requests a restart of your Windows NT server,
Terminal Server Edition server, select No, I will restart my computer later.

10.After normal installation program has ended, the After Installation window
appears as shown in Figure 69 on page 117. Click Next.
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Figure 69. After Installation

11.At the next window, shown in Figure 70, click Finish.

Figure 70. Finish Admin Install

The Windows NT server, Terminal Server Edition server now allows the use of the
installed application.

8.3.2 Considerations for domain users
The following tasks allow domain users on Network stations, a local login to the
Windows NT server, Terminal Server Edition server. These tasks must be
performed if the user is to connect to the server.

1. Log on to Windows NT server, Terminal Server Edition server with
administrator authority.

2. Click Start-> Programs-> Administrative Tools-> User Manager for
Domains.

3. In the User Manager window, select Policies-> User Rights.

4. Select Log on locally from the pull-down menu as shown in Figure 71 on
page 118.
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Figure 71. User Rights Policy

5. Check if the group Domain Users is shown in the lower list (in Figure 71). If
not, proceed to the next task. Otherwise, you can stop here.

6. Click Add. The window shown in Figure 72 appears.

Figure 72. Add Users and Groups

7. Select the group Domain Users from the list as shown in Figure 72, and click
the Add button.

8. Now the group, named Domain Users, should be shown in the lower list
(Figure 72). Click OK.

Instead of adding the group Domain Users, the group Everyone can be added.
However, it will decrease the security of the domain. Therefore, we recommend
that you add the group Domain Users or add special user-defined groups.

Note
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8.3.3 Setting up WINS Server
When using AS/400 NetServer, it is possible to use a WINS server to provide a
central point for NetBIOS name resolution. Here, we explain how to set up a
WINS server on a Windows NT server, Terminal Server Edition server.

To set up the WINS server, perform the following steps:

1. Click Start-> Settings-> Control Panel. Double-click on the Network icon.

2. Select the Services tab, and click Add. The window shown in Figure 73
appears.

Figure 73. Select Network Service

3. Select Windows Internet Name Service from the list as shown in Figure 73,
and click OK.

4. If the Windows NT Setup window appears, enter the path where your
Windows NT server, Terminal Server Edition server installation files are
located, for example, a CD-ROM drive. If this window does not appear,
continue with the next task.

5. Some files are copied which are needed for the requested service. After
copying, in the Network window, Windows Internet Name Service should
appear as shown in Figure 74 on page 120.
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Figure 74. Network

6. Close the Network window, and reboot the Windows NT server, Terminal
Server Edition server to activate the service.

7. After rebooting the Windows NT server, Terminal Server Edition server, click
Start-> Program-> Administrative Tools. There is now a new menu item
called WINS Manager. By selecting this menu item, you can administer the
WINS server.

The WINS server now dynamically refreshes the NetBIOS name table and can be
synchronized with other servers. To administer the WINS server, refer to the
Microsoft documentation. For details on how to use the WINS server with AS/400
NetServer, refer to 2.1, “Configuring AS/400 NetServer” on page 12.

8.4 Citrix Metaframe and Network Station Manager

Citrix MetaFrame Application Server for Windows is Citrix’s thin client/server
system software for Windows NT server, Terminal Server Edition server. It uses
the Independent Computing Architecture (ICA) protocol to connect thin-clients to
the Windows NT server, Terminal Server Edition server from where the
applications are deployed, managed, and executed. There is no need to
download the application from the server. This results in better manageability.

There are some easy configuration steps to be done in the Network Station
Manager program, so that Network Stations (ICA clients) can be connected to a
Windows NT server, Terminal Server Edition server. This section describes these
configuration steps. Complete the following steps to set up Network Station
Manager for ICA clients:
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1. Citrix Metaframe must be installed on the Windows NT server, Terminal Server
Edition server to which we will connect.

2. Enter the Network Station Manager Program with a standard browser, such as
Netscape Navigator or Internet Explorer. For more information, refer to IBM
Network Station Manager Installation and Use, SC41-0664.

3. At the Network Station Manager main menu, click Startup-> Menus-> Next.

4. At Menu Contents - System Defaults, scroll down and choose Local Program
Menu Items.

5. Complete the following parameters as shown in Figure 75:

a. Menu item label: Enter the name of the menu button.

b. Program to run: Type ICACLNT. This is the connection program for the ICA
clients.

c. Parameters: Type in -h <ip-address of WIN/TSE server> -c 256. Here, -h
refers to the host IP address (Windows NT server, Terminal Server Edition
server), and -c is the color resolution. We recommend that the Network
Stations have the 2 MB graphic chip installed when used with a Windows
NT server, Terminal Server Edition server.

Figure 75. IBM Network Station Manager

d. Click Finish to save the parameters.

After signing on to the Network Station, the new menu item appears in the task
bar.
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8.5 Using Network Stations with AS/400 NetServer

This section describes how to use AS/400 NetServer in a Windows NT server,
Terminal Server Edition environment with Network Stations. It explains only the
tasks associated with Network Stations using AS/400 NetServer.

8.5.1 Multiple session support
AS/400 NetServer has always supported Windows NT server, Terminal Server
Edition server as a client for a single user. Until now, it has not allowed access for
multiple concurrent users from a single workstation. With the V4R4M0 PTFs
shown in Table 4, AS/400 NetServer can now handle multiple user sessions from
one PC client (in our example, Windows NT server, Terminal Server Edition). See
Informational APAR II11435 for updated information about V4R3M0 or higher
releases and support.

Table 4. Multiple user session PTFs

Refer to the following Informational APARs for the AS/400 PTF requirements so
that AS/400 NetServer functions properly:

• II12091 for V4R4M0
• II11752 for V4R3M0
• II11081 for V4R2M0

To support multiple users establishing sessions from the same workstation,
AS/400 NetServer requires additional tables and locking constructs to store and
track multiple AS/400 NetServer session activity associated with one NetBIOS
over TCP/IP (NBT) connection. For a better understanding, see Figure 76 on
page 123. This figure demonstrates that although there are four Network Station
users with AS/400 NetServer sessions, the Windows NT server, Terminal Server
Edition server generates only one PC client connection. The AS/400 NetServer
now has the ability to handle more than one client session with the same name
from the TSE server.

PTF number Description

MF23055 AS/400 NetServer support of TSE and
Windows 2000 clients.

MF23047 AS/400 NetServer multiple user session
tables (Prerequisite for MF23055)

MF23044 AS/400 NetServer sessions list guest user
profile name instead of actual user name
(Prerequisite for MF23047)

It is also possible to configure a connection to a Windows NT server, Terminal
Server Edition server as an autostart program. The parameters are the same,
but instead of using the Menus item, we must use the Programs item in the
Startup menu.

Note
122 The AS/400 NetServer Advantage



Figure 76. Multiple session support

After you have established two or more Network Station sessions to the AS/400
NetServer, the AS/400 NetServer administration window in the Operations
Navigator program appears similar to the example in Figure 77.

Figure 77. Operations Navigator - Multiple session support

For more information about multiple session support, please refer to the related
PTF cover letters listed in Table 4 on page 122.

8.5.2 File shares with Network Stations
When using Network Stations, the Windows NT server, Terminal Server Edition
server is the application server. We do not recommend that it is also the file
server because there can be performance problems. This is the job of AS/400
NetServer. AS/400 NetServer allows us to access IFS directories with the
Network Stations. We do not need extra hardware for a file server PC. However,
there is an administration difference when using file access, if the application
server is installed on the Integrated Netfinity Server or on an external server. For
detailed information about this, refer to 8.6, “Windows NT Terminal Server Edition
on external or internal servers” on page 125.
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8.5.2.1 Creating file shares with Network Stations
Fortunately there are no differences between creating a file share for a normal
Windows NT Client and a Network Station. Therefore, this point does not need to
be covered in great detail.

To create a file share, perform the following tasks:

1. Log on to the Windows NT server, Terminal Server Edition server with
administrator authority.

2. Use Operations Navigator to create a file share. For detailed information, refer
to 3.1, “AS/400 NetServer file shares” on page 26.

8.5.2.2 Accessing file shares with Network Stations
For accessing file shares, you must perform the same steps as you would for a
Windows NT PC. Perform the following tasks:

1. Log on to the Windows NT server, Terminal Server Edition server with the user
who requires the file share.

2. The file share can be accessed directly, or a network drive can be mapped by
using the normal functions of a Windows NT Client. For more information,
refer to 3.1, “AS/400 NetServer file shares” on page 26, or to AS/400 Client
Access Express for Windows: Implementing V4R4M0, SG24-5191.

8.5.3 Print shares with Network Stations
This section explains what to do if a printer is locally attached to a Network
Station and you want to share these printers using AS/400 NetServer.

8.5.3.1 Creating printer shares with Network Stations
AS/400 NetServer supports sharing the output queues of the AS/400 system with
PC clients. The following tasks must be done so that a locally attached Network
Station printer can be shared by AS/400 NetServer:

1. Configure the local printer of the Network Station using the Network Station
Manager. For detailed information, please refer to IBM Network Station
Printing Guide, SG24-5212.

2. Create a remote output queue on the AS/400 system that is pointing to the
locally attached printer created in step 1. For detailed information, please refer
to IBM Network Station Printing Guide, SG24-5212.

3. Share the remote output queue using AS/400 NetServer. For more
information, refer to 3.3, “AS/400 NetServer print shares” on page 34.

Now the local attached Network Station printer is available for all other users if
they have the authority to use this output queue and printer.

8.5.3.2 Accessing printer shares with Network Stations
For accessing print shares, you must perform the same steps as you would for a
Windows NT PC. Perform the following tasks:

1. Log on to the Windows NT server, Terminal Server Edition server as the user
who requires the print share.

2. Select Find-> Computer to find the AS/400 NetServer. When the Computer is
found, double-click on it. The printer share for the local attached Network
Station printer, created in 8.5.3.1, “Creating printer shares with Network
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Stations” on page 124, is seen. This printer can now be configured as a
network printer on a client. For detailed information, please refer to 3.3,
“AS/400 NetServer print shares” on page 34.

8.6 Windows NT Terminal Server Edition on external or internal servers

An important decision for each customer is to decide which kind of server they
should install the Windows NT Server 4.0, Terminal Server Edition operating
system: external or internal (Integrated Netfinity Servers). This section helps you
to make the right decision for your environment.

8.6.1 External servers
If you are installing the Windows NT server, Terminal Server Edition operating
system on an external server, you have the following two options:

• If you want to have full security on your integrated file system, you have to
create all existing AS/400 NetServer users on the external Windows NT
server, Terminal Server Edition server. The Windows NT server, Terminal
Server Edition user should have the same password as the AS/400 user to
avoid prompting for the AS/400 password. Having matching passwords
ensures login scripts, and network connections to AS/400 NetServer do not
require user interaction to be successful. Then, you can apply restricted
access to the directories of the integrated file system because all users are
known AS/400 users.

• A simple approach, but one that gives you less granular security on your
integrated file system, is when all Windows NT server, Terminal Server Edition
users access the file shares with the guest profile from the AS/400 NetServer.
In this case, you do not have to create all existing AS/400 NetServer users as
described in the previous point, just a single AS/400 NetServer guest user.
You can use your normal Windows NT server, Terminal Server Edition user,
but you must give them access to the directories of the integrated file system
by using the AS/400 NetServer guest profile. In our example, shown in Figure
78 on page 126, we give the AS/400 NetServer guest user netguest full
access to the directory worddocs. In this case, all Windows NT server,
Terminal Server Edition users will have the same level of authority when they
use the AS/400 NetServer shares.
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Figure 78. Directory permissions when using guest profile

In an environment with a small number of Windows NT server, Terminal Server
Edition users who use AS/400 NetServer, the second solution can be practical.
Otherwise, you have to do a great amount of user administration work.

8.6.2 Integrated Netfinity Servers
If you want to have the best security and the easiest user administration on both
operating systems, install the Windows NT server, Terminal Server Edition
operating system on the Integrated Netfinity Server. The following advantages
make it easy to manage your environment:

• You can propagate the AS/400 users to the Windows NT server, Terminal
Server Edition server. They will automatically have the same password. If the
AS/400 password is changed, it is changed on both sides. For more
information how to propagate users, refer to AS/400 - Implementing Windows
NT on the Integrated Netfinity Server, SG24-2164. In Figure 79 on page 127,
we show an example. User Benjoe and user Alex are propagated users. Now
you can give each or both users full or limited access to one or more
directories of the integrated file system, without using the AS/400 NetServer
guest user profile. This allows more granularity in security. In our example,
user Benjoe has full access to the directory wordsdoc and the user Alex has
only read and execute authority to the directory.
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Figure 79. Directory permissions without using guest profile

• You can use the backup and restore routines of the AS/400 system not only for
your file and print served data (AS/400 NetServer). You can also save your
application server (Windows NT server, Terminal Server Edition server on the
Integrated Netfinity Server) with these routines. For detailed information on
how to save the Integrated Netfinity Server data, please refer to AS/400 -
Implementing Windows NT on the Integrated Netfinity Server, SG24-2164.

Considering all these factors, when you want to have an environment with
Network Stations using Windows NT server, Terminal Server Edition server and
AS/400 NetServer, we recommend that you install your application server
(Windows NT server, Terminal Server Edition server) on the Integrated Netfinity
Server.

8.7 Practical example

In this section, we look at a practical example for using Network Stations with
AS/400 NetServer in a mid-size company. The company wants to bring their IT
environment up to date. The environment they are using has:

• A mix between 15 old and new PCs
• Two Windows NT servers
• One AS/400 system
• PC-attached printers
• LAN-attached printers
• All devices attached by Token Ring using TCP/IP

The old PCs use 5250 sessions to connect to the AS/400 system, Lotus Notes,
and Microsoft Office. The newer PCs use the same software as well, but they are
also using a program that must be installed locally on the workstations. This will
guarantee a better performance for this program. One Windows NT server is
newer and is used as the Primary Domain Controller (PDC) and file server. The
other Windows NT server is old and is used as the Backup Domain Controller
(BDC) and print server, but the server is not powerful enough to manage these
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two jobs. The AS/400 system is used for the main business applications and is
running a native Lotus Domino server. All printers are used as PC printers and
AS/400 printers as well. The actual configuration is shown in Figure 80.

Figure 80. Example company without using AS/400 NetServer

The company wants to use the most cost effective method to modernize their
environment. They decide to use AS/400 NetServer with Network Stations.

First, they must complete the following hardware configuration:

1. Replace the old PCs with Network Stations.
2. Remove the print server (BDC).
3. Install a Integrated Netfinity Server in the AS/400 system.

Then, they must complete the following software configuration:

1. Install and configure the no-charge Network Station Manager program on the
AS/400 system.

2. Configure the Network Stations to use the AS/400 system as a boot server.

3. Install and configure the Windows NT server, Terminal Server Edition
operating system on the Integrated Netfinity Server.

4. Install and configure the Citrix Metaframe program on the Windows NT server,
Terminal Server Edition server.

5. Start and configure the AS/400 NetServer on the AS/400 system.

After these configuration steps are done, the environment appears like the
diagram shown in Figure 81 on page 129.

Token Ring
Old PCs

New PCs
File server

(PDC)

Print server
(BDC)

AS/400 system LAN-attached printers

Local-attached printers

Local-attached printers
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Figure 81. Example company with AS/400 NetServer

Now let us look at the separate components, their job in the newly configured
environment, and the benefits that the company has achieved, with the new
environment.

• The AS/400 NetServer has to perform two jobs: file serving and print serving.
The advantage of using AS/400 NetServer for these jobs is that the external
Windows NT server now only has to manage the security of the Windows NT
domain. This will result in better login performance. The old Windows NT
server was removed. There is no need to buy a new print server because
AS/400 NetServer covers this job.

• The Windows NT server, Terminal Server Edition server has also two jobs:
application server for the Network Stations and Backup Domain Controller. In
this case, there is now one focal point of administration for the Network
Stations applications. The complete server can be saved by using the AS/400
utilities.

• The PCs have their applications installed locally, but also use AS/400
NetServer as a file server.

• All printers are managed by AS/400 NetServer, and they have output queues
on the AS/400 system. These queues can be managed and saved by the
standard AS/400 utilities.

• The company can save all production data with the normal AS/400 utilities
because they are all stored in the integrated file system of the AS/400 system.

All-in-all, the company achieves:

• Better workstation performance because all old components are removed
• Easier administration of the server
• An easier backup and restore strategy

Token Ring

New PCs
NT server

(PDC)

AS/400 system
with NetServer

LAN-attached printers

Local-attached printers

Local-attached printers

Network Stations

WIN/TSE on INS
(BDC)
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Part 4. Appendixes

This part includes appendixes on:

• Configuring AS/400 NetServer with commands rather than using the
Operations Navigator interface

• An example on using AS/400 NetServer with applications

• An example of an Exit program that can be used for debugging AS/400
NetServer problems
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Appendix A. Setting up AS/400 NetServer without Operations Navigator

If you do not have Operations Navigator support, you can set up your AS/400
system to use AS/400 NetServer with AS/400 APIs. A full list of APIs is given in
3.11, “AS/400 NetServer administration using AS/400 APIs” on page 49.

You must have *IOSYSCFG special authority to alter any part of AS/400
NetServer configuration. Follow these steps to set up AS/400 NetServer:

1. Verify that TCP/IP support is configured on your AS/400 system. You must
have at least one external TCP/IP interface configured and active to use
AS/400 NetServer. Use the Configure TCP/IP (CFGTCP) command to check or
change interfaces, routes, the host table, and domain name services. Once
the configuration is complete, use the Start TCP/IP (STRTCP) command to
activate the support.

2. Use the Work with Subsystems (WRKSBS) command to verify that the QSERVER
subsystem has started.

3. Verify that the AS/400 NetServer server name is unique on the network. To
change the default AS/400 NetServer default server and domain name, use
the following command:

CALL QZLSCHSN PARM (server-name domain-name ‘text description or comment’ X
‘00000000’)

Once you change the AS/400 NetServer server name, you should add it to the
WINS), or your PC client LMHOST file.

4. Users who require the file and print sharing capabilities of AS/400 NetServer,
but do not have an AS/400 user profile, need a guest user profile. AS/400
NetServer does not automatically configure guest support. Users without
AS/400 user profiles will not be able to access AS/400 NetServer. However,
the guest user profile must have a password but no special authority. To
change AS/400 NetServer guest support, use the following command:

CALL QZLSCHSG (guest-user-profile X’00000000’)

For more information on guest user profiles, see 4.1.1, “Considerations for
using the guest user profile” on page 51.

5. All changes to your AS/400 NetServer configuration, with the exception of
share and session administration, do not take effect until you stop and start
the server. To stop and start AS/400 NetServer at V4R4, use the following
commands:

ENDTCPSVR *NETSVR
STRTCPSVR *NETSVR

If you are using V4R2 or V4R3 of OS/400, use the following commands to
respectively stop and start AS/400 NetServer:

CALL QZLSENDS PARM(X'00000000')
CALL QZLSSTRS PARM('0' X'00000000')

6. Use the Work with Active Job (WRKACTJOB) command to verify that there is a
QZLSSERVER job running under the QSERVER subsystem. If the
QZLSSERVER job is not active, you must restart AS/400 NetServer.

7. Using the Work with TCP/IP Status (NETSTAT *CNN) command, verify that the
following entries appear in the NETSTAT output file. If you cannot find these
entries, you must restart AS/400 NetServer.
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** netbios>001:27:44 Listen
** netbios>000:00:01 *UDP
** netbios>000:00:00 *UDP
** netbios>000:30:57 Listen

8. Use the WRKACTJOB command to ensure that there is a QNPSERVD job active in
the QSYSWRK subsystem. If there is no QPNSERVD job, then you must use
the Start Host Server (STRHOSTSVR *NETPRT) CL command to start the Network
Print Server. Starting the Network Print Server ensures that AS/400 NetServer
print shares function properly.

9. Verify that the QUSRWRK subsystem is started for V4R4 because
QNPSERVS jobs are configured to run there by default.

10.Make sure the LOOPBACK TCP/IP interface is active.
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Appendix B. Using applications with AS/400 NetServer

It is possible to install and run applications from an AS/400 NetServer share. This
may be beneficial for those who want to centrally administer applications and
keep local PC hard drive usage to a minimum. The details that follow
demonstrate how you can take advantage of this functionality.

You may decide to create a new AS/400 file share to hold any applications that
you choose to share. If necessary, review 3.1, “AS/400 NetServer file shares” on
page 26.

B.1 Preparation

This section shows the considerations that administrators need to be aware of
before attempting any application installation.

B.1.1 Creating file shares

The AS/400 NetServer administrator must create a file share to the directory on
the AS/400 system in which the application will reside. All users who will use this
application must have a mapped network drive to this file share.

The user installing this software on the AS/400 NetServer file share needs all
data and object authorities. Since users will be using these files as well, the
correct authority must be defined for them. The authority for these users must be
considered carefully so that unauthorized actions are not performed. In most
cases, *RX data authority is sufficient, but this depends on the application that is
being installed.

B.1.2 User directory considerations

Most applications that permit a multi-user installation, provide the possibility to
copy shared application files to the following locations:

• In a sub-directory on the same share in which the core application files
reside. This is the default install option for the software tested in this
appendix. The advantage of this installation is that there is less space used on
the PC local hard drive and the installation files reside in one area on the
AS/400 NetServer.

• On a user’s own file share on the AS/400 NetServer. This also keeps the
PC hard drive usage to a minimum and also makes authority administration
easier since appropriate levels of authority have already been defined.

• PC local hard drive. The advantage with this installation option is that there
may be better performance, but PC hard drive space is used.

It is important to understand that the following examples demonstrate file
serving and not application serving. Although the application files are stored on
the AS/400 NetServer share, they are not run there. Required files are
downloaded to the PC client and run locally.

Note
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B.2 Installing the applications

In this section, we demonstrate how to install Lotus SmartSuite and Microsoft
Office into an AS/400 NetServer environment.

B.2.1 Lotus SmartSuite

The following example demonstrates the main steps in the installation of Lotus
SmartSuite to an AS/400 NetServer share and subsequent installation to the PC
client.

B.2.1.1 Installing Lotus SmartSuite on an AS/400 NetServer share
The following example represents a typical Lotus SmartSuite installation on a
network using the command install. At a point during the installation, the window
shown in Figure 82 is displayed.

Figure 82. Lotus SmartSuite installation

To install the Lotus SmartSuite code to the AS/400 NetServer file share, the box
labelled Install to a file server must be checked as shown in Figure 82. This
allows the installation program to copy the files to the network drive, rather than
to a local hard disk drive.

Continue to follow the normal installation procedure until the window shown in
Figure 83 on page 137 is displayed.

This example does not detail an entire Lotus SmartSuite installation. Refer to
your supporting Lotus documentation for further information.

Note
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Figure 83. Lotus file server installation

The two options shown in Figure 83 are defined here:

• File server or multiple user install. Copies all files to the AS/400 NetServer
share and allows a node (PC client) installation. This effectively limits the size
of the code present on the PC local hard drives because the Lotus
applications are run from the AS/400 NetServer share and downloaded into
the PC memory when needed.

• Network distribution. Copies all files to the AS/400 NetServer share and
allows users to install the applications to their PC hard drives using a network
drive rather than the installation CD.

Make your selection, and click Next. In our environment, the File server or
multiple user install option is selected.

Now continue to follow the normal installation procedures. During these
procedures, we advise that you take time to read the NETWORK
ADMINISTRATORS GUIDE when you are prompted. Also ensure that when you
are prompted, you enter the drive letter of the AS/400 NetServer share so that the
files are copied to the correct location.

B.2.1.2 Setting up your PC client
Once you finish installing your Lotus SmartSuite software to your AS/400
NetServer share, you can consider setting up individual PC clients. In conjunction
with the supporting Lotus documentation, perform the following steps:

1. Map a network drive to the AS/400 NetServer share that has the Lotus
SmartSuite software on it.

2. Run the install.exe file.

3. Follow the instructions contained within your supporting Lotus documentation.

During the node (PC client) installation, there is an option provided that allows the
user to specify where the user-specific files are located. It is possible to specify
either local hard drive or network drive. In our test environment, the AS/400
NetServer share was specified. This minimizes the number of files copied to the
PC local hard drives.
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B.2.2 Microsoft Office

The following example demonstrates the main steps in the installation of
Microsoft Office to the AS/400 NetServer share and subsequent installation to the
PC client.

B.2.2.1 Installing Microsoft Office on an AS/400 NetServer share
The following example represents a Microsoft Office installation on a network
using the command setup /a, where /a indicates a server installation.

At some point during the installation, you are presented with the window shown in
Figure 84.

Figure 84. Network Server Confirmation screen

To allow users to access these files from the AS/400 NetServer share, you must
specify the directory path to that share in the Server field. In the example in
Figure 84, we specified the path as: \\QAS23\OFFICE2, where QAS23 is the name of
the AS\400 NetServer and OFFICE2 represents a specific shared directory where
the Microsoft Office files will be stored.

Select Continue. Then, you are prompted with the display shown in Figure 85 on
page 139.

This example does not detail an entire Microsoft Office installation. Refer to
your supporting Microsoft documentation for further information.

Note
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Figure 85. Microsoft Office setup

This step determines where shared application files will be stored:

• Server: Shared application files are stored on the server.

• Local Hard Drive: Shared application files are stored to the clients individual
hard drive.

• User’s Choice: During the individual client installation, the user can choose to
store the shared application files on the server or on the client’s individual
hard drive.

Make your decision based on where you want your user’s shared application files
to reside. Then, click OK to continue.

Follow the remainder of the Microsoft documentation to continue with your
installation.

B.2.2.2 Setting up your PC client
Once you finish installing your Microsoft Office software to your AS/400
NetServer share, you can consider setting up individual PC clients. In conjunction
with the supporting Microsoft documentation, perform the following steps:

1. Map a network drive to the AS/400 NetServer share that has the Microsoft
Office software on it.

2. Run the SETUP.EXE file.

3. Follow the instructions contained within your supporting Microsoft
documentation until the window shown in Figure 86 on page 140 appears.
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Figure 86. Setup from Network Server

4. If you want to run Microsoft Office from the AS/400 NetServer file share, select
the Run from Network Server option.

5. Continue with the installation using the Microsoft documentation.

B.3 Using the applications

This section displays the default setups for Lotus SmartSuite and Microsoft
Office. It also discusses the possibilities of using AS/400 NetServer further in this
environment.

B.3.1 Lotus SmartSuite

The example used here covers only the Lotus WordPro product. Other
applications within Lotus SmartSuite may not necessarily have the same
displays. The same considerations apply for the other applications. Therefore,
the supporting Lotus documentation should be referenced.

B.3.1.1 Default file locations
After the installation of Lotus SmartSuite from the AS/400 NetServer file share,
Lotus Wordpro uses default file locations, which are shown in Figure 87 on page
141.
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Figure 87. WordPro file locations

Most files are located on the local PC hard drive and some on the AS/400
NetServer file share. This is the default configuration, but it is not always what
you want. You can change it by selecting Files-> User Setup-> WordPro
Preferences and clicking the Locations tab.

B.3.2 Microsoft Office

The example used here covers only the Microsoft Word product. Other
applications within Microsoft Office may not necessarily have the same windows.
The same considerations apply for the other applications. Therefore, the
supporting Microsoft documentation should be referenced.

B.3.2.1 Default file locations
After the installation of Microsoft Office from the AS/400 NetServer file share,
Microsoft Word uses default file locations, which are shown in Figure 88 on page
142.
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Figure 88. Word default file locations

Some files are located on the local PC hard drive, and others are located on the
AS/400 NetServer file shares. This is the default configuration, but it is not always
what you want. You can change the configuration by selecting Tools -> Options,
and clicking on the File Locations tab.

B.3.2.2 Optimizing for use with AS/400 NetServer
By using the Modify button as shown in Figure 88, it is possible to define where
these file types (for example, Documents) are located.

If you want to use an AS/400 NetServer file share as a location for your file types,
you must grant the correct authority to the IFS directory. You must also make it
available by sharing it using AS/400 NetServer. Once available, you can access
the IFS directory by mapping a network drive to the AS/400 NetServer file share.

Using this method has the following advantages:

• The AS/400 system is the central point for all Microsoft Office files. All
application maintenance can be done at one location.

• You can use the AS/400 system save and restore functions for backup and
recovery of your Microsoft Office environment.

• Reduced space is required on the local PC hard drives.

This method increases the amount of network traffic, and therefore, may have
a detrimental effect on performance.

Note
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B.3.2.3 Optimizing for use with AS/400 NetServer
By selecting the current path of the file type you want to change and clicking
Browse (shown in Figure 87 on page 141), it is possible to define where these file
types are located.

If you want to use an AS/400 NetServer file share as a location for your file types,
you must grant the correct authority to the IFS directory and make it available by
sharing it using AS/400 NetServer. Once available, you can access the IFS
directory by mapping a network drive to the AS/400 NetServer file share.

Using this method has the following advantages:

• The AS/400 system is the central point for all Lotus SmartSuite files. All
application maintenance can be done at one location.

• You can use the AS/400 system save and restore functions for backup and
recovery of your Lotus SmartSuite environment.

• Reduced space is required on the local PC hard drives.

B.4 Performance considerations

Installing and running applications from an AS/400 NetServer may not
necessarily perform well in all environments. There are a number of reasons why
this may be the case and causes may include network-related issues or AS/400
utilization.

There is a new parameter, TCP/IP only, on the line description for a 10/100
Ethernet Adapter at V4R4. This parameter applies if the adapter is on a dedicated
Input Output Processor (IOP), that is, not on the multi-function input/output
processor (MFIOP). Using this parameter enhances AS/400 NetServer and other
TCP/IP application throughput. Make sure you apply PTF MF22323 before setting
this parameter. AS/400 NetServer fails when this parameter is set and the PTF is
not applied.

We advise that you monitor the situation closely. If performance is affected, install
the software on another file server, for example, Windows NT Server 4.0 on the
Integrated Netfinity Server.

This method increases the amount of network traffic, and therefore, may have
a detrimental effect on performance.

Note
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Appendix C. Exit program

The following CL program captures the *FILESERVER exit points and reports
them to a message queue. This can be a useful debug tool.

/***************************************************************************/
/* THIS IS AN EXIT PROGRAM FOR THE FILE SERVER. IT NEEDS TO BE */
/* REGISTERED USING THE WRKREGINF COMMAND. */
/* */
/* THIS PROGRAM IS BASED ON THE SAMPLE IN THE "CLIENT ACCESS/400 HOST */
/* SERVERS" BOOK */
/* */
/* THIS EXIT PROGRAM SENDS A TRACE OF ALL CALLS TO THE QUSRSYS/FSEXIT */
/* MESSAGE QUEUE (WHICH NEEDS TO BE CREATED OUTSIDE THIS PROGRAM) */
/***************************************************************************/
PGM PARM(&STATUS &REQUEST)

DCL VAR(&STATUS) TYPE(*CHAR) LEN(1) /* ACCEPT/REJECT INDICATOR */
DCL VAR(&REQUEST) TYPE(*CHAR) LEN(2000) /* PARAMETER STRUCTURE */

/***********************************************************************/
/* DECLARES */
/***********************************************************************/
/* COMMON TO ALL EXIT PROGRAMS */
DCL VAR(&USER) TYPE(*CHAR) LEN(10)
DCL VAR(&APPLIC) TYPE(*CHAR) LEN(10)

/* FILE SERVER DECLARES */
DCL VAR(&FSFID) TYPE(*CHAR) LEN(4) /* FUNCTION IDENTIFIER */
DCL VAR(&FSFMT) TYPE(*CHAR) LEN(8) /* PARAMETER FORMAT */
DCL VAR(&FSREAD) TYPE(*CHAR) LEN(1) /* OPEN FOR READ */
DCL VAR(&FSWRITE) TYPE(*CHAR) LEN(1) /* OPEN FOR WRITE */
DCL VAR(&FSRDWRT) TYPE(*CHAR) LEN(1) /* OPEN FOR READ/WRITE */
DCL VAR(&FSDLT) TYPE(*CHAR) LEN(1) /* OPEN FOR DELETE */
DCL VAR(&FSFLG) TYPE(*CHAR) LEN(4) /* ALL OPEN FLAGS */
DCL VAR(&FSLEN) TYPE(*CHAR) LEN(4) /* FDAME LENGTH */
DCL VAR(&FSNAME) TYPE(*CHAR) LEN(2000) /* QUALIFIED FILE NAME */
DCL VAR(&DECLEN) TYPE(*DEC) LEN(8 0)

/* OUTPUT MESSAGE */
DCL VAR(&OUTMSG) TYPE(*CHAR) LEN(512) +

VALUE('User xxxxxxxxxx Function xxxxxxxxxx Path')
DCL VAR(&FUNC) TYPE(*CHAR) LEN(10)
DCL VAR(&ECFNAME) TYPE(*CHAR) LEN(400)

/* MISC VALUES FOR PLAYING WITH BINARY NUMBERS */
DCL VAR(&BIN0) TYPE(*CHAR) LEN(4) VALUE(X'00000000')
DCL VAR(&BIN1) TYPE(*CHAR) LEN(4) VALUE(X'00000001')
DCL VAR(&BIN2) TYPE(*CHAR) LEN(4) VALUE(X'00000002')
DCL VAR(&BIN3) TYPE(*CHAR) LEN(4) VALUE(X'00000003')
DCL VAR(&BIN4) TYPE(*CHAR) LEN(4) VALUE(X'00000004')
DCL VAR(&BIN5) TYPE(*CHAR) LEN(4) VALUE(X'00000005')
DCL VAR(&BIN6) TYPE(*CHAR) LEN(4) VALUE(X'00000006')

DCL VAR(&UCCCSID) TYPE(*CHAR) LEN(4) VALUE(X'0000F200')
DCL VAR(&ECCCSID) TYPE(*CHAR) LEN(4) VALUE(X'00000025')
DCL VAR(&BIN400) TYPE(*CHAR) LEN(4) VALUE(X'00000190')

/* MISC VARS FOR CALLING THE CONVERSION ROUTINE */
DCL VAR(&FEEDBACK) TYPE(*CHAR) LEN(12)
DCL VAR(&TEMP1) TYPE(*CHAR) LEN(4)
DCL VAR(&TEMP2) TYPE(*CHAR) LEN(4)

/***********************************************************************/
/* PROGRAM */
/***********************************************************************/
/* RETRIEVE HEADER VALUES */
CHGVAR VAR(&USER) VALUE(%SST(&REQUEST 1 10))
CHGVAR VAR(&APPLIC) VALUE(%SST(&REQUEST 11 10))

/* RETRIEVE FILE SERVER VALUES */
CHGVAR VAR(&FSFID) VALUE(%SST(&REQUEST 21 4))
CHGVAR VAR(&FSFMT) VALUE(%SST(&REQUEST 25 8))
CHGVAR VAR(&FSREAD) VALUE(%SST(&REQUEST 33 1))
CHGVAR VAR(&FSWRITE) VALUE(%SST(&REQUEST 34 1))
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CHGVAR VAR(&FSRDWRT) VALUE(%SST(&REQUEST 35 1))
CHGVAR VAR(&FSDLT) VALUE(%SST(&REQUEST 36 1))
CHGVAR VAR(&FSFLG) VALUE(%SST(&REQUEST 33 4))
CHGVAR VAR(&FSLEN) VALUE(%SST(&REQUEST 37 4))
CHGVAR VAR(&DECLEN) VALUE(%BINARY(&FSLEN 1 4))
CHGVAR VAR(&FSNAME) VALUE(%SST(&REQUEST 41 &DECLEN))

CHGVAR VAR(&STATUS) VALUE('1') /* INITIALIZE RETURN VALUE TO ACCEPT REQ */

IF COND(&APPLIC *NE '*FILESRV') THEN(GOTO DONE) /* ONLY LOOK AT FILESVR */

/* SET USER NAME IN OUTPUT MESSAGE */
CHGVAR VAR(%SST(&OUTMSG 6 10)) VALUE(&USER)

/* FIGURE OUT WHAT FUNCTION IS BEING PERFORMED */
IF COND(&FSFID *EQ &BIN0) THEN(CHGVAR &FUNC 'CHANGE ')
ELSE IF COND(&FSFID *EQ &BIN1) THEN(CHGVAR &FUNC 'CREATE ')
ELSE IF COND(&FSFID *EQ &BIN2) THEN(CHGVAR &FUNC 'DELETE ')
ELSE IF COND(&FSFID *EQ &BIN3) THEN(CHGVAR &FUNC 'LIST ')
ELSE IF COND(&FSFID *EQ &BIN4) THEN(CHGVAR &FUNC 'MOVE ')
ELSE IF COND(&FSFID *EQ &BIN5) THEN(CHGVAR &FUNC 'OPEN(xxxx)')
ELSE IF COND(&FSFID *EQ &BIN6) THEN(CHGVAR &FUNC 'RENAME ')
ELSE CHGVAR &FUNC 'UNKNOWN '

/* FOR OPEN FUNCTION, COPY OPEN FLAGS TO FUNCTION NAME */
IF COND(&FSFID *EQ &BIN5) THEN(CHGVAR %SST(&FUNC 6 4) &FSFLG)

/* NOW SET FUNCTION IN OUTPUT MESSAGE */
CHGVAR VAR(%SST(&OUTMSG 26 10)) VALUE(&FUNC)

/* ANNOYINGLY, THE FILE NAME PASSED INTO THE EXIT PROGRAM IS IN */
/* UNICODE. CONVERT IT TO CODEPAGE 37 */
CALL CDRCVRT (&UCCCSID /* INPUT CCSID */ +

&BIN0 /* NULL TERM INPUT */ +
&FSNAME /* INPUT STRING */ +
&FSLEN /* INPUT LENGTH */ +
&ECCCSID /* OUTPUT CCSID */ +
&BIN2 /* SPACE PAD OUTPUT */ +
&BIN0 /* DEFAULT CONVERT */ +
&BIN400 /* OUTPUT LEN */ +
&ECFNAME /* OUTPUT */ +
&TEMP1 /* RETURNED LEN */ +
&TEMP2 /* RESERVED */ +
&FEEDBACK)

/* AND COPY THE CONVERTED PATH TO THE OUTPUT MESSAGE */
CHGVAR VAR(%SST(&OUTMSG 42 400)) VALUE(&ECFNAME)

/* FINALLY, SEND THE MESSAGE */
SNDPGMMSG MSGID(CPF9898) MSGF(QSYS/QCPFMSG) +

MSGDTA(&OUTMSG) TOMSGQ(QUSRSYS/FSEXIT)
DONE:

/* RETURN. STATUS IS ALWAYS 1 (INDICATING THAT IT IS OK TO PROCEED */
ENDPGM
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Appendix D. Special notices

This publication is intended to help AS/400 system administrators and
implementors configure and use AS/400 NetServer. The information in this
publication is not intended as the specification of any programming interfaces that
are provided by the Operating System/400. See the PUBLICATIONS section of
the IBM Programming Announcement for Operating System/400 for more
information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The information about non-IBM ("vendor")
products in this manual has been supplied by the vendor and IBM assumes no
responsibility for its accuracy or completeness. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed
by IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.

Any performance data contained in this document was determined in a controlled
environment, and therefore, the results that may be obtained in other operating
environments may vary significantly. Users of this document should verify the
applicable data for their specific environment.
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This document contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples contain
the names of individuals, companies, brands, and products. All of these names
are fictitious and any similarity to the names and addresses used by an actual
business enterprise is entirely coincidental.

Reference to PTF numbers that have not been released through the normal
distribution process does not imply general availability. The purpose of including
these reference numbers is to alert IBM customers to specific information relative
to the implementation of the PTF when it becomes available to each customer
according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet Tivoli,
and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems
Inc., an IBM company, in the United States, other countries, or both. In Denmark,
Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through The Open Group.

SET and the SET logo are trademarks owned by SET Secure Electronic
Transaction LLC.
Other company, product, and service names may be trademarks or service marks
of others.

Advanced Function Printing AFP
APPN AS/400
AT Client Access
Client Access/400 Client Access Express
CT DB2
IBM  Netfinity
Network Station OS/400
Operating System/400 OS/2
RS/6000 SP
System/390 XT
400
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Appendix E. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

E.1 International Technical Support Organization publications

For information on ordering these ITSO publications see “How to get ITSO
Redbooks” on page 151.

• AS/400 - IBM Network Station - Getting Started, SG24-2153

• AS/400 Printing V, SG24-2160

• AS/400 - Implementing Windows NT on the Integrated Netfinity Server,
SG24-2164

• Inside Client Access for Windows 95/NT, SG24-4748

• AS/400 Client Access Express for Windows: Implementing V4R4M0,
SG24-5191

• IBM Network Station Printing Guide, SG24-5212

E.2 Redbooks on CD-ROM

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at http://www.redbooks.ibm.com/ for information about all the CD-ROMs
offered, updates and formats.

E.3 Other publications

These publications are also relevant as further information sources:

• IBM Network Station Manager Installation and Use, SC41-0664

• OS/400 Integration Services for the Integrated PC Server, SC41-5123

• OS/400 Integrating AS/400 with Novell NetWare, SC41-5124

• OS/400 Security, SC41-5302

• OS/400 Backup and Recovery, SC41-5304

• Work Management, SC41-5306

• TCP/IP Configuration and Reference, SC41-5420

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849
Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr Format) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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• OS/2 Warp Server for AS/400 Administration, SC41-5423

• AS/400 System API Reference, SC41-5801

E.4 Resources on the Web

These Web pages are referenced in the redbook:

• IBM home page: http://www.ibm.com

• Lotus home page: http://www.lotus.com

• Infocenter: http://www.as400.ibm.com/infocenter

• AS/400 NetServer home page:
http://www.as400.ibm.com/netserver/welcome.htm

• IBM Printer Company home page: http://www.printers.ibm.com

• AS/400 service: http://as400service.ibm.com
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How to get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, redpieces, and
CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download, or order hardcopy/CD-ROM redbooks from the redbooks Web site. Also read
redpieces and download additional materials (code samples or diskette/CD-ROM images) from this redbooks
site.

Redpieces are redbooks in progress; not all redbooks become redpieces and sometimes just a few chapters will
be published this way. The intent is to get the information out much quicker than the formal publishing process
allows.

• E-mail Orders

Send orders by e-mail including information from the redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest information
may be found at the redbooks Web site.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order” section at
this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and redbooks by accessing the IBM
Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. Look in the Materials
repository for workshops, presentations, papers, and Web pages developed and written by the ITSO technical
professionals; click the Additional Materials button. Employees may access MyNews at http://w3.ibm.com/ for
redbook, residency, and workshop announcements.

IBM Intranet for Employees
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IBM Redbook fax order form
Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
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